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Change Table 

The following table contains an overview of changes made to this document for the 3.4 SP 5 
release of Zenly. 

Table 1: Change Table 

Version Section Impacted Change(s) 

3.4 SP 5 

Run Pricing 
Updated the steps for the Run Pricing screening due 
to a UI change. All users will have access to the Run 
Pricing button. 

Loan Overview Image and steps updated for the ECOA Date field. 

PMI/MIP/VA/USDA 
Added step and updated image for the Exempt from 
VA Funding Fee checkbox. 

Buydown Mortgage 
Added a new Type dropdown menu with the old Type 
dropdown menu renamed to Source of Funds. 

Credit Reporting Added information about hard and soft credit pulls 

Loan Product Advisor 
LPA documentation is available for up to five 
borrowers. 
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Chapter 1: DOCUMENT OVERVIEW 

Preface 

Zenly is a full web-based loan origination solution. Zenly requires no installations and is 
securely accessed from multiple platforms on any computer or mobile device. 

See the following table for product assistance details. 

Note: Not all features displayed in this guide are available for every user. 

Table 2: Product Assistance 

Knowledge Base Access the online Knowledge Base Articles  

Visit: Zenly Knowledge Base Articles 

Product Information General product information and links to product support 
pages and the user guide are available at Calyx Support. 

Email: Zenly@calyxsoftware.com 

Email: DCSZIP@calyxsoftware.com 

Training Attend paid online cases delivered by a Certified Calyx 
Consultant by contacting PSG@calyxsoftware.com or call 1-
800-362-2599 Option 1. 

Online: Go to the Calyx Customer Portal 

Email: training@calyxsoftware.com 

Toll Free: 800-362-2599. 

Documentation Accessibility 

The goal is to make Calyx products, services, and supporting documentation accessible. 
This document focuses on usability for the disabled community. The documentation 
includes features that make information available to users of assistive technology and 
conforms with Americans with Disabilities Act (ADA) compliance standards. Documentation 
is available in HTML format and contains markup to facilitate access by the disabled 
community. Accessibility standards continue to evolve over time, and Calyx Software is 
actively engaged with other market-leading technology vendors to address technical 
obstacles so documentation can be accessible to all customers. 
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Access Zenly 

Use https://www.calyxzenly.com/ link to access Zenly. 

1. Click the Calyx Zenly link. 

2. Enter User Email Address. 

 
Figure 1: Zenly Log In 

3. Enter the 14-digit Password. 

Note: Zenly requires a combination of alpha-numeric characters along with at least one 
special character. At least one alpha character must be capitalized. 

Forgot Password (Request Password Reset) 

Users needing to renew or to replace forgotten passwords can use the link to reset the 
password. 

To change the password: 
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1. Click on the Forgot Your Password? link in the sign in screen. 

 
Figure 2: Forgot Your Password? 

2. Enter the Login Name. 

 
Figure 3: Request Password Request 

3. Click the Send button to request the password change. 

4. After receiving the code, type Access Code in the field. 

 
Figure 4: Access Code 
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Note: Choose another method allows the user to send the password request through a 
different method. See User Information. 

5. Enter a new Password. 

6. Enter the same password again to confirm. 

Mobile Access 

The mobile view of Zenly functions identically to the desktop view. The standard menu 
items are available by expanding the Menu button  located at the top of the screen. For 
information about the buttons, See Zenly Mobile Icons. 

 
Figure 5: Zenly Mobile View 
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Home Screen (Mobile) 

The user can return to the Home screen by tapping on the Zenly logo. 

   
Figure 6: Home Screen (Mobile) 

User Profile for Mobile Users 

Selecting the Menu icon displays all Zenly features including the User Profile, Interview 
Portal, Support, Help, and the Sign Out functions. 

 
Figure: User Profile (Mobile) 

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
22 

The Home screen allows the user to search for both Leads or Loan files. 

Zenly Mobile Icons 

Table 3: Zenly Home Screen Icons 

Icons Function 

 
Tapping the icon allows the user to return to the Zenly Home screen. 

 
Tapping on the Select button allows the user to choose files to delete or 
archive. 

 
The Alerts icon displays unread notifications. Select the icon to view 
notifications. 

 

Tap on the Main Menu button to access the main menu. The User Profile, 
Interview Portal, Settings*, Reports, Users, and Template screens are 
accessed in the main menu. 

 Tap on the Expand (chrevon) icon to expand the table to view the entries. 

 
Tapping on the Filter icon allows the user to filter between Lead, Loan, and 
Archived files. 

 The New File icon allows the user to create new loans or lead files. 

 Tap on the Add button to insert an entry to a table. 

 
Tapping on this button displays the Summary Info popup screen (Leads 
Only). 

 
Tap on the Primary Dropdown Menu button to navigate throughout other 
Loan screens. 

 
Tap on the Secondary Dropdown Menu button to navigate within the Loan 
screen. 

*- The Settings option appears for accounts with a retail flag. 
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Chapter 2: ZENLY HOME SCREEN 
Zenly opens to the Home Screen after successful login. This screen provides access to 
existing leads and loan options. Click on the Zenly logo to return to the Home screen. 

 
Figure 7: Zenly Main Page 

Note: The User List displays only the registered user when logging into Zenly the first time. 
Use the New button to add users or select a Main tab to add loans or set up the 
administration options (See Add User for details). 

Icons help distinguish a Lead from a Loan. See Figure 8. 

 
Figure 8: Home Table Icons 

  

Lead
 

Loan 
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Filtering 

The filtering  icon allows the user to display the desired file type. The options include 
Archived, Leads, and Loans. 

 
Figure 9: Filtering 

Copy File 

This function allows the user to copy loan or lead files. 

To copy a file: 

1. Click the Select button. 

 
Figure 10: File Select 

2. Select the desired Loan/Lead file. 
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3. Select the Copy button. 

 
Figure 11: Copy Button 

4. Select the Copy button. 

5. Select Copy to confirm the desired file(s). 

 
Figure 12: Copy Files Dialog 
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6. Once the progress bar reaches 100%, close the dialog. 

 
Figure 13: Copy Files (Complete) 

Archiving Files 

Files located on the Leads/Loans table are archivable. 

To archive a file: 

1. Click on the Select button. See Figure 10. 

2. Select the desired files. 

3. Select the Archive button. 

 
Figure 14: Archiving Files 

4. Click Ok on the Confirm Archive dialog. 
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Viewing Archived Files 

Use the Filter function to view archived files. 

Note: Viewing archived files while archived are read-only. Ensure that the file is reactivated 
before opening. 

To view the archived files: 

1. Click on the Filter  icon. 

 
Figure 15: Viewing Archived Files 

2. Select Archived. 

Reactivating Archived Files 

Archived files required reactivation before adding additional information. Opening an 
archived file will function in read-only mode. 

To reactivate an archived file: 

1. Click on the Filter  icon. 

2. Select Archived. 

3. Click on the Select button. 

 
Figure 16: Select Button 
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4. Choose the desired files. 

5. Select Activate. 

 
Figure 17: Activate Button 

Deleting Files 

Delete files through the Home and Leads/Loan tables. 

To delete files: 

1. Click the  icon for the undesired Loan/Lead file. 

 
Figure 18: Selecting Files (Deleting) 
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2. Click OK in the Confirm Delete dialog. 

 
Figure 19: Confirm Delete File 

User Profile 

The User Profile’s location is at the top-right corner of the screen. Selecting the button 
allows the user to access the Interview Portal (Interview Configuration), Settings (specific 
accounts only), Help, and Sign Out links. 

 
Figure 20: User Profile 

Contact Information 

Set the user contact information and state licensing options. 

To add User Profile information. 

1. Select the User Profile  icon. 
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2. Click on the profile name. 

 
Figure 21: Loan Originator Contact Information 

Note: Asterisks indicate required fields. 

1. Enter Originator’s First and Last name. 

2. Enter the Middle name if applicable. 

3. Add a Suffix if applicable. 

4. Enter the user’s NMLS Number. 

5. Add a Login Name if applicable. 

6. Enter Email. 

7. Enter Contact number. 

8. Enter Mobile number. 

9. If needed, select the By Checking the Opting in Box…. 

Note: By opting into the informational texts, the user is provided with an additional method 
for sending password change requests. 

State License 

This section allows the user to view licenses associated with the current account. 

To add a license: 

1. Click the State License Add  button. 

2. Enter State License information. 

3. Click Save & Close. 

Note: Click Save & New to add additional licenses. 
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Appearance 

Dark Mode allows the user to darken the Zenly screen. To change the screen modes, select 
the button with the desired appearance. 

 
Figure 22: Dark/Light Modes 

Services Settings 

Use the Services Settings to create Loan Originator Login credentials. 

1. Select Services Settings. 

 
Figure 23: Add Login Credentials 

2. Click on the Add  icon. 
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3. Select the appropriate Service. 

 
Figure 24 Add Login Credentials Dialog 

4. Select the appropriate Agency. 

5. Select the Preferred checkbox to save settings as preferred. 

6. Enter Login Name. 

7. Enter the login Password. 

8. Enter the Account number. 

9. Enter the company Branch ID if appropriate. 

10. Enter the Fannie Mae Account Number. 

11. Enter the Fannie Mae Password. 

Note: The Fannie Mae fields only appear for credit vendors that require different 
authentication credentials for Fannie Mae vendors. 

12. Click Save & Close. 

Note: Click Save & New to add another service setting. 

Alerts Configuration 

Use the Alerts Configuration to set notifications. Toggle the switches for the desired alerts. 

 
Figure 25:  Alerts Configuration 
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Configuring Email Settings (User Profile) 

The Email Settings screen provides the user with fields for overriding default Global Email 
Settings for their profile. Admins can use the Email Settings located in the Users tab to 
configure other user’s email settings. See Configuring Email Settings (Users). 

 
Figure 26: Email Settings 

To override the company’s default email settings: 

1. Select the Username from the User Profile menu. 

2. Select Email Settings. 

3. To enable the override, select the Override Company Defaults toggle. 

4. For Server Information, enter the desired Sender Name. 

5. Enter the desired Sender Email. 

6. Click Save. 

Test Email 

Enter the Sender Email into the Receiver Email field before clicking the Send button. If the 
email is valid the Status will change to Connected. 

Accessing the Interview Portal 

Use the User Profile to access the Interview Portal and the User Profile settings. See Chapter 
8: Zip for more information. 

Settings 

Settings contain the option to configure email settings. 
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Global Email Settings 

Global Email Settings allow admins, or users with permission, the ability to configure email 
server settings for all users. Email Settings allows the user to add SMTP server information 
to connect Zenly with the user’s chosen emailing service, 

 
Figure 27: Email Settings 

To open the Global Email Settings screen: 

1. Click on the User Profile. 

2. Click Settings. 

3. Enter Sender Name. 

This name will appear in the “From” line next to the user’s email address. 

4. Enter the Sender Email. 

5. Enter the SMTP Server name. See SMTP Server Examples. 

6. Enter the provider’s Port number for the SMTP server. 

7. Enter Login Credentials. 

8. For Modern Authentication: 

• Enter the Application (client) ID. 

• Enter the Directory (tenant) ID. 

• Enter Client Secret Value. 

9. For Secure Connection (SSL/TLS): 

• Enter the User Name. The User Name is the email address used for the chosen 
provider. 

• Enter the App Password. 
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10. To test the connection, enter an email address. 

Server Information 

Use these fields to add the name and server port. 

Sender Name: Enter the name of the email account. 

Sender Email: Enter the email used for the Username if using an SSL/TLS connection. Enter 
Microsoft Outlook© if using Microsoft Authentication. 

SMTP Server: Use the chosen email service provider’s server name. See SMTP Server 
Examples. 

Port: The Port number assigned to the specific SMTP server. 

Login Credentials 

Zenly provides two options to connect to the SMTP server. Outlook accounts should use 
the Modern Authentication option. 

Modern Authentication for Microsoft 

For Modern Authentication for Microsoft: 

1. Paste the Application (client) ID. 

2. Paste the Directory (tenant) ID. 

3. Paste the Client Secret Value. 

4. To test the connection, enter the email address in the Receiver Email field. 

5. Click the Send button. 

A successful connection will change the Status from Disconnected to Connected. 

Locating Azure IDs 

To locate the required IDs: 
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1. Go to Azure Portal > Azure AD > App Registrations. 

 
Figure 28: Login Credentials IDs 

2. To view the Client Secret Value, click the Add a certificate or secret link. 

 
Figure 29: Certificates & Secrets 

Secure Connection (SSL/TLS) 

For a secure connection: 

1. Enter the desired email address in the User Name field. 

2. Enter Password. 

Insert the App-specific password in the field generated by the desired email 
service. See SMTP Server Examples. 

3. Click Save. 

4. To test the connection, enter the email address in the Receiver Email field. 

5. Click the Send button. 
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Test Email 

Use the Receiver Email field to enter where to send an email. 

SMTP Server Examples 

The following table contains SMTP server information. 

• Gmail: 

o Server: smtp.gmail.com 

o Port: 464 (SSL) or 587 (TLS) 

o App Password information: 
https://support.google.com/mail/answer/185833?hl=en 

• iCloud Mail: 

o Server: smtp.mail.me.com 

o Port: 587 

o App Password information: https://support.apple.com/en-us/102654 

• Outlook: 

o Server: smtp-mail.outlook.com 

o Port: 587 

o App Password information: https://support.microsoft.com/en-us/account-
billing/how-to-get-and-use-app-passwords-5896ed9b-4263-e681-128a-
a6f2979a7944 

• Yahoo Mail: 

o Server: smtp.mail.yahoo.com 

o Port: 465 or 587 

o App Password information: https://help.yahoo.com/kb/SLN15241.html 

White Labeling 

Users can change certain aspects of Zenly from the Business Configuration screen. The 
alterations can be made by opening the Settings from the User Profile dropdown menu. 

This function is only available for certain types of Zenly accounts. 

To open the Business Configuration screen: 

1. Select the User Profile dropdown menu. 
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2. Select Settings . 

 
Figure 30: User Profile Settings 

Web Address 

Use the Web Address field to enter a custom sub-domain. 

 
Figure 31: Web Address 

Logo 

Read the recommendations on the screen to ensure that the image file is supported. Use 
the Logo section to add personalized images to the following locations: 

• Login Image – Recommended image size: 208 x 75 px. 

• Site Logo – Recommended image size: 150 x 39 px. 

• Favicon - Recommended image size: 32 x 32 px. 
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To change the image (from desktop):  

1. Select the box associated with the desired location. 

 
Figure 32: Logo Upload 

2. Browse to the desired image. 

3. Select Open. 
An image thumbnail display as a preview in the upload box. 

4. If a Favicon is used, enter the desired text to display in the tab. 

 
Figure 33: Favicon Text 

5. Click Save. 

Display Logo Toggle 

Use the Display Logo toggle to hide or show all the logos in Zenly. 

Load Default Button 

The Load Default button resets the image by replacing custom logos with the default Zenly 
screen logos 
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Alerts 

The Alerts feature displays notifications set by the user. Alerts appear in the bell icon at the 
top of the screen. Select the icon to view the queue. See Alerts Configuration for 
information about managing alerts. 

 
Figure 34: Alerts 

Note: All notifications will appear in the Alerts window. The Alerts window inside of a file will 
also display all the other file’s notifications.  

To clear an alert: 

1. Click on the Select button. 

2. Select the desired alert(s). 

3. Select Clear. 

4. Select Delete in the Delete Confirmation dialog. 

Note: The Mark as Unread button allows read alerts to become re-highlighted and cause 
the alerts counter to increase. 

Creating an Alert 

The user can create alerts by selecting the bell icon in an open lead/loan file. 

To create an alert: 

1. Select the desired Lead/Loan file. 

2. Select the Alerts  icon. 
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3. Select the Add  icon. 

 
Figure 35: Add Alerts 

4. Add the notification information in the Add Alerts dialog. 

 
Figure 36: Add Alert Dialog 
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Leads/Loan Search 

Use the Search field to locate existing leads or loans. 

Note: Zenly allows partial text searches. 

1. Enter the Search criteria. 

 
Figure 37: Loan Search 

2. Press Enter to obtain search results. 

 
Figure 38: Search Results 

3. Clear the Search field and press Enter to return to the full list. 

New File 

The New File button allows the user to create a New Lead or a New Loan file. For more 
information on creating a Lead see Creating a New Lead. For more information on creating a 
loan file see Creating a New Loan File. 

 
Figure 39: New File 
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Chapter 3: LEADS 
A Lead is a person interested in the products or services of a company in any way. The 
Tracking screen allows the user to insert information about the lead. Once the lead chooses 
to continue, the user can initiate the loan process through the Status screen. 

Creating a New Lead 

Use the New Lead button to create a new lead. Selecting the button opens the Lead Status 
screen, where the user can insert information about the lead. For information on archiving 
and deleting lead files, see Archiving Files or Deleting Files. 

  
Figure 40: Creating a New Lead 

Lead Status 

The Status tab contains sections for the user to record information about the lead. Use the 
Contact screen to add desired contacts for the lead. 
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Figure 41: Lead Status 

Lead Tracking 

Lead information added to the Tracking screen is transferable to a loan file (See Initiate 
Loan). 

The user can also select the Lead Invite button to send an interview request to the lead (See 
Creating a Lead Invite). 

Summary Info 

The Summary Info allows the user to see Housing Expense, Debt-to-Income, and the Total 
LTV ratios on the Tracking screen. For mobile users, select the Information icon  to open 
the Summary Info. 

        
Figure 42: Summary Info (Desktop/Mobile) 

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
45 

Lead Tracking Status 

Use the Status options to track and update the status of the lead. The following statuses are 
provided by default: 

• New 

• Prospect 

• Qualified 

• Unqualified 

• Not Interested 

• Future Opportunity 

• Won Opportunity 

• Lost Opportunity 

• Loan Created 

• Other

The user can create additional statuses by using the Template > Dropdown Lists screen. 

Adding a Lead Status 

Add a new status to show the progress of the lead. A new status will populate the table 
without overwriting an existing status. 

To add a status to a lead: 

1. Expand  the Status table. 

2. Click on the Add  button. 

 
Figure 43: Add Status 

3. Choose an option from the Status dropdown menu. 

 
Figure 44: Add Tracking 
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4. If needed, add a Description. 

5. Click Save & Close or Save & New. 

Editing Lead Status 

To edit a status entry: 

1. Select the desired entry from the Status table to open the Edit Tracking dialog. 

2. Select the Calendar icon to change the date or the Clock icon to change the time. 

3. Click on the Status dropdown menu to change the status. 

4. If needed, edit the Description. 

 
Figure 45: Edit Status 
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Alerts (Leads) 

The Alerts section allows the user to view active and cleared alerts for the Lead. Users can 
view the alert by selecting an item from the table. Use the  button to add an alert for the 
lead. 

 
Figure 46: Alerts (Leads) 

Note: Alerts CANNOT be deleted. 

Add Alerts 

To add an alert for the lead: 

1. Click on the  icon. 

2. Enter a Description. 

 
Figure 47: Add Alerts 
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3. Select a Due Date/Time for the alert to notify. 

4. Select Save & Close to close the window. 

Edit Alerts 

Only Active alerts are editable. Select an alert from the Active side of the table to open the 
Edit Alerts screen. 

 
Figure 48: Edit Active Alerts 

Clearing Alerts 

Even if Alerts can’t be deleted, alerts can be cleared. 

To clear an alert: 

1. Select the checkbox for the undesired alert. 

 
Figure 49: Clear Alerts 

2. Select the Clear button. 

The undesired alerts will move to the Cleared section of the table. 
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Conversation Log (Leads) 

Use the Conversation Log to track communication with the lead. 

Note: Conversation Log entries cannot be altered or deleted after saving, adding, or 
removing documents are the only modifications a user can make. 

To add an entry: 

1. Expand  the Conversation Log table. 

2. Select the Add  button. 

 
Figure 50: Add Conversation Log 

3. If needed, link a stored document by selecting the Link icon. 

 
Figure 51: Add Conversation Log Dialog 

4. If needed, select the Upload PDF icon to upload a pdf document into the 
Conversation Log entry. 

5. Select an option from the Type dropdown menu. 

6. If needed, add a Description. 

7. Click Save & Close or Save & New. 

Contact Information 

Contact Information is a section to record personal, as well as spouse’s, information. 

1. Expand  the Contact Information section. 
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2. Enter the lead’s First name and Last name. 

  
Figure 52: Contact Information 

3. If needed, add the Middle name. 

4. If needed, add a Suffix. 

5. Add a Nickname if applicable. 

6. If needed, add the lead’s Email Address. 

7. Select the lead’s preferred Contact Method. 

8. Add SSN/Tax ID of the Lead. 

9. Enter Date of Birth. 
Age will populate automatically. 

10. Enter Martial Status. 

11. Enter the Number of Dependents and the Ages if applicable (Ex. 2,5). 

12. Enter the Lead’s desired Language. 

Note: If Other was selected, enter the desired language in the Other Description field. 

13. Select the lead’s Citizenship status. 

14. Enter the lead’s Credit Score. 

15. Select whether the lead is a First-Time Homebuyer. 

16. Enter the Spouse’s information if applicable. 
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17. Select the Save button at the top of the screen. 

Telephone (Leads) 

Use this section to add any telephone numbers associated with the lead. 

Adding a Telephone Number 

To add a Telephone number: 

1. Expand  the Telephone table. 

2. Click on the Add  button. 

 
Figure 53: Add Telephone 

3. Click on the Type dropdown menu and select an option. 

 
Figure 54: Add Telephone Dialog 

4. Add a description if Other was selected in the Type dropdown menu. 

5. Enter the phone Number. 

6. Enter the Extension if applicable. 

7. If the number entered is preferred by the lead, select the Preferred Contact 
checkbox. 

8. Click on Save & Close or Save & New. 

Editing a Telephone Number 

To edit a Telephone number: 
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1. Expand  the Telephone section. 

2. Select the desired number from the table. 

 
Figure 55: Edit Telephone 

3. Update the desired fields. 

4. Click Save & Close. 

Delete a Telephone Number 

To delete a phone number: 

1. Expand  the Telephone section. 

2. Click on the Delete icon associated with the undesired number. 

 
Figure 56: Delete Telephone Number 

3. Select Delete on the Delete Confirmation dialog. 

Address (Leads) 

The Address table displays addresses associated with the lead. The user can add, edit, or 
delete an address. 

Adding an Address 

To add an Address: 

1. Expand  the Address table. 

2. Select the Add  button. 

 
Figure 57: Add Address 
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3. Select an option from the Type dropdown menu. 

 
Figure 58: Add Address Dialog 

4. Select an Occupancy option. 

5. Enter the Length of Residency. 

6. Enter the Address. 

7. Select a Unit Designator if applicable. 

8. Enter the Number of the unit if applicable. 

9. Enter the City name. 

10. Select the State the address resides in. 

11. Enter the address’ Postal Code. 

12. Enter the County 

13. Select the Country. 

14. Click on Save & Close or Save & New. 

Editing an Address 

To edit an Address: 

1. Expand  the Address section. 

2. Click on the desired address in the table. 

3. Update the desired fields. 

4. Click Save & Close. 
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Delete an Address 

To delete an Address: 

1. Expand  the Address section. 

2. Select the Delete icon associated with the undesired address. 

3. Select Delete on the Delete Confirmation dialog. 

Loan Information (Leads) 

The user can enter loan information of the lead in this section. 

 
Figure 59: Loan Information 

1. Expand  the Loan Information section. 

2. Select the Loan Type. 

Note: If Other is selected, enter a description in the Other Description field. 

3. Choose a Loan Purpose. 

Note: If Other is selected, enter a description in the Other Description field. 

4. Select the Construction Type if applicable. 

5. If Refinance was selected in the Loan Purpose dropdown menu, select a Cash-Out 
Type. 

6. Select the type of Occupancy. 

7. Select the Lien Position. 

Note Details (Leads) 

The user can enter Note Details in this section. 
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1. Expand  the Note Details section. 

 
Figure 60: Note Details 

2. Enter the Estimated Appraised Value. 

3. Enter the Sales Price. 

4. Enter the Base Loan Amount. 

5. Enter the Down Payment Amount. 

Note: Selecting the Calculator icon opens the Down Payment dialog that allows the user to 
enter the down payment percentage. 

6. Enter the Note Rate. 

7. Enter the Amortization Term in Months. 

8. Enter the PMI/MIP/VA/USDA percentage if applicable. 

Note: The PMI/MIP/VA/USDA Amount, Total Loan Amount w/MIP.FF, and Monthly Payment 
fields are auto populated. 

Subordinate Financing (Leads) 

User the Subordinate Financing section to enter additional financing information for the 
Lead. 

 
Figure 61:Subordinate Financing (Leads) 

Adding Subordinate Financing Information 

To add loan information: 

1. Expand   

2. Click on the  icon. 
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3. Select the Loan Position. 

 
Figure 62: Add Subordinate Financing 

4. Enter the Creditor Name. 

5. Enter the Source/EIN. 

6. Select the Source Type from the dropdown menu. 

Note: If Other was selected, add a description (Other Description). 

7. If needed, select an option for the First Loan Mortgagee. 

8. If needed, enter the Original Loan Amount. 

9. Select the Affordable Loan checkbox if applicable. 

10. Enter the Loan Amount. 

11. Enter the Note Rate. 

12. Enter the Qual Rate. 

13. Enter the Amortization Terms in months. 

14. Enter the Loan Terms in months. 

15. Enter the Interest Only months if applicable. 

16. The Monthly Payment field is calculated automatically. Edit the payment amount if 
needed. 

17. Enter the Credit Limit if applicable. 

18. Select the Qualify Ratios at the interest Only Payment checkbox if applicable. 
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Editing Subordinate Financing Information 

Select the desired entry from the table to open the Add Subordinate Financing dialog to edit 
the information. 

 
Figure 63: Edit Subordinate Financing (Leads) 

Deleting Subordinate Financing Information 

Select  icon delete the loan information. 

 
Figure 64: Delete Subordinate Financing Information 

Proposed Housing (Leads) 

This section allows the user to enter proposed housing expenses. If the Loan Information 
and Note Details section were completed, the mortgage would populate in this section. If 
needed the user can add additional proposed housing expenses. 

Adding Proposed Housing 

To add an expense: 

1. Expand  the Proposed Housing section. 

2. Click on the Add  button. 

 
Figure 65: Proposed Housing 
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3. Select a Housing Expense Type. 

Note: If Other was selected, enter the Other Description. 

 
Figure 66: Add Proposed Housing Expenses 

4. Select an option from Based On dropdown menu. 
The option determines how the expense is calculated. 

5. Enter a Fee Percentage if applicable. 

6. Enter a Monthly Dollar Amount if applicable. 

The Monthly Amount fields will auto populate based on options entered and 
selected in this dialog. 

7. Select Save & New or Save & Close. 

Editing Proposed Housing Expenses 

To edit an expense: 

1. Expand  the Proposed Housing section. 

2. Select the desired expense. 

3. Update the desired fields. 

4. Select Save & Close. 

Deleting Proposed Housing Expenses 

To delete an expense: 

1. Expand  the Proposed Housing section. 

2. Select the Delete icon associated with the undesired expense. 

3. Select Delete in the Delete Confirmation dialog. 
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Primary Housing (Leads) 

The Primary Housing expense section allows the user to enter the lead’s current housing 
expenses. 

Adding Primary Housing Expenses 

To add a Primary Housing expense: 

1. Expand  the Primary Housing section. 

2. Select the Add  button. 

 
Figure 67: Primary Housing 

3. Select a Type. 

Note: If the Other option was selected, enter Other Description. 

 
Figure 68: Add Primary Housing Dialog 

4. Enter the Amount. 

5. Click Save & New or Save & Close. 

Editing Primary Housing Expenses 

To edit an expense: 

1. Expand  the Primary Housing section. 

2. Select the desired expense. 

3. Update the desired fields. 

4. Click Save & Close. 
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Deleting a Primary Housing Expense 

To delete an expense: 

1. Expand  the Primary Housing section. 

2. Select the Delete icon on the undesired expense. 

3. Click Delete on the Delete Confirmation dialog. 

Income (Leads) 

The Income section allows the user to enter the lead’s sources of income. 

Adding a Source of Income 

 To add a source of income: 

1. Expand  the Income section. 

2. Select the Add  button. 

 
Figure 69: Income 

3. Select the Source. 

Note: If Other was selected, enter an Other Description. 

 
Figure 70: Add Income Dialog 

4. Enter the Amount. 

5. Click Save & New or Save & Close. 

Editing a Source of Income 

To edit a source of income: 

1. Expand  the Income section. 
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2. Select the source of income. 

3. Update the desired fields. 

4. Select Save & Close. 

Deleting a Source of Income 

To delete a source of income: 

1. Expand  the Income section. 

2. Select the Delete icon associated with the undesired income source. 

3. Select Delete in the Delete Confirmation dialog. 

Liabilities (Leads) 

This section allows the user to pre-emptively add liabilities that the lead holds. 

Adding a Liability 

To enter liabilities: 

1. Expand  the Liabilities section. 

2. Select the Add  button. 

 
Figure 71: Liabilities 

3. Add the Company Name. 

 
Figure 72: Add Liability Dialog 
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4. Select an option from the Credit Account Type dropdown. 

5. Select a Liability Type. 

Note: If Other was selected, enter an Other Description. 

6. Enter the Account Number. 

7. For Mortgage Loans, enter the Credit Limit if applicable. 

8. Select the Subject Property checkbox if applicable. 

9. Enter the Current Balance. 

10. Enter the Remaining Balance if applicable. 

11. Enter the Payments Remaining. 

12. Select the Paid off at closing checkbox if applicable. 

13. Select the Omitted checkbox if applicable. 

14. Select Save & New or Save & Close. 

Editing a Liability 

To edit a liability: 

1. Expand  the Liabilities section. 

2. Select the desired liability. 

3. Update the desired fields. 

4. Select Save & Close. 

Deleting Liabilities 

To delete a liability: 

1. Expand  the Liabilities section. 

2. Select the Delete icon associated with the undesired liability. 

3. Select Delete in the Delete Confirmation dialog. 

Other Expenses 

All additional expenses that the lead wants to disclose are added to this section. 

Adding Other Expenses 

To add an expense: 

1. Expand  the Other Expenses section. 
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2. Select the Add  button. 

 
Figure 73: Other Expenses 

3. Select an option from the Type dropdown menu. 

 
Figure 74: Other Expenses Dialog 

Note: If Other was selected, enter an Other Description. 

4. Enter who the expense is Owed To if applicable. 

5. Enter a Description if applicable. 

6. Enter the remaining payments (Payments Remaining). 

7. Enter the Monthly Payment. 

8. Select the Omit checkbox if applicable. 

9. Select the Save & New or Save & Close. 

Editing Other Expenses 

To edit an expense: 

1. Expand  the Other Expenses section. 

2. Select the desired expense. 

3. Update the desired fields. 

4. Click Save & Close. 
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Deleting Other Expenses 

To delete an expense: 

1. Expand  the Other Expenses section. 

2. Select the Delete icon associated with the undesired expense. 

3. Select Delete in the Delete Confirmation dialog. 

Additional Information (Leads) 

Use the Additional Information field to add any notes about the lead. The expansion icon at 
the bottom-right corner can increase or decrease the size of the text box. 

 
Figure 75: Additional Information 

Contacts (Leads) 

The Contacts screen provides a location for entering information about people of interest 
(Ex.: Appraiser, Broker, Doc Preparer). 

To add a contact: 

1. Select the Add  icon. 

 
Figure 76: Contacts (Leads) 
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2. Select a Contact Type. 

 
Figure 77: Add Contacts Dialog (Leads) 

Note: If the Other was selected, enter a label for the Other Type. 

3. If needed, enter a Reference. 

4. If Seller #1, 2, 3, 4 are selected, ensure that an option is selected from the Entity 
dropdown menu. 

5. Enter contact information of the individual or the entity. 

Additional Details 

Add additional information about the contact’s licenses or identification. 

 
Figure 78: Additional Details 
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Select a license/identification in the list to add details. 

 
Figure 79: Edit Detail Dialog 

Adding Contacts Using the Directory 

Use the Directory  icon to add contacts from the Directory. For more information about the 
Directory see Directory. 

To add contacts: 

1. On the Status screen. 

2. Select the Directory  icon. 

3. Choose the desired contact(s) or use the Search bar to enter a contact parameter. 

Note: Only one of each Contact Type is allowed per Lead if multiple contacts are selected 
from the Directory. 

Note: If a contact of the same type was selected, Zenly will prompt the user to overwrite 
the prior contact. 

 
Figure 80: Add from Directory 
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4. Click OK. 

 
Figure 81: Contact Through Directory 

Note: Contacts that are added from the Contacts screens can be added to the Zenly 
Directory by selecting the icon displayed next to the Delete  icon. 

History 

The History table shows the loans initiated from the opened Lead file. Loans are manually 
linked by using the Link icon. 

 
Figure 82: History 

Linking a Loan file 

To manually link a loan to the Lead file: 

1. Select the Link  icon. 
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2. Choose the desired loan file. 
If needed, search for a specific Loan file using the Search Bar. 

 
Figure 83: Link Loan 

3. Click Save & Close. 

Copying a Loan from the History Table 

The option to copy the Loan file is available if needed. Select the Copy  icon. 

 
Figure 84: Copy History Entry 

To copy a History entry: 

1. Select the Copy  button. 

2. Choose 1003 Only or Full Loan to copy. 

 
Figure 85: Copy Loan 
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Unlinking Loan File 

To unlink any undesired Loan files to the Lead, click on the Unlink  icon to remove the 
loan from the History table. 

 
Figure 86: Unlink Loan 

Qualification 

The Qualification screen allows the user to provide Loan Comparisons for the lead. 

Loan Comparisons 

The Loan Comparisons screen allows the user to swiftly create loan scenarios and compare 
loan possibilities. Use the Loan Comparisons screen to create, copy, delete, and compare 
loan scenarios. Use the Loan Scenario tables to create and arrange loan scenarios. 

A default loan scenario entry, containing the information from the Status screen, appears as 
the first loan scenario at the top of the table. This scenario CANNOT be deleted. 

Note: Dragging and dropping a loan scenario to the top of the table will prompt Zenly to 
sync the scenario with the Lead file. Information contained in the scenario will transfer to the 
Leads Status screen. 

 
Figure 87: Loan Comparison 

To compare loan scenarios: 

1. Select the desired 2 or 3 scenarios in the table. 

Note: The user can select a maximum of three (3) loan scenarios to compare. 
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2. Enter how many months to compare. 

 
Figure 88: Months to Compare 

3. Click on the Compare button. 

 
Figure 89: Compare Scenarios 

Note: The scenarios are available in print form through the Documents tab. 

Copying a Loan Scenario 

Select the  icon to replicate the desired loan scenario. A maximum of one loan scenario 
can be copied. 

To copy a loan scenario: 

1. Select the desired loan scenario. 
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2. Select the  icon. 

 
Figure 90: Copy Loan Scenario 

Drag & Dropping Scenarios 

Users can arrange loan scenarios by dragging & dropping them in the desired order. 

 
Figure 91: Drag & Drop Scenario 
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Generated Loan Scenario Documents 

When generating a printable Loan Comparison document, ensure that the desired scenarios 
are selected. The selected loan scenarios appear in the printed Loan Comparison. A 
maximum of 3 scenarios will appear in the printed document. 

 
Figure 92: Scenarios 

Creating Loan Scenarios 

Before loans can be compared, create, and add loan scenarios to the table. 

To create a Loan Scenario: 

1. Select the Add  icon. 

 
Figure 93: Loan Scenario 
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2. Enter a Product name. 

Note: A Product name is required before saving and exiting. 

 
Figure 94: Create Scenario 

3. If needed, click the Select button to choose a Loan Program Scenario. 

Note: The tables will auto-populate based on the scenario selected. 

4. If needed, click the Select button to choose a Fees Template. 

Note: The tables will auto-populate based on the selected template. 

5. Adjust the desired values in the Loan Information section. 

Loan Information 

Use the Loan Information section to add or adjust the fields to the desired values. Save after 
adding or adjusting values before continuing to the next step. Fields will auto-populate if a 
Loan Program is chosen. 

 
Figure 95: Loan Information 
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Note Details 

Enter Note Details to add the mortgage value and expected monthly payment to the 
scenario. 

 
Figure 96: Note Details 

PMI/MIP/VA/USDA 

If needed, add information for mortgage insurance. Save after adding or adjusting values 
before continuing to the next step. 

 
Figure 97: PMI/MIP/VA/USDA 
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Subordinate Financing (Loan Scenario) 

Select the  icon to add Subordinate Financing information if applicable. 

 
Figure 98: Subordinate Financing (Loan Scenario) 

Rate Adjustment 

If needed add any rate adjustment to the scenario. Save after adding or adjusting values 
before continuing to the next step. 

 
Figure 99: Rate Adjustment Scenario 
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Proposed Housing Expenses 

Use this section to include any housing expenses in the loan scenario. Once satisfied with 
the added expenses, click Next. 

 
Figure 100: Housing Expenses Scenario 

Estimated Closing Cost 

Use this section to include any closing costs to the scenario. Use the Fee Template 
dropdown menu to auto-populate the table. Adjust any desired value and select the Save & 
Exit button. 

 
Figure 101: Estimated Closing Costs 
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Deleting a Loan Scenario 

To delete a loan scenario, select the  icon. 

 
Figure 102: Deleting Loan Scenario 

Documents Stored (Leads) 

The Stored screen allows the user to upload PDFs and store them. Use this screen to view 
any stored documents or delete unnecessary ones. 

 
Figure 103: Lead Documents 

Uploading a PDF 

To upload a PDF: 

File Types allowed: 

• TXT 
• MSG 
• PDF 
• PNG 

• JPEG 
• JPG 
• GIF 
• DOCX 
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• BMP 
• RTF 
• HTML 

• TIFF 
• XML 

 

1. Select the Upload  icon. 

2. Enter a Document Name. 

 
Figure 104: Upload Dialog 

3. Choose a Category for the document. 

4. Select a Prepared Date. 

5. Enter a Package Name. 

6. Click the Choose File button to browse for the desired PDF. 

7. After the PDF is chosen, select Open. 

8. Click on the Store button to complete the upload. 

Searching for Lead Documents 

Use the Search Bar to locate a specific PDF. 

To search for a PDF: 

1. Click inside the text field. 

2. Enter the name of the document. 

3. Press Enter or click on the magnifying glass icon. 
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Previewing, Downloading, and Deleting 

The entries contain functions for each uploaded. The user can preview, download, or delete 
the desired PDF. 

 
Figure 105: Table Functions 

Documents Generate (Leads) 

Generate printed loan comparisons. Preview the generated document by selecting the 
associated icon when selecting Loan Comparison. 

 
Figure 106: Documents Generate 

To generate a printable loan comparison document: 

1. Ensure that the desired loan scenarios are arranged at the top of the Loan 
Comparison table. See Generated Loan Scenario Documents. 

2. Select Documents > Generate. 

3. Select Loan Comparison. 
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4. Select Store. 

Note: Stored loan comparisons are available in Documents > Stored for leads. 

 
Figure 107: Store Document 

5. Enter Package Name or use the Skip button to progress. 

6. Click Set. 

Document Request (Leads) 

The Document Request screen allows the user to request documents from the lead. 

Note: Document request recipients must have a valid email address on file. 

1. Select Documents. 

2. Select Request. 

 
Figure 108: Documents Request (Leads) 

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
81 

Pending 

Use the Pending options to request missing documents from appropriate parties. 

1. Click the Add  button. 

2. Select or enter the Document Name. 

 
Figure 109: Add Document Request Dialog (Leads) 

3. Select the document Category from the dropdown. 

Note: Leave Category blank when the document category is not listed. 

4. Use the Calendar to select the Due date and Time. 

5. Enter a memo to the document recipient if Memo to Borrower does not auto 
populate. 

6. Click Save & Close or Save & New. 

7. Click Send when requested documents are listed. 

 
Figure 110: Send Document Request (Leads) 
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8. Click Send To. 

 
Figure 111: Send Document Request 

Review 

Document requested appears in the Review List after return from requestor. 

1. Click the Preview icon. 

 
Figure 112: Review Received Documents 

2. Click Accept to approve the received document. 

3. Click Reject to reject the document. 

Note: The rejected document moves back to the Pending List to return the document to the 
requestor. 

Completed 

Accepted documents move to the Completed List. 

 
Figure 113: Completed Document Requests 
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Run Pricing 

The Run Pricing function for leads works to find a suitable loan product for the lead. Use this 
screen to filter through the available loan products and select eligible products for the lead. 

If users don’t have Login Credentials saved for Pricing, Zenly allows the user to have access 
to the Run Pricing button. Market pricing will be available for users without credentials. 

To use the Run Pricing function: 

1. Open the desired Lead file. 

2. Enter applicable information for the Status screen. 

3. Select Run Pricing. 

 
Figure 114: Run Pricing 

Availability Screen 

1. Ensure that the Available Products Search table contains the correct information. 

Note: Values in the Availability Search table are auto-populated from the Status screen. 

OR 
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2. Click on the Select button to choose a Loan Program Scenario. See Loan Program. 

 
Figure 115: Choose a Loan Program 

Note: If no lead information is added to the Available Products Search table, all loan 
products will appear on the Available Products table. 

3. Select the desired Group ID from the dropdown menu. For more information about 
creating a Group ID, see Pricing Service. 

4. Select the desired product(s) from the investor. 

5. Click Save. 

6. Click Next. 

Eligibility Screen 

Review the information in the Eligibility screen. 

1. Edit or enter Loan Information if applicable. 

Note: Select a single product from the Showing Eligibility for dropdown menu to show 
eligibility parameters for that one product. 

 
Figure 116: Select Products 
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2. Edit or enter Borrower Information if applicable. 

3. If needed, select Product Features. 

4. Edit or select Property Information. 

5. Click Save. 

6. Click Next. 

Pricing Screen 

The Pricing screen will populate products that are eligible and ineligible for the lead. 
Expand the table to see all loan products that fit or don’t fit the lead’s criteria. 

Eligible Product 

Expand the Eligible Products table to view all loan products to view all loan products that fit 
the lead’s criteria. 

Select the Calendar  icon to view the Interest Rate table for the selected loan product. Rate 
Adjustments and Price Adjustments appear below the table. 

 
Figure 117: Eligible Products 

To choose the Eligible Products: 
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1.  Expand  the Eligible Products table. 

2. Select the desired loan products. 

3. Select Save Scenario. 

4. Select either or both to save as a New Loan Comparison Scenario(s) and/or to the 
Lead’s Loan Information table. 

 
Figure 118: Save Pricing Scenario 

5. Use the dropdown menu to select the desired product. 

6. Click OK. 

To view this Pricing Scenario(s), see Loan Comparisons. 

Ineligible Product 

Expand the Ineligible Products table to view all loan products that don’t fit the lead’s criteria. 

The table lists the ineligible products as well as the cause for the product’s ineligibility. 

 
Figure 119: Ineligible Products 
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Sending an Email 

Use the Email button to send emails through Zenly. 

Note: Email Settings must be configured before using this function. See Global Email 
Settings. 

 
Figure 120: Email Button 

If needed, select the Send Individually checkbox or choose a template. Attach documents to 
the email by selecting the Upload icon (Upload PDF) or by linking a stored document in 
Zenly. 

 
Figure 121: Send Email 

Creating a Lead Invite 

Use the Lead Invite option to send an existing or potential customer a link. The link provides 
customers with access to a personal Point of Sale (POS) website. 

1. Open or create a new Lead. See Creating a New Lead. 
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2. Click the Lead Invite button. 

 
Figure 122: Invite Lead Button 

3. Select the invitation Type from the dropdown. 

 
Figure 123: Lead Invite Dialog 

4. Enter contact details. (phone number or email address). 

5. Enter the Contact First and Last Names. 

6. Enter a memo to introduce the borrower to the link for the Interview portal. 
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Initiate Loan 

The Initiate Loan button allows the user to start the loan process by creating a loan file from 
the lead. Zenly will use the available information in the lead. 

 
Figure 124: Initiate Loan Button 

To initiate a loan: 

1. Select the Initiate Loan button. 

2. Select File Contact or Import Data from ZIP Interview if applicable. 
Borrower information will import from Zip if the Import Data option is selected. 

 
Figure 125: Initiate Loan Screen 

3. If needed, use the Loan Scenario drop-down menu to select a stored scenario. 

Note: If there are no documents uploaded for the lead, the Select Document step will not 
appear. 
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4. If documents are stored, select the desired PDFs to copy over to the loan file. 
Use the icons associated with the documents to preview or delete the selected 
PDF. 

 
Figure 126: Selected Documents 

5. Click Next. 

6. Review the Summary. 

7. Click on the Create Loan button to complete the initialization. 

 
Figure 127: Summary 
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Chapter 4: LOANS 
This chapter Loan files are performed by selecting the Zenly Logo and the Leads/Loans 
contains the loan files the user has available. The user can identify a Loan file by the icon . 
Use either a screen to create a new loan file or open an existing loan. 

 
Figure 128: Leads/Loans 

New Loans 

Create new loans by completing the Zenly screens during a borrower interview or using the 
import function. Users can import single or batch loan files. 

Creating a New Loan File 

Use the New File button to create a new loan file during a borrower interview. 

1. Click New File. 

2. Select the New Loan option. 

 
Figure 129: Create New Loan 
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3. Select the Blank Loan option. 

4. Click Create. 

 
Figure 130: Create Loan Dialog 

5. Proceed to Application - Borrower. 

Importing Loan Files 

Use the import function to import Fannie Mae 3.2 (FNM) and Fannie Mae MISMO 3.4 (XML) 
files. 

To import loan files: 

1. Select New File. 

2. Select New Loan. 

 
Figure 131: Create New Loan 

3. Select the Import option. 

4. Click Select Files. 
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Figure 132: Import Loans 

5. Browse to the stored FNM/XML files. 

6. Highlight the file. 

7. Click Open. 

Drag & Drop Import 

Use the drag and drop import feature to drag FNM/XML files to Zenly instead of browsing 
to the file(s). 

1. Access the Zenly Loan List. (See Figure 7.) 

2. Browse to the stored FNM and/or XML files. 

3. Select the files. 

4. Drag the files to the loan list. 

5. Click Import. 

6. Click Close when import is complete. 

Loan Status 

The Status tab enables loan progress tracking from prequalification to closing. The Loans 
Status screens provide status information for the selected loan. The following options are 
available for loan status. 

Loan Export 

Use the loan Export option to select and export files from Zenly to a designated location. 
Zenly exports the loan application as an XML file. 

1. Select a file. 
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Figure 133: Export File 

2. Click Export. 

3. Click Open File to view the exported file. 

4. Click the Ellipse to view export options. 

 
Figure 134: Export Options 

Note: The exported file is an XML file when exporting the Loan Application. 

5. Select the appropriate Export option. 

6. Browse to the appropriate folder and save the export. 

Note: See Industry Connect for sending exported files to third-party vendors. 

Status Tracking 

The Status Tracking screen opens by default after selecting a loan. Use the Tracking 
options to track and update loan application/processing status. 

Track Loan Status 

Review and update loan status information. Only the Status Description can be updated from 
the Status List. The Status as well as the Date/Time synch with the Closed Date and the 
Application Date for the Mortgage Call Report. See Mortgage Call Report 2024. 

Note: See Add Status to enter a new loan status. 

1. Select the Status. 
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2. Select Tracking. (See Figure 133.) 

3. Click current Status to edit. 

4. Update the Description. 

 
Figure 135: Update Status 

5. Click Save & Close. 

Add Status 

Add new loan statuses as the application progresses. The new status populates in the 
Status list without overwriting existing statuses. 

Note: To change the Status of the loan file, use Add Status to change a loan “Lead” to a loan 
“Application”. 

1. Click Add. 

 
Figure 136: Add Loan Status 

2. Select the appropriate status from the dropdown. 
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Figure 137: Add Status Dialog 

3. Enter status Description. 

4. Click Save & Close to add the status to the Status List. 

 
Figure 138: New Application Status 

Note: Use Save & New to add another status. 

Edit Loan Status 

To edit a status entry: 

1. Select the desired entry from the Status table to open the Edit Tracking dialog. 

2. Select the Calendar icon to change the date or the Clock icon to change the time. 

3. Click on the Status dropdown menu to change the status. 
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4. Use the Description textbox to edit any text. 

 
Figure 139: Edit Status 

5. Click Save & Close. 

Alerts 

The Alerts section allows the user to view active and cleared alerts for the loan. Users can 
view the alert by selecting an item from the table. Use the  button to add an alert for the 
loan. 

 
Figure 140: Alerts (Loans) 

Note: Alerts CANNOT be deleted. 

Add Alerts 

To add an alert for the loan file: 

1. Click on the  icon. 
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2. Enter a Description. 

 
Figure 141: Add Alerts 

3. Select a Due Date/Time for the alert to notify. 

4. Select Save & Close to close the window. 

Edit Alerts 

Only Active alerts are editable. Select an alert from the Active side of the table to open the 
Edit Alerts screen. 

 
Figure 142: Edit Active Alerts 

Clearing Alerts 

Even if Alerts can’t be deleted, alerts can be cleared. 

To clear an alert: 
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1. Select the checkbox for the undesired alert. 

 
Figure 143: Clearing Alerts 

2. Select the Clear button. 

The undesired alerts will move to the Cleared section of the table. 

Status Contacts 

The Status Contacts List provides a location to save contact information for relevant loan 
contacts. 

Add Contact 

Add additional loan Contacts to the Contact List. 

1. Select the Add  button. 

 
Figure 144: Add Contact 
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2. Enter Contact details. 

 
Figure 145: Add Contacts Dialog 

3. Select Additional Details fields to add information if required. 

 
Figure 146: Additional Contacts Details 
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4. Click Save & Close. 

Note: Click Save & New to add another contact. 

Edit Contacts List 

Use the following steps to edit the loan Contacts List. 

1. Select the Status. 

2. Select the Contacts tab. 

3. Click a Contact entry to edit. 

 
Figure 147: Loan Contacts List 

4. Make appropriate contact information changes. 

 
Figure 148: Edit Contacts Dialog 

5. Select Additional Details fields to edit information if required. (See Figure 146.) 

6. Click Save & Close. 
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Delete Contact 

Delete contacts that are no longer required. 

1. Click the Delete icon for the contact to delete. 

 
Figure 149: Delete Contact 

2. Click Delete on the Delete Confirmation dialog. 

Adding Contact Using the Directory 

Use the Directory  icon to add contacts from the Directory. For more information about the 
Directory see Directory. 

To add contacts: 

1. On the Status screen. 

2. Select the Directory  icon. 

3. Choose the desired contact(s) or use the Search bar to enter a contact parameter. 

Note: Only one of each Contact Type is allowed per Loan if multiple contacts are selected 
from the Directory. 

Note: If a contact of the same type was selected, Zenly will prompt the user to overwrite 
the prior contact. 

 
Figure 150: Add from Directory 
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4. Click OK. 

 
Figure 151: Contact Through Directory 

Note: Contacts that are added from the Contacts screens can be added to the Zenly 
Directory by selecting the icon displayed next to the Delete  icon. 

Status Conversations 

Use Status Conversations to track communications with borrowers and loan contacts. 

Note: Conversation Log entries cannot be altered or deleted after saving. 

1. Select the Status tab. 

2. Select Conversation Log. 

 
Figure 152: Loan Conversations 

3. Click Add. 

  

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
104 

4. Enter conversation details. 

 
Figure 153: Add Item Dialog 

5. Click Save & Close to add the item to the Conversation Log. 

Loan Application 

Use the Loan Application screens to enter/update borrower and loan information details. 

Application - Borrower 

The Application > Borrower screen contains options for capturing borrower details. Enter 
initial borrower information and return to update as additional information is provided. 

1. Select the Application tab. 

 
Figure 154: Application Borrowers 
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2. Select Borrower. 

Note: The Borrower radio button title populates with the primary borrower’s name after 
completing the Borrower Information. (See Borrowers for details.) 

3. Select the radio button for a listed borrower to view an overview of the selected 
borrower. 

4. Drag and drop the desired borrower to the top of the table to make them the 
Primary borrower. 

5. Use the Loan Originator dropdown menu to select the desired contact. 

Note: The selected loan originator will auto-populate on the screen. Selecting a new loan 
originator from the dropdown menu will replace the existing one. 

6. Select the Loan Originator Signature Date. 

Borrowers 

Borrowers may be added to the loan throughout the loan process. 

Add Borrower 

Use the following steps to add a borrower other than co-borrower to the loan. 

1. Click the Add Borrower icon. 

 
Figure 155: Add Borrower 

2. Proceed to Borrower/Co-Borrower Information to complete the borrower details. 

Import From Leads 

The user can import a borrower by using leads. 

To Import from Leads: 

1. Select the Add Borrower icon. 

 
Figure 156: Adding a Borrower 
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2. Choose Import from Leads. 

 
Figure 157: Import from Leads 

3. Click Next. 

4. Search for the desired Lead Contact using the search bar. 

Note: If the Lead contains no stored documents, the screen will skip to the Summary step. 

 
Figure 158: Searching Leads 

5. Click on the magnifying glass icon or press Enter. 

6. Select a lead from the results table. 

7. Select either File Contact or Import Data from Interview. 

8. Click Next. 
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9. Select the desired stored documents to move the items to the Selected 
Documents table. 

 
Figure 159: Select Documents 

10. Click Next. 

11. Review the Summary. 

 
Figure 160: Summary 

12. Click Import. 

Delete Borrower 

Use the following steps to delete a borrower from the loan. 

Note: The primary borrower cannot be deleted if other borrowers are not listed on the loan. 
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1. Select the borrower to delete. 

 
Figure 161: Delete Borrower 

2. Click Delete Borrower. 

3. Click Delete on the Delete Confirmation dialog. 

Swap Primary Borrower 

Use the following steps to swap the primary borrower and co-borrower. Information 
automatically updates to match the new primary borrower when the swap is complete. 

1. Click the Primary Borrower set. 

 
Figure 162: Edit Borrower 

2. Click the Edit Borrower icon. 

3. Select the Swap radio button. 

 
Figure 163: Swap Primary Borrower 

4. Click Save & Close. 

5. Proceed to Borrower/Co-Borrower Information to complete the borrower details. 

Separate Borrowers 

Use the following steps to separate borrowers into the same borrower set. Separate 
borrowers become single borrowers in the Borrower List. 

Note: Separate a borrower set to enable deleting a borrower from the loan. 

1. Select the Borrower Set. (See Figure 162.) 
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2. Click the Edit Borrower icon. 

3. Select the Separate Borrower radio button. 

 
Figure 164: Separate Borrowers 

4. Click Save & Close. 

Merge Borrowers 

Use the following steps to merge borrowers. 

1. Select one of the borrowers to Merge. (See Figure 162.) 

2. Click Edit Borrower. 

3. Select the appropriate Merge As option. 

 
Figure 165: Merge Borrowers 

4. Select the borrower to merge With. 

5. Click Save & Close. 

Borrower/Co-Borrower Information 

Complete the screen details with as much information as possible. Return to the Borrower 
and Co-Borrower fields to update as additional information becomes available. 
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1. Select Borrower from the Application tab. 

 
Figure 166: Borrower/Co-Borrower Information 

Note: Select Unmarried from the Marital Status dropdown to enable the Unmarried 
Addendum fields. 

2. Complete the Borrower and Co-Borrower fields with available information. 

Unmarried Addendum 

Use the Unmarried Addendum when the borrower resides in a state that recognizes civil 
unions, domestic partnerships, or registered reciprocal beneficiary relationships. 

1. Select the appropriate Shared Property Rights option. 

  
Figure 167: Unmarried Addendum 

Note: Proceed to Telephone if answering No in Step 1. 

2. Select the appropriate Domestic Relationship option. 

3. Enter Other Description when selecting Other for Domestic Relationship. 
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4. Select the appropriate State. 

Telephone 

Contact telephone numbers are required for all borrowers. 

Add Telephone 

Use the following steps to complete the borrower/co-borrower Telephone fields. 

1. Click the Borrower Telephone Add button. 

 
Figure 168: Add/Edit Telephone Number 

2. Select Telephone Type. 

 
Figure 169: Add Telephone Dialog 

3. Enter the Other Description when Other is selected from the Type dropdown. 

4. Enter the Telephone Number. 

5. Enter an Extension when appropriate. 

6. Select the Preferred Contact checkbox if the entered number is the preferred 
contact type. 

7. Click Save & Close. 

Note: Click Save & New to add another telephone number. 

8. Repeat Steps 1 – 7 for the Co-Borrower. 
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Edit Telephone 

Use the following steps to edit a listed telephone number. 

1. Click the phone Number to edit. (See Figure 168.) 

2. Update the Telephone Information on the Edit Telephone dialog. (See Add 
Telephone for details.)  

3. Click Save & Close. 

Delete Telephone 

Use the following steps to delete a listed telephone number. 

1. Click the Delete icon. (See Figure 168.) 

 
Figure 170: Delete Confirmation 

2. Click Delete on the Delete Confirmation dialog. 

Addresses 

Enter borrower/co-borrower current address information. Important selections for the Add 
Address dialog entries include: 

• Select Previous from the Type dropdown list and add addresses to cover the 
required timeframe. 

• Select Current from the Type dropdown list where the address listed is also the 
mailing address. 

• Enter the Postal Code to auto-populate the City and State/Providence fields. 

Add Address 

Use the following steps to add borrower addresses. 

1. Click the Borrower Address Add button. 
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Figure 171: Add/Edit Current Address 

2. Select the appropriate Type from the dropdown. 

 
Figure 172: Add Address Dialog 

3. Select the Occupancy from the dropdown. 

Note: Monthly rent amount is added from the Monthly Housing Expenses section. If the 
borrower has a Positive Rental History, select the checkbox. 

4. Enter Length of Residency. 

5. Enter the borrower Address Information. 

Note: The Country Code auto-populates based on the Country selected. 

6. Click Save & Close. 

Note: Click Save & New to add another address. 

7. Repeat Steps 1 – 6 for the co-borrower when appropriate. 

Edit Address 

Use the following steps to edit a listed address. 

1. Click the Borrower Address to edit. (See Figure 171.) 
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2. Update the Address Information on the Edit Address dialog. (See Add Address for 
details.)  

3. Click Save & Close. 

Delete Address 

Use the following steps to delete a listed address. 

1. Click the Delete icon. (See Figure 171.) 

2. Click Delete on the Delete Confirmation dialog. 

Employment 

A minimum of two years’ employment history is required. 

Add Employment 

Enter employment information for the borrower/co-borrower. 

1. Click the Borrower Add button. 

 
Figure 173: Add/Edit Employment History 

2. Enter Employer name. 

 

Figure 174: Add Employer Dialog 
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3. Complete the Employer Address fields. 

Note: Enter the Postal Code to auto-populate the City and State fields. 

4. Select the Country. 

5. Enter employer contact Telephone Number. 

6. Enter an Extension if appropriate. 

7. Select the Employed by family checkbox when appropriate. 

8. Select the appropriate Employment Status. 

9. Select the Employment Classification. 

10. Enter the Employer Position. 

11. Use the Calendar to select the Start Date. 

12. Complete the Length of Employment fields. 

13. Complete the Years in Occupation fields. 

14. Select the Foreign Income checkbox if applicable. 

15. Select the Seasonal Income checkbox if applicable. 

16. Select the Business Owner/Self-employed checkbox if appropriate. 

17. Complete the Ownership Interest and Monthly Income fields when selecting the 
checkbox. 

18. Click Save & Close. 

Note: Click Save & New to add another employer’s information. 

19. Repeat Steps 1 – 13 for co-borrower Employment History. 

Edit Employment 

Use the following steps to edit a listed employer. 

1. Click the Employer name. (See Figure 173.) 

2. Update the Employer Information on the Edit Employer dialog. (See Add 
Employment for details.)  

3. Click Save & Close. 

Delete Employment 

Use the following steps to delete a listed employer. 

1. Click the Delete icon. (See Figure 173.)  

2. Click Delete on the Delete Confirmation dialog. 
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Income 

Individual gross income details are required for the borrower/co-borrower. 

Add Income 

Use the following steps to add income. 

1. Click the Borrower Add button. 

 
Figure 175: Gross Monthly Income 

2. Select the appropriate Section. 

  
Figure 176: Add Income Dialog 

3. Select the appropriate Source. 

4. Enter Other Description when Other is selected from the Source dropdown. 

5. Enter the Amount. 

6. Click Save & Close. 

Note: Click Save & New to add another income source. 

7. Repeat Steps 1 – 6 for co-borrower. 
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Edit Income 

Use the following steps to edit a listed income. 

1. Click the income to edit. (See Figure 175.) 

2. Update the Income Information on the Edit Income dialog. (See Add Income for 
details.)  

3. Click Save & Close. 

Delete Income 

Use the following steps to delete a listed income. 

1. Click the income to delete. (See Figure 175.)  

2. Click Delete on the Delete Confirmation. 

Assets 

Borrower/co-borrower assets are combined. 

Add Assets 

Use the following steps to add assets. 

1. Click the Assets Add button. 

 
Figure 177: Combined Borrower/Co-Borrower Assets 

2. Enter Company Name for the asset. 

  
Figure 178: Add Asset Dialog 
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3. Complete the remaining Add Asset dialog fields. 

4. Click the Add button to add a new account on the Add Account dialog. 

5. Select the Account Type from the dropdown. 

  
Figure 179: Add New Account Dialog 

6. Enter Other Description if applicable. 

7. Select Owner from the dropdown. 

8. Enter Account Number. 

9. Enter Cash/Market Value. 

10. Complete the remaining Add Account dialog fields as applicable. 

11. Click Save & Close on the Add New Account dialog to list the account on the Add 
Asset dialog. 

 
Figure 180: Added Asset Account 

Note: Click Save & New to add another new account. 

12. Click Save & Close on the Add Asset dialog. 

Note: Click Save & New to add another new account. 

Edit Assets 

Use the following steps to edit a listed asset. 
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1. Select the Asset to edit. (See Figure 177.) 

2. Update the Assets Information on the Edit Assets dialog. (See Add Assets for 
details.) 

3. Click Save & Close. 

Edit Asset Account 

Use the following steps to edit a listed asset account. 

1. Select the Asset with the account to edit. (See Figure 177.) 

2. Select the Account to edit. (See Figure 180.) 

3. Update the account information. (See Figure 178.) 

4. Click Save & Close on the Add New Account dialog. 

5. Click Save & Close on the Add Asset dialog. 

Delete Assets 

Use the following steps to delete a listed asset. 

1. Select the Delete icon next to the desired Asset. (See Figure 177.) 

2. Click Delete on the Delete Confirmation dialog. 

Delete Asset Account 

Use the following steps to delete a listed asset account. 

1. Select the asset with the account to delete. (See Figure 177.) 

2. Select the account to delete. (See Figure 180.) 

3. Click Delete on the Delete Confirmation dialog. 

4. Click Save & Close on the Edit Asset dialog. 

Gifts or Grants 

Enter all gifts or grants being applied to the loan. 

Add Gifts or Grants 

Use the following steps to complete the Gifts or Grants Received fields. 

1. Click the Gifts or Grants Received Add button. 

 
Figure 181: Gifts or Grants Received 
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2. Select the Type. 

 
Figure 182: Add Account 

3. Click Yes from the Deposited dropdown if the gift/grant is deposited. 

Note: Click No if the gift/grant is not deposited. 

4. Enter Account Number if deposited. 

5. Select Source of Funds. 

6. If Lender or Non-Originating Lender options are selected, add a Closing Cost and 
Down Payment. 

Note: Closing Cost plus the Down Payment must equal the Cash/Market Value amount. 

7. Enter Other Description when selecting Other from Source of Funds dropdown. 

8. Enter Cash/Market Value. 

9. Click Save & Close. 

Note: Click Save & New to add another account. 

Edit Gifts or Grants 

Use the following steps to edit a listed gift/grant. 

1. Select the gift/grant to edit. 

 
Figure 183: Gifts or Grants Received 

2. Update the Income Information on the Edit Account dialog. (See Add Gifts or 
Grants details.) 

3. Click Save & Close. 
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Delete Gifts or Grants 

Use the following steps to delete a listed gift/grant. 

1. Click the Delete icon. (See Figure 183.) 

2. Click Delete on the Delete Confirmation dialog. 

Liabilities 

Enter the borrower/co-borrower combined liabilities. Entered mortgage liabilities populate 
the Unmatched Mortgage Liabilities table. 

Add Liabilities 

Use the following steps to add liabilities. 

1. Click the Liabilities Add button. 

 
Figure 184: Liabilities List 

Note: Click an existing liability and use the Edit Liability dialog to update. 
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2. Enter the Company Name and the company’s Address information for the liability. 

  
Figure 185: Add Liability Dialog 

3. Select the Credit Account Type from the dropdown menu. 

4. Select the Liability Type from the dropdown. 

5. Enter Other Description when selecting Other from the Liability Type dropdown. 

6. Enter the liability Account Number. 

7. Enter (FHA) Original Debt Amount if appropriate. 

8. Enter (FHA) Automobile information if appropriate. 

9. Enter Current Balance and Payment details. 

10. Enter Remaining amount if applicable. 

11. Complete the Paid Off amount if applicable. 

12. Check the appropriate checkbox. 

13. Enter the Mortgage Type from the dropdown if applicable. 

14. Enter the Credit Limit amount if applicable. 

15. Check the appropriate checkbox if applicable. 

16. Click Save & Close. 

Note: Click Save & New to add another liability. 

Edit Liabilities 

Use the following steps to edit liabilities in one of the liability tables. 

1. Click the liability to edit. (See Figure 184.) 
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2. Update the information for the liability as applicable. (See Add Liabilities for details.) 

3. Click Save & Close. 

Note: The Real Estate table updates automatically when changes are made to a real estate 
owned liability. 

Delete Liabilities 

Use the following steps to delete liabilities in one of the liability tables. 

1. Click on the Delete icon to remove the liability. (See Figure 184.) 

2. Click Delete on the Delete Confirmation dialog. 

Alimony, Child Support, Other Expenses 

Enter alimony, child support, and other expenses for borrower/co-borrower. 

Add Expenses 

Use the following steps to Add Alimony, Child Support, and Other Expenses. 

1. Click the Add button. 

 
Figure 186: Alimony, Child Support, Other Expenses 

2. Select the expense Type. 

 
Figure 187: Add Expense Type 

3. Enter Other Description when Other is selected from the Type dropdown. 

4. Enter number of Payments Remaining. 

5. Enter Monthly Payment amount. 
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6. Select the Omit checkbox if applicable. 

7. Click Save & Close. 

Note: Click Save & New to add another expense. 

Edit Alimony, Child Support, and Other Expenses 

Use the following steps to Edit Alimony, Child Support, and Other Expenses. 

1. Select the desired expense to Edit. (See Figure 186.) 

2. In the Edit Expense dialog, update the desired information. 

3. Click Save & Close. 

Delete Alimony, Child Support, and Other Expenses 

Use the following steps to delete a listed expense. 

1. Click the Delete icon on the desired expense. (See Figure 186.) 

2. Click Delete on the Delete Confirmation dialog. 

Real Estate 

Use the following sections to complete the Real Estate section. 

Add Real Estate 

Use the following steps to add real estate. 

1. Click the Real Estate Add button. 

 
Figure 188: Existing Real Estate 
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2. Select the Subject Property checkbox if applicable. 

 
Figure 189: Add Real Estate Dialog 

3. Complete the Address fields. 

4. Enter the Number of Units. 

5. Enter the Acc. (Accessory) Dwelling Units if applicable. 

6. Select the Property Type. 

7. Select the appropriate Status from the dropdown. 

8. Select Intended Occupancy from the dropdown. 

9. Select the Current Occupancy from the dropdown. 

10. Enter the Market Value. 

11. Enter the Mortgage Balance if applicable. 

12. Enter the Gross Rent. 

13. Enter Monthly Payment if applicable. 

14. Enter Insurance/Tax/Miscellaneous expenses. 

15. Select the Omitted Ins/Tax/Misc to omit the expense from the loan application. 

16. Enter the Occupancy Rate percentage. 

17. Click Calculate icon to calculate the Net Rent. 

18. If needed, enter the Acc. (Accessory) Dwelling Net Rent. 

19. Click Save & Close. 

Note: Click Save & New to add another real estate property. 
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Edit Real Estate 

Use the following steps to edit Real Estate section. 

1. Click the Real Estate to edit. (See Figure 188.) 

2. Update the desired information on the Edit Real Estate dialog. (See Add Real Estate 
for details.)  

3. Click Save & Close. 

Delete Real Estate 

Use the following steps to delete a listed real estate item. 

1. Click the Delete icon. (See Figure 188.) 

2. Click Delete on the Delete Confirmation dialog. 

Unmatched Mortgage Liabilities 

Use the following steps to match the table items to the Real Estate table items. This table 
populates when a Liability is an unmatched mortgage. See Liabilities. 

1. Select the Unmatched Mortgage Liability. 

 
Figure 190: Unmatched Mortgage Liabilities 

2. Drag and drop the liability to the matching item on the Real Estate table item. 

Note: The selected item is removed from the Unmatched Mortgage Liabilities table. 
Matched liabilities can be updated on either the Real Estate table or the Liabilities table. 

Primary Housing 

Complete the Primary Housing section with current housing expenses. 

Add Primary Housing 

Use the following steps to add primary housing expenses. 
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1. Click the Primary Housing Add button. 

 
Figure 191: Primary Housing 

Note: Click an existing expense and use the Edit Primary Housing dialog to update. 

2. Select the expense Type. 

 
Figure 192: Add Primary Housing Dialog 

3. Enter Other Description when Other is selected from the Type dropdown. 

4. Enter expense Amount. 

5. Click Save & Close. 

Note: Click Save & New to add another expense. 

6. Repeat Steps 8 – 12 for co-borrower. 

Edit Primary Housing Expenses 

Use the following steps to edit a listed primary housing expense. 

1. Click the Expense to edit. (See Figure 191.) 

2. Update the Address Information on the Edit Address dialog. (See Add Primary 
Housing for details.) 

3. Click Save & Close. 

Delete Primary Housing Expenses 

1. Click the Delete icon. (See Figure 191.) 

2. Click Delete on the Delete Confirmation dialog. 
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Declarations 

Complete the Declarations for the borrower/co-borrower as appropriate. 

1. Select Yes or No appropriately for each borrower question. 

 
Figure 193: Borrower/Co-Borrower Declarations 

2. Enter a Description when selecting Yes. 

3. Click the Bankruptcy Select button when Yes is selected for the Bankruptcy 
question. 

 
Figure 194: Bankruptcy Details 

4. Select the appropriate Bankruptcy type. 

 
Figure 195: Bankruptcy Dialog 
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5. Click Save & Close. 

6. Select Yes or No appropriately for Military Service. 

 
Figure 196: Military Service 

7. Click Select when Yes is selected. 

8. Select the appropriate Military Service checkbox. 

 
Figure 197: Military Service Dialog 

9. Use the Calendar to select the Active Duty Service End Date when the checkbox 
is selected. 

10. Repeat Steps 1 – 9 for the co-borrower. 

Ethnicity and Gender 

Ethnicity and gender information is optional. Use the checkboxes when borrower/co-
borrower decline to provide the information. 

1. Select the Ethnicity Borrower does not wish to furnish this information checkbox 
when the borrower declines to provide information. 
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2. Select the Borrower Ethnicity Add button. 

 
Figure 198: Add/Edit Ethnicity 

Note: Click the displayed ethnicity and use the Edit Ethnicity dialog to update. 

3. Select the borrower’s Ethnicity from the dropdown. 

 
Figure 199: Add Ethnicity Dialog 

4. Select the Designation when appropriate. 

5. Enter Other Description when Other is selected from the Designation dropdown. 

6. Click Save & Close. 

Note: Click Save & New to add another ethnicity. 

7. Select the appropriate Gender Visual Observation option. 

8. Select the Gender Borrower does not wish to furnish this information checkbox 
when the borrower declines to provide information. 

9. Select the appropriate Sex option. 

10. Select the appropriate Visual Observation option. 

11. Select the appropriate Race Visual Observation option. 

12. Repeat Steps 1 – 11 for the co-borrower. 

Identifying Documentation 

Enter details for identifying documentation provided by the borrower/co-borrower. 
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1. Click the Borrower Identifying Documentation Add button. 

2. Select the documentation Type from the dropdown. 

 
Figure 200: Add Identifying Documentation Dialog 

3. Enter Other Description when Other is selected from the Type dropdown. 

4. Select the Governing Entity for the documentation from the dropdown. 

5. Enter Other Description when Other is selected from the Governing Entity 
dropdown. 

6. Enter the identification issuing Agency. 

7. Select the State/Province. 

8. Enter the identifying Document Number. 

9. Select the Country from which the document originated. 

10. Use the Calendar to select the Issued date. 

11. Enter the verifying party name in the By field. 

12. Use the Calendar to select the Expires date. 

13. Enter Discrepancy and Resolution details when the identification documentation 
contains discrepancies. 

14. Click Save & Close. 

Note: Click Save & New to add another identifying document. 

15. Repeat Steps 1 – 14 for the co-borrower. 
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Nearest Relative 

Nearest relative details are required for Federal Housing Administration (FHA) or Veteran 
Affairs (VA) loans. 

Note: (FHA/VA) Nearest Relative fields are required when FHA or VA is selected for Loan 
Type on the Loan screen. 

Add Nearest Relative 

1. Click the Add button. 

 
Figure 201: FHA/VA Nearest Relative 

2. Enter the Relationship status. 

 
Figure 202: Add (FHA) Nearest Relative 

3. Complete the Name and Address fields. 

Note: Enter the Postal Code to auto-populate the City and State fields. 

4. Enter the contact Phone Number. 

5. Click Save & Close. 

Note: Click Save & New to add another relative. 
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6. Click the States Add button. 

7. Select the appropriate State. 

8. Click Save & Close. 

Note: Click Save & New to add another state. 

9. Repeat Steps 1 – 8 for co-borrower. 

Edit Nearest Relative 

Use the following steps to edit a listed nearest relative. 

1. Click the Expense to edit. (See Figure 201.) 

2. Update the Address Information on the Edit Address dialog. (See Add Nearest 
Relative for details.)  

3. Click Save & Close. 

Delete Nearest Relative 

1. Click the Delete icon. (See Figure 201.) 

2. Click Delete on the Delete Confirmation dialog. 

Additional Information 

Complete the remaining information fields if applicable. 

1. Enter additional relevant Borrower Information. 

2. Enter additional relevant Co-Borrower Information. 

Application Loan 

The Application Loan screen contains options for capturing the loan details. 

Loan Overview 

Enter initial loan details or use Select to import a pre-defined template. 

Note: Use Loan Program in the Templates tab to create loan templates. See Loan Program 
for details. 

Options on the Application Loan screen vary depending on the initial loan details selected. 

1. Select Application tab. 

2. Select Loan. 
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3. Use the Calendar to select Application Date. 

 
Figure 203: Loan Overview 

4. Enter the ECOA (Equal Credit Opportunity Act) Application Date. 

5. Enter the Legal Entity ID. 

6. Click the Loan Program Scenario Select button. 

7. Enter the number of Total Borrowers. 

8. Enter Agency Case Number. 

Note: The Universal Loan Information field is ungrayed for users that are operating as a 
Broker. This field functions the same for HMDA reporting. 

 Loan Information 

Complete the Loan Information options as they pertain to the loan. 

1. Select the Loan Type. 

 
Figure 204: Loan Information 

2. Enter Other Description when selecting Other Loan Type. 

3. Select the Loan Purpose. 

4. Enter Other Description when selecting Other Loan Purpose. 
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5. Select the Construction Type option if applicable. 

6. Select the Cash-Out Type when Refinance is selected for Loan Purpose. 

7. Select the Occupancy. 

8. Select the FHA Secondary Residents checkbox if applicable. 

9. Select the Lien Position. 

10. Select the Simultaneous Financing checkbox if applicable. 

Note: Checkbox is not available for First Lien Position. 

11. Select the Amortization Type. 

Note: Enter the Other Amortization Description if applicable. 

12. Select the appropriate Loan Information checkboxes. 

Note Details 

Use the following steps to complete the Note Details section. 

1. Enter Estimated Appraised Value amount. 

 
Figure 205: Note Details 

2. Enter Initial Requested Loan amount. 

3. Enter the Note Rate percentage. 

4. Enter the Qual Rate percentage if different than Note Rate. 

5. Enter the Amortization Term. 

6. Enter Loan Term if different than Amortization Term. 

7. Enter Appraised Value amount. 

8. Enter Sales Price amount. 

9. Enter Base Loan Amount. 

10. Enter Down Payment Amount. 

Note: Click %Cal to calculate a percentage down payment. 
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Rental Income on Subject Property 

Complete the Rental Income on Subject Property if the property is a rental. 

1. Enter Gross Rent amount. 

 
Figure 206: Rental Income 

2. Enter Occupancy Rate percentage. 

3. Click Calculate to calculate Net Rent amount. 

Note: The Ratios fields auto populate. 

4. If needed, enter the Acc. (Accessory) Dwelling Net Rent. 

5. Click on the Save button at the top of the screen. 

If Construction Loan 

The If Construction Loan fields are required if a Construction option is selected from the 
Construction Type dropdown. 

1. Enter the property Original Cost. 

 
Figure 207: If Construction Loan 

2. Enter the Lot Value. 

3. Enter the Improvements estimate. 

Note: Lot Value + Improvements = Total. 

4. Select the Include MI During Construction Period checkbox if applicable. 

5. Select the Include Escrow During Construction Period checkbox if applicable. 

6. Enter the construction loan Period. 

7. Enter the loan Interest Rate percentage. 

8. Enter Required Reserve if applicable. 

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
137 

9. Select the Closing Type from the dropdown. 

PMI/MIP/VA/USDA 

Complete the PMI/MIP/VA/USDA details for the loan when the following details are 
required: 

• Private Mortgage Insurance (PMI) 
• Mortgage Insurance Premium (MIP) 
• Veterans Affairs (VA) 
• United States Department of Agriculture (USDA) 

1. Enter the PMI/MIP/VA/USDA Up-Front percentage requirements. 

 
Figure 208: PMI/MIP/VA/USDA Section 

2. Enter Additional Amount Paid in Cash. 

3. Select the Exempt from VA Funding Fee checkbox if needed. 

The VA Funding Fee is a mandatory, one-time fee for VA-backed loans. 

4. Enter the Monthly Percentage rates. 

5. Enter the Monthly Dollar Amount. 

6. Enter the Months for the loan term. 

7. Select the appropriate Calculation Based on option. 

8. Enter the Cancel at percentage. 

9. Select the Calculate based on the remaining balance checkbox if applicable. 

10. Select the Midpoint Payment cancellation checkbox if applicable. 

Rate Adjustment 

Complete the Rate Adjustment fields when the Amortization Type is ARM. 
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1. Enter the 1st Change Adjustable Cap percentage. 

 
Figure 209: Rate Adjustment 

2. Enter the 1st Change Months at which the percentage changes. 

3. Enter the Adjustment Period percentage. 

4. Enter the Adjustment Period months. 

5. Complete the remaining percentages. 

6. Select the appropriate Index Type from the dropdown. 

7. Complete the Other Description when selecting Other for the Index Type. 

8. Enter the Rate Percentage Rounding Options if appropriate. 

9. Select the appropriate Rate Round To option. 

Payment Adjustment 

Enter payment adjustment information for loans. 

1. Enter Interest-Only Months. 

 
Figure 210: Payment Adjustments 

2. Select the Calculate Qual Ratios at the Interest-Only Payment checkbox if 
applicable. 
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3. Select the appropriate Initial Payment Rate option. 

4. Enter the Initial Payment Rate percentage. 

5. Enter the Adj Cap percentage. 

6. Enter the Adj Period months. 

7. Enter the Recast Pd/Stop values. 

8. Enter the Max Balance percentage. 

9. Select the Calculate Qual Ratios at the Max Adjustment Loan Balance checkbox 
if applicable. 

10. Enter extra payment amount. 

11. Enter payment frequency. 

12. Select the Bi-Weekly Payment Schedule checkbox if applicable. 

13. Select the Simple Interest checkbox if applicable. 

14. Select the Down Payment Assistance Program checkbox if applicable. 

15. Enter the Principal Forgive amount and complete the months field. 

16. Enter the Graduated Payment Mortgage details. 

17. Enter the appropriate Payment Rounding %. 

18. Select the appropriate Payment Rounding option. 

Buydown Mortgage 

Complete the Buydown Mortgage dialog when the Buydown Mortgage option is available. 

1. Select the Type of Buydown (ex. 3-2-1, 2-1, etc.). 

2. Use the Paid By dropdown menu to select the party responsible for the Buydown. 

3. Select the desired option from the Disclose LE/CD Product. 

4. Click on the Source of Funds dropdown menu and select where the funds are 
transferred from. 

5. If needed, select the Temporary Subsidy checkbox. 

6. Click Add. 

 
Figure 211: Buydown Mortgage 
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7. Enter the buydown mortgage Rate percentage. 

 
Figure 212: Add Buydown Mortgage Dialog 

8. Enter the Term in months. 

9. Click Save & Close. 

Note: Click Save & New to add another buydown mortgage option. 

Loan Features 

A balloon payment is required when the Loan Term is lower than Amortization Term. 

1. Click Add. 

 
Figure 213: Loan Features 

2. Select the appropriate Loan Feature. 

3. Complete Other Description field when selecting Other from the Loan Feature 
dropdown. 

 
Figure 214: Add Loan Features Dialog 

4. Click Save & Close. 

Note: Click Save & New to add another loan feature. 

Payment Schedule 

The Payment Schedule is automatically calculated. 
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1. Click Payment Schedule. 

 ` 

Figure 215: View Payment Schedule 

2. Review Payment Schedule. 

 
Figure 216: Payment Schedule 

Subject Property 

Use the following sections to complete subject property details. Complete the Subject 
Property screen fields not auto populated from previous screens. 

1. Select Application tab. 

2. Select Subject Property. 
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Subject Property Address 

1. Verify the auto populated fields. 

 
Figure 217: Subject Property Details 

2. Enter the County if applicable. 

3. If needed, enter a Legal Description. 

4. Enter the following codes: 

• State Code 
• County Code 
• MSA/MD Code 

5. If applicable, enter the Census Tact. 

Property Information 

1. Enter the Number of Units and the Year Built. 

 
Figure 218: Property Information 

2. If needed, enter the Acc. (Accessory) Dwelling Units. 
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3. For classic loan applications, enter Year Acquired if refinancing. 

4. Enter Lot Acquired Date if applicable. 

5. Click on the Mixed-Use Property dropdown and select the appropriate option. 

6. Click on the Property in Project dropdown and select the appropriate option. 

7. Click on the Community Property State dropdown and select the appropriate 
option. 

8. Select the Planned Unit Development checkbox if needed. 

9. Select the Attachment Type from the dropdown. 

10. Select Structure Type from the dropdown menu. 

11. Select Construction Method if applicable. 

12. Complete Other Description field when selecting Other from Construction 
Method option. 

13. Select the Manufactured Home Width option. 

14. Select Design Type option. 

15. Complete Other Description field when selecting Other from the Design Type 
option. 

Proposed Housing Expenses 

Enter the borrower/co-borrower disclosed housing expenses. 

1. Click Add in Proposed Housing Expenses section. 

 
Figure 219:Proposed Housing Expenses 
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2. Select Housing Expense Type option. 

 
Figure 220: Add Proposed Housing Expenses Dialog 

Note: Enter Other Description when selecting Other for Housing Expense Type. 

3. Select appropriate Based On option. 

4. Enter Fee Percentage. 

5. Enter Monthly Dollar Amount. 

6. Enter Monthly Amount if applicable. 

7. Click Save & Close. 

Note: Click Save & New to add other expenses. 

Subordinate Financing 

Enter subordinate financing when the borrower/co-borrower is receiving subordinate 
financing. 

1. Click Subordinate Financing Add button. 

 
Figure 221: Subordinate Financing 
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2. Enter the desired information in the Add Subordinate Financing dialog. 

 
Figure 222: Add Subordinate Financing 

Title 

Enter the information to include in the new title. 

1. Select the appropriate Title will be held as option. 

 
Figure 223: Property Title Details 

2. Select the Other Description if applicable. 

3. Select the appropriate Estate will be held in option. 

4. Use the Calendar to select the title Expiration Date. 

5. Select the appropriate Trust Information option. 

6. Select the appropriate Indian Country Land Tenure option. 

7. Select the appropriate (VA) Type of Ownership option. 
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If Refinancing Loan 

Select the appropriate option if the loan is being refinanced. Some fields may auto populate. 

 
Figure 224: If Refinancing Loan 

Names on Title 

Use the following sections to add the names on the title. 

Copy Borrower 

Use the following to add borrower name to the title. 

Note: Copy borrower overwrites existing names. 

1. Click Copy Borrower. 

 
Figure 225: Names on Title 

2. Click Delete on the Delete Confirmation dialog. 

Add Name 

1. Click the Add button. (See Figure 225.) 

 
Figure 226: Add Names on Title Dialog 
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2. Complete the Add Names on Title dialog. 

3. Click Save & Close. 

Note: Click Save & New to add another name to the title. 

Edit Name 

Use the following steps to edit a name. 

1. Click the name to edit. (See Figure 225.) 

2. Update the Edit Names on Title dialog as applicable. (See Add Name for details.) 

3. Click Save & Close. 

Delete Name 

Use the following steps to delete a name. 

1. Click the name to Delete icon. (See Figure 225.) 

2. Click Delete on the Delete Confirmation dialog. 

Energy Improvements 

Select the appropriate energy improvements. 

1. Click Select. 

 
Figure 227: Energy Improvements 

2. Select the appropriate checkbox. 

 
Figure 228: Energy Improvements Dialog 

3. Click Save & Close. 

Note: Checking Mortgage Loan will finance energy-related improvements requires an 
amount. 
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4. Select the Loan Position option. 

 
Figure 229: Add Subordinate Financing Dialog 

5. Enter Creditor Name. 

6. Enter Source/EIN. 

7. Select Source Type option. 

Note: Enter Other Description when selecting Other for Source Type. 

8. Enter Loan Amount. 

9. Enter Note Rate percentage. 

10. Enter Qual Rate percentage. 

11. Enter Amortization Term Months. 

12. Enter Loan Term Months. 

13. Enter Interest Only Months. 

14. Enter Monthly Payment. 

15. Enter Credit Limit. 

16. Select the Quality Ratios checkbox if appropriate. 

17. Click Save & Close. 

Note: Use Save & New to add other subordinate financing. 
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Initial Fees Worksheet 

Complete the Initial Fees Worksheet fields not auto populated from previous screens.  

1. Select Application tab. 

2. Select Initial Fees Worksheet. 

3. Use the Calendar to select the Estimated Close Date. 

4. Use the Calendar to select the First Payment Date. 

 
Figure 230: Initial Fees Worksheet 

Fees Template 

. Use the Fees Template to populate the Initial Fees Worksheet screen or enter the values 
when not provided on the Fees Template. To import a Fees Template: 

1. Click the Select button near the Fees Template field to browse templates. 

 
Figure 231: Select Template Dialog 
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2. Select the Template Name. 

Note: Use Search to browse stored templates. 

3. Click OK to import the Template Fees. 

Origination Charges 

Use the fees template created on the TEMPLATE tab to populate the Fee fields in the 
worksheet when a template was created. 

Add Origination Charges 

Use the following steps to add additional Origination Charges to the imported template or 
to manually build fees. 

Note: See Dropdown Lists to build the Fees Template. 

1. Click Origination Charges Add button. 

 
Figure 232: Origination Charges 

2. Select the Fee Name to add a new fee type option. 

 
Figure 233: Edit Origination Charges Dialog 

3. Enter Other Description if selecting Other Fee Name. 
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4. Select the Paid To option. 

5. Select the Based On option. 

6. Enter Company Name. 

7. Select Responsible Party option. 

Note: Select Blank and enter the fee distribution on the Fees Distribution table. 

8. Select the Qualified Mortgage checkbox if applicable. 

9. Select the Exclude from Tolerance checkbox if applicable. 

10. Complete the Fees Distribution table to distribute fees as applicable if Blank is 
selected for Responsible Party. 

11. Click Save & Close. 

Note: Use Save & New to add other origination fees. 

12. Select the Print additional fees on addendum checkbox if applicable. 

Edit Origination Charges 

Use the following steps to complete the Edit Origination charges. 

1. Select the charge to edit. (See Figure 232.) 

2. Update the Address Information on the Edit Address dialog. (See Add Origination 
Charges for details.) 

3. Click Save & Close. 

Delete Origination Charges 

Use the following steps to delete a listed real estate item. 

1. Click the Delete icon. (See Figure 232.) 

2. Click Delete on the Delete Confirmation dialog. 

Services Borrower Can’t Shop For 

The Origination Charges Services Borrower Can’t Shop For list contains the loan 
origination agents and services that are pre-selected and cannot be changed. 

Add Services 

Use the following steps to create the list. 

1. Click the Service Providers Borrower Can’t Shop for Add button. 

 
Figure 234: Non Shopped Services 
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2. Complete the Add Services Borrower Can’t Shop for dialog fields. (See Add 
Origination Charges for details.) 

3. Click Save & Close. 

Note: Use Save & New to add other origination fees. 

4. Select the Print additional fees on addendum checkbox if applicable. 

See Edit Origination Charges for editing services. 

See Delete Origination Charges for deleting services. 

Services Borrower Can Shop For 

The Origination Charges Services Borrower Can Shop For list contains the loan origination 
services that have multiple providers from which the borrower can select. Use the following 
steps to create the list. 

1. Use the steps in Services Borrower Can’t Shop For to build the Services Borrower 
Can Shop For list. 

2. Select the Print Confirm Receipt checkbox to request a Confirmation Receipt 
when the Borrower receives the list. 

See Edit Origination Charges for editing services. 

See Delete Origination Charges for deleting services. 

Total Loan Costs 

Total Loan Costs fields populate from: 

• Origination Charges 
• Services Borrower Can’t Shop For 
• Services Borrower Can Shop For 

Additional Fee Tables 

Use the steps provided in Add Origination Charges for assistance with completing 
appropriate the sections under Total Loan Costs. Sections include: 

• Taxes and Other Government Fees 
• Prepaids 
• Initial Escrow payment at Closing 
• Other 

Total Other Costs 

Total Other Costs fields populate from the Additional Fee Tables. 
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Total Closing Costs 

The Total Closing Costs table populates based upon the Fees selected while completing the 
above Fees tables. Use the following steps to add Lender Credits. 

1. Click Lender Credit. 

 
Figure 235: Total Closing Costs 

2. Update the fields as required. 

 
Figure 236: Update Closing Cost Total Dialog 

3. Click Save & Close. 

Closing Costs Service Providers Borrower Can’t Shop For 

The Closing Costs Service Providers Borrower Can’t Shop For list contains the closing 
costs agents and services that are pre-selected and cannot be changed. Use the following 
steps to create the list. See Services Borrower Can’t Shop For details about building the list. 

 
Figure 237: Closing Cost Services 

Note: See Edit Origination Charges for details on editing a listed fee. 
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Closing Costs Service Providers Borrower Can Shop For 

The Closing Costs Services Providers Borrower Can Shop For list contains the closing 
costs services that have multiple providers from which the Borrower can select. Use the 
following steps to create the list. See Services Borrower Can Shop For details about building 
the list. (See Figure 237.) 

Note: See Edit Origination Charges for details on editing a listed fee. 

Select the Print Confirmation Receipt checkbox to request confirmation when Borrower 
receives the information. 

Change of Circumstance 

Complete the Change of Circumstance fields when the Borrower experiences a change of 
circumstance the impacts the loan process. 

1. Click the Change of Circumstance Add button. See Figure 237. 

2. Select the Changed Date. 

 
Figure 238: Add Changed Date Dialog 

3. Enter the Disclose By Date. 

4. Enter the Re-Disclosed Date if applicable. 

5. Enter the Received Date. 

6. Select the Delivery Method. 

7. Select the Reason. 

8. Enter the Other Description when selecting Other Reason. 

9. Enter Change Details. 

10. Click Add. 

11. Select the associated loan section from the Select Section dropdown. 
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12. Select the Fee Name. 

13. Enter the Previous Fee Amount. 

14. Enter the New Fee Amount. 

15. Click Save & Close. 

Note: Click Save & New to add another associated fee. 

16. Click Save & Close on the Add Change of Circumstance dialog. 

Note: Click Save & New to add another change of circumstance. 

Estimated Cash-to-Close 

The Loan Estimate/Closing Disclosure Form dropdown allows the user to select the 
Standard or an Alternate form to allow selecting the printed form. The fields depend on the 
selected form. 

Standard Form 

Use the following steps to select the Standard print form output and the loan application 
type. 

1. Select Application tab. 

 
Figure 239: Standard Estimate/Closing Disclosure 

2. Select Estimated Cash-to-Close. 

3. Select the Standard Loan Estimate/Closing Disclosure Form from the dropdown. 

Add Due from Borrower 

Use the following steps to add due from borrower fees. 
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1. Click the Due from Borrower Add button to add additional fees. (See Figure 239.) 

2. Select the appropriate Section from the dropdown. 

 
Figure 240: Add Due from Borrower Dialog 

3. Select the appropriate Fee Name dropdown. 

Note: Enter a description when selecting Other from Fee Name. The selected Fee Name 
populates the liability fields as required. 

4. Select the appropriate Based On option. 

5. Enter the Percentage or Dollar Amount as appropriate. 

6. Complete the To field. 

Note: The To field is not required when the Adjustments for Items Paid by seller in Advance is 
selected. 

7. Select Yes from the Paid Outside Closing dropdown if applicable. 

8. Enter the From and To Dates if applicable. 

9. Click Save & Close. 

Note: Select Save & New to add another fee. 

Edit Due from Borrower 

Use the following steps to edit a listed due from borrower fee. 

1. Click the fee to update. (See Figure 239.) 

2. Complete the changes in the Edit Due from Borrower dialog. (See Add Due from 
Borrower for details.) 

3. Click Save & Close. 
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Add Due To Seller 

Use the following steps to complete the Due To Seller section. 

1. Click the Due To Seller Add button. 

 
Figure 241: Due To Seller 

2. Select the Fee Name. 

 
Figure 242: Add Due To Seller 

3. Select Other Description when selecting Other for the Fee Name. See Add Due To 
Seller for details. 

4. Enter the Percentage. 

5. Enter the Dollar Amount. 

6. Complete the remaining fields if available. 

7. Click Save & Close. 

Note: Click Save & New to add another fee due to seller. 

Edit Due To Seller 

Use the following steps to edit a listed due to seller fee. 

1. Select the Fee to edit. (See Figure 241.) 

2. Update the fee to edit on the Edit Due To Seller dialog. (See Add Due To Seller for 
details.) 
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Delete Due to Seller 

Use the following steps to delete due to seller fee. 

1. Click the Delete icon. (See Figure 248.) 

2. Click Delete on the Delete Confirmation screen. 

Add Paid For/By Borrower 

Use the following steps to complete the Paid For/By Borrower section. 

1. Click the Paid For/By Borrower Add button. 

  
Figure 243: Paid For/By Borrower 

2. Select the appropriate Section from the dropdown. 

 
Figure 244: Add Paid For/By Borrower 

3. Select the appropriate Fee Name from the dropdown. 

Note: Enter a description when selecting Other from Fee Name. The selected Fee Name 
populates the liability fields as required. 

4. Select the appropriate Based On option. 

5. Enter the Percentage or Dollar Amount as appropriate. 

6. Complete the To field. 

Note: The To field is not required when the Adjustments for Items Paid by seller in Advance is 
selected. 
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7. Select Yes from the Paid Outside Closing dropdown if applicable. 

8. Enter the From and To Dates if applicable. 

9. Click Save & Close. 

Note: Select Save & New to add another fee. 

Edit Paid For/By Borrower 

Use the following steps to edit a listed Paid For/By Borrower fee. 

1. Click the fee to update. (See Figure 243.) 

2. Complete the changes in the Edit Paid For/By Borrower dialog. (See Add Paid 
For/By Borrower for details.) 

3. Click Save & Close. 

Add Due From Seller 

Use the following steps to complete the Due To Seller section. 

1. Click the Due To Seller Add button. (See Figure 239.) 

2. Select the appropriate Section from the dropdown. 

 
Figure 245: Add Due From Seller Dialog 

3. Select the appropriate Fee Name from the dropdown. 

Note: Enter a description when selecting Other from Fee Name. The selected Fee Name 
populates the liability fields as required. 

4. Select the appropriate Based On option. 

5. Enter the Percentage or Dollar Amount as appropriate. 
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6. Complete the To field. 

Note: The To field is not required when the Adjustments for Items Paid by seller in Advance is 
selected. 

7. Select Yes from the Paid Outside Closing dropdown if applicable. 

8. Enter the From and To Dates if applicable. 

9. Click Save & Close. 

Note: Select Save & New to add another fee. 

Edit Due From Seller 

Use the following steps to edit a listed Due from Seller fee. 

1. Click the fee to update. (See Figure 239.) 

2. Complete the changes in the Edit Due from Seller dialog. (See Add Due From Seller 
for details.) 

3. Click Save & Close. 

Delete Due From Seller 

Use the following steps to delete a listed due from seller fee. 

1. Click the Delete icon. (See Figure 248.) 

2. Click Delete on the Delete Confirmation screen. 

Add Source of Down Payment 

Use the following steps to update the Source of Down Payment section when required. 

1. Click the Source of Down Payment Add button. 

 
Figure 246: Source of Down Payment 
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2. Select Funds Type. 

 
Figure 247: Add Down Payment Source 

3. Enter Other Description when selecting Other Funds Type. 

4. Select Funds Source Type. 

5. Enter Other Description when selecting Funds Source Type. 

6. Enter Amount. 

7. Click Save & Close. 

Note: Select Save & New to add another down payment source. 

Edit Source of Down Payment 

Use the following steps to Edit Source of Down Payment. 

1. Click the Funds Type to edit. (See Figure 246.) 

2. Update the Edit Down Payment Source dialog. (See Add Source of Down Payment 
for details.) 

3. Click Save & Close. 

Delete Source of Down Payment 

Use the following steps to Delete Source of Down Payment. 

1. Click the Delete Icon. (See Figure 246.) 

2. Click Delete on the Delete Confirmation dialog. 

Add Cash From Borrower 

Use the following steps to complete the Details of Transaction (1003) section. 
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1. Click the Cash From Borrower Add button. 

 
Figure 248: Details of Transaction 

2. Select the Cash From Borrower Type option. 

 
Figure 249: Cash From Borrower Dialog 

3. Enter the Amount. 

4. Click Save & Close. 

Note: Select Save & New to add another down payment source. 

Edit Cash From Borrower 

Use the following steps to edit cash from borrower. 

1. Select the Fee to edit. (See Figure 248.) 

2. Update the Edit Cash From Borrower dialog. (See Add Cash To Borrower for details.) 

3. Click Save & Close. 

Delete Cash From Borrower 

Use the following steps to delete cash from borrower. 

1. Click the Delete icon. (See Figure 248.) 

2. Click the Delete on the Delete Confirmation dialog. 
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Add Cash To Borrower 

1. Click the Cash to Borrower Add button. (See Figure 248.) 

2. Select the Cash To Borrower Type from the dropdown. 

 
Figure 250: Add Cash To Borrower Dialog 

3. Enter Other Description when selecting Other Cash To Borrower Type. 

4. Enter the Amount. 

5. Click Save & Close. 

Note: Select Save & New to add another down payment source. 

Edit Cash To Borrower 

Use the following steps to edit cash to borrower. 

1. Select the Fee to edit. (See Figure 248.) 

2. Complete the changes in the Edit Cash To Borrower dialog. (See Add Cash To 
Borrower for details.) 

3. Click Save & Close. 

Delete Cash To Borrower 

Use the following steps to delete cash to borrower entries. 

1. Click the Delete icon. (See Figure 248.) 

2. Click Delete on the Delete Confirmation dialog. 

Alternative Form 

Use the following steps when completing the alternative Cash-to-Close form fields. 

Note: The Alternative form is typically used for refinanced loans. 
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1. Select Alternative from the Loan Estimate/Closing Disclosure Form dropdown. 

 
Figure 251: Alternate Estimate/Closing Disclosure 

2. Click the Payoffs and Payment Add button. 

3. Complete the Add Payoffs and Payment fields. 

 
Figure 252: Add Payoffs and Payments Dialog 

4. Click Save & Close. 

Note: Select Save & New to add another down payment source. 

5. Complete the Source of Down Payment. (See Add Source of Down Payment for 
details.) 

6. Complete the Cash From Borrower fields. (See Add Cash From Borrower.) 

7. Complete the Add Cash To Borrower fields. (See Add Cash To Borrower.) 
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Loan Estimate 

The Loan Estimate screen discloses the TRID 2.0 compliance requirements for the following 
loan types: 

• Purchase 

• Refinance 

• Construction 

Some screen fields are populated from the Loan screen and Initial Fees Worksheet. Use the 
following sections to complete the fields that are not populated. 

Note: Make changes to populated fields on the Loan screen and Initial Fees Worksheet. 

Initial Fields 

Use the following steps to complete the Loan Estimate. The initial fields are not auto 
populated. 

1. Select the Application tab. 

2. Select Loan Estimate. 

 
Figure 253: Loan Estimate Tab 

3. Select Yes from the Rate Lock dropdown to lock the interest rate. 

4. Use the Calendar to select the Rate Lock Expiration Date if applicable. 

5. Use the Clock and Time Zone dropdown to set the Rate Lock time. 

6. Use the Calendar to select the Estimate Available Through date. 

7. Use the Clock and Time Zone dropdown to set the Estimate Available Through 
time. 
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8. Use the Calendar to select the Intent to Proceed date after receiving notification 
from the borrower to move forward with the loan. 

9. Use the Clock and Time Zone dropdown to set the Intent to Proceed time. 

10. Select Yes from the Optional Payment dropdown if borrower elects to make 
optional payments. 

11. Enter the Months value if selecting Yes. 

12. Select the Prepayment Penalty checkbox if applicable. 

13. Complete the Prepayment Penalty fields if applicable. 

Remaining Fields 

Complete the remaining fields that are not populated from the Loan Screen and Initial Fees 
Worksheet. 

1. Select the appropriate Assumptions radio button. 

 
Figure 254: Remaining Loan Estimate Fields 

2. Set the Late Payments Days Late value. 

3. Enter the Late Fee Charge or Percentage. 

4. Select the Percentage Description from the dropdown if applicable. 

5. Enter Other Description if selecting Other from the Percentage Description 
dropdown. 

6. Select the appropriate Servicing option. 
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7. Select the Print Confirmation Receipt checkbox to print the confirmation page. 

8. Select the Print Additional Signature Page checkbox for co-borrower if applicable. 

9. Complete the Higher-Priced Mortgage Loan fields if applicable. 

10. Click Save. 

Fannie Mae Addendum 

Fannie Mae requires specific addendums for financing mortgages. 

Property 

Complete the Fannie Mae Property Addendum information not auto populated from other 
screens. 

1. Select Application tab. 

 
Figure 255: Fannie Mae Property Details 

2. Select Fannie Mae Addendum. 

3. Verify the Subject Property Type from the dropdown. 

4. Select the Project Classification from the dropdown. 

5. Enter the CPM Project ID. 

6. Enter the Appraisal ID. 

7. Enter Property Data ID. 

8. Enter the Sales Contract Amount. 

9. Select the Did seller provide below market financing? checkbox if applicable. 

Loan Application Information 

The Loan Application Information Addendum information includes loan application details 
required by Fannie Mae. 
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1. Verify the Product Code is correct. 

 
Figure 256: Loan Application Information 

2. Select the Product Description option. 

3. Select the Product Plan Number option. 

4. Select the Lender is funding buydown checkbox if applicable. 

5. Select the ARM Index Type option. 

6. Select the Refinance Type option. 

7. Enter Other Description if applicable. 

8. Enter the Total Financed Properties. 

9. Select the Escrow Waived checkbox if appropriate. 

Community Lending 

The Community Lending Addendum information includes community details in which the 
property resides. 

1. Select the Enable Community Lending Yes option to access the remaining 
Community Lending fields if applicable. 

 
Figure 257: Community Lending 

Note: Proceed to FHA when selecting No. 

2. Select the appropriate Fannie Neighbor Eligibility option. 

3. Select the appropriate Community Seconds option. 

4. Select the appropriate Repayment Structure option if Yes is selected for 
Community Seconds. 

5. Enter Metro Statistical Area or County if applicable. 
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6. Select the appropriate Product. 

7. Enter Housing and Urban Development (HUD) Area Median Income if applicable. 

8. Enter Income Limit Adjustment percentage if applicable. 

9. Enter Income Limit amount if applicable. 

FHA 

The FHA Addendum information includes information required for FHA loans through Fannie 
Mae. 

1. Select the Section of the Act to which the loan pertains to. 

 
Figure 258: FHA Fields 

2. Enter Mortgage Credit Certificate amount. 

3. Enter Mortgage Insurance Premium (MIP) Refund Amount. 

4. Enter Mortgage Credit Certificate amount. 

5. Enter Sellers Concessions amount. 

VA 

The VA Addendum information includes information required for VA loans through Fannie 
Mae. 

1. Enter Monthly Maintenance amount. 

 
Figure 259: VA Fields 

2. Enter Entitlement Amount. 

3. Enter Monthly Utilities amount. 

4. Select Married to Borrower option. 

Validation Service Providers 

Use the following sections for validation service providers. 
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Add Provider 

Use the following to add a service provider. 

1. Click the Borrower Validation Service Providers Add button. 

 
Figure 260: Borrower/Co-Borrower Fields 

2. Select the Verification Type option. 

 
Figure 261: Add Validation Service Providers 

3. Select the Service Provider option. 

4. Enter Reference Number. 

5. Enter Reissue Number. 

6. If Income Calculator is selected for Verification Type and Service Provider, select 
the applicable Source. 

7. Click Save & Close. 

Note: Click Save & New to add another validation service provider. 

8. Repeat Steps 1 – 7 to add Co-Borrower Validation Service Providers. 

Edit Provider 

Use the following steps to edit provider. 

1. Select the Service Provider to edit. (See Figure 260.) 

2. Update the Edit Validation Service Providers dialog. (See Add Provider for details.) 

3. Click Save & Close. 
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Delete Provider 

Use the following steps to delete cash to borrower. 

1. Click the Delete icon. (See Figure 260.) 

2. Click the Delete on the Delete Confirmation dialog.  

Total Taxes and Deductions 

Use the following sections for validation service providers. 

Note: Use the VA Loan Type to enable this section. See Loan Information. 

Add Deductions 

1. Click the Total Taxes and Deductions Add button. 

 
Figure 262: Total Taxes and Deductions 

2. Select the Deductions Type option. 

 
Figure 263: Add Total Taxes and Deductions 

3. Select the Amount. 

4. Click Save & Close. 

Note: Click Save & New to add more taxes and deductions. 

5. Repeat Steps 1 – 4 for Co-Borrower Total Taxes and Deductions. 

Edit Deductions 

Use the following steps to edit deductions. 

1. Select the Taxes and Deductions to edit. (See Figure 262.) 

2. Update the Edit Total Taxes and Deductions dialog. (See Add Deductions for 
details.) 

3. Click Save & Close. 
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Delete Deductions 

Use the following steps to delete deductions. 

1. Click the Delete icon. (See Figure 262.) 

2. Click the Delete on the Delete Confirmation dialog. 

Desktop Underwriting Exceptions 

Use this section to add exceptions for Desktop Originator (DO). This section allows the user 
to add certain exceptions for a loan. 

 
Figure 264: Desktop Underwriting Exceptions 

To add exceptions: 

1. Click the Applications tab for a loan file. 

2. Click Fannie Mae Addendum. 

3. Scroll down to end of the screen. 

4. Click the Select button for Desktop Underwriter Exceptions. See Figure 264. 

5. Choose the desired exception(s). 

 
Figure 265: Select Exceptions 

6. Click Save & Close. 
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Freddie Mac Addendum 

Freddie Mac requires specific addendums for financing mortgages. 

1. Enter the Lender Registration Number if applicable. 

 
Figure 266: Freddie Mac Addendum 

2. Enter the Lender Branch Number if applicable. 

3. Enter the Agency Case Number if applicable. 

4. Select the appropriate Submitting Role option from the dropdown menu. 

5. Select the Interviewer Signed Date. 

6. Select the Save button at the top of the screen. 

Loan Program 

Choose the desired Loan Program if applicable for Freddie Mac. 

1. Click the Add button. 

 
Figure 267: Loan Program (Freddie Mac) 
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2. Select the desired option from the Loan Program dropdown menu. 

 
Figure 268: Add Loan Program 

3. Select Save & Close or Save & New to add another Loan Program. 

4. Select the Save button at the top of the screen. 

FHA/VA 

1. Enter Discount Points Financed if applicable. 

 
Figure 269: FHA/VA 

2. Enter VA Residual Income if applicable. 

3. Enter Borrower Paid Closing Costs if applicable. 

4. Select the Save button at the top of the screen. 

Property 

1. Select Yes or No whether the property is a Manufactured Home. 
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Figure 270: Property (Freddie Mac) 

2. If needed, enter months of Deed Restriction. 

3. If Construction was selected for Construction Type (Application > Loan > Loan 
Information), select the Construction Status. 

4. Enter Appraisal ID if applicable. 

5. Enter the Property Data ID if applicable. 

6. Enter the Project ID if applicable. 

7. Select the Save button at the top of the screen. 

Transaction Detail 

1. Enter Sales Concessions if applicable. 

 
Figure 271: Transaction Detail 

2. Enter a Cash-Out if applicable. 

3. Select the ARM Index Type dropdown, choose the desired option. 

4. If the Other option was selected for the ARM Index Type, enter an Other Description. 

5. Select the Save button at the top of the screen. 
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Validation Service Providers 

Add Validation Service Providers for the Borrower/Co-Borrowers. 

1. Click on the Add button. 

 
Figure 272: Validation Service Providers 

  

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
177 

2. Select the desired option for the Verification Type dropdown menu. 

 
Figure 273: Add Validation Service Providers 

3. Select the desired option for the Service Provider dropdown menu. 

4. Enter the Reference Number. 

5. Enter Reissue Number. 

6. Select Save & Close or Save & New to another Validation Service Provider. 

Negative Amortization 

These radio buttons are read only and will be automatically selected based on loan 
information that was entered on the loan file. 

 
Figure 274:Negative Amortization 

Anti-Steering Disclosure 

Loan originators are required to present an Anti-Steering Disclosure to borrowers to comply 
with the Federal Truth-In-Lending Act (TILA) and Regulation Z (Reg Z). The disclosure 
includes the options available for each loan type in which the borrower has expressed an 
interest. 
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1. Select Application tab. 

 
Figure 275: Anti-Steering 

2. Select Anti-Steering. 

3. Check the certification checkbox if applicable. 

4. Select the Type of Transaction from the dropdown. 

5. Enter the Lowest Interest Rate percentage available. 

6. Enter the Lowest Interest Rate without Risky Features percentage available. 

7. Enter the Lowest Origination Costs percentage available. 

8. Enter Adjusted Origination Charges for each field as applicable. 

Escrow Account 

Fees checked as Escrow in Section G. of the Initial Fees Worksheet will populate the Escrow 
Account section. The Escrow Account allows the user to calculate the disbursement for 
escrow fees. 

To generate Escrow payments: 

1. Enter a First Payment Date. 
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2. Select the Calculate button. 

 
Figure 276: Escrow Account 

3. Review the Escrow Account Setup. 

 
Figure 277: Escrow Account Setup 

4. If needed, adjust the information. 

Note: Selecting the Calculate button will update the Month, Escrow Indicator, and the Total 
Fees for section G. Initial Escrow Payment at Closing table in the Initial Fees Worksheets. 
The status of the Escrow indicator will determine whether a Fee is included in the 
calculation. 
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5. Select the Calculate button. 

 
Figure 278: Escrow Disbursements 

6. Review the disbursement and re-calculate if needed. 

7. Click the Save button at the top of the screen after reviewing the generated 
information. 

Initial ARM Disclosure 

Users may need to complete this screen to issue an initial Adjustable-Rate Mortgage 
Disclosure. 

To navigate to this screen: 

1. Click on the Application tab. 

2. Click on Initial ARM Disclosure. 

 
Figure 279: Initial ARM Disclosure 
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How Your Interest Rate is Determined 

1. Enter the Program Name. 

2. Click on the Index Type dropdown menu and select an Index. 

 
Figure 280: Index Type 

3. If the user selects Other, enter the Index in the Other Description field. 

4. If needed, enter information about the index availability. 

5. Select an option that the Index is based on. 

Note: Select all that apply. 

 
Figure 281: Index Option 

  

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
182 

Important Loan Information 

1. Click on the dropdown menu to select if the loan has a Demand Feature. 

 
Figure 282: Important Loan Information 

2. If needed, select the Prepayment Penalty checkbox. 

3. Click on the button. 

Worst Case Scenario 

This section explains how the ARM payments are calculated and the maximum payment 
the borrower might pay. 

 
Figure 283: Worst Case Scenario 

HOEPA Counseling List 

Complete Homeownership and Equity Protection Act (HOEPA) options when home ownership 
counseling is required. 

Generate Counseling List 

Generate a list of available homeownership counselors. 

1. Select Application tab. 
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2. Select HOEPA Counseling List. 

 
Figure 284: HOEPA Counseling List 

3. Click Generate List to create the Counselors List. 

 
Figure 285: Counselor List 

4. Repeat Steps 1 – 13 for the co-borrower. 

Add HOEPA Counseling List 

Use the Add option to create a HOEPA Counseling List or add to the generated list. 

1. Click the Counselors List Add button. (See Figure 284.) 
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2. Enter the Company Name. 

 
Figure 286: Add Counseling List 

3. Enter Address information. 

4. Enter Phone number. 

5. Enter Web Site Address. 

6. Enter Email Address. 

7. Select Counselor Visited from the dropdown. 

8. Enter Agency ID#. 

9. Click the Languages Provided Add button to select the preferred language. 

 
Figure 287: Add Languages Provided 
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10. Click the Counseling Services Provided Add button to select the service. 

 
Figure 288: Add Counseling Services Provided 

11. Click Save & Close. 

Edit HOEPA Counseling List 

Use the following steps to edit a listed HOEPA counseling service provider. 

1. Select the service provider to edit. (See Figure 285.) 

2. Update the Edit Counseling List dialog. (See Add HOEPA Counseling List for details.) 

3. Click Save & Close. 

Delete HOEPA Counseling List 

Use the following steps to delete a listed HOEPA counseling service provider. 

1. Select the service provider to delete. (See Figure 285.) 

2. Click Delete on the Delete Confirmation dialog. 

Homeownership Education 

Use the Homeownership Education section to track the completion status of the 
borrower/co-borrower homeownership education. 

1. Select Yes from the Completed dropdown when borrower finishes the required 
education. 

 
Figure 289: Homeownership Education 
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2. Select the Completion Date. 

3. Select the Training Format option. 

4. Enter Counselor Name. 

5. Enter the Company Name and Address. 

Note: Enter the Postal Code to auto-populate the City and State. 

6. Enter Agency ID# the borrower received after education completion. 

7. Repeat Steps 1 – 6 for the co-borrower. 

Housing Counseling 

Use the Housing Counseling section to track the completion status of the borrower/co-
borrower housing counseling. 

1. Select Yes from the Completed dropdown when borrower finishes the required 
housing counseling. 

2. See Homeownership Education for completion details. 

3. Repeat Steps 1 – 2 for the co-borrower when appropriate. 

Loan Processing 

Use the Loan Processing screens to prepare for form printing. 

Note: Printing is performed from the Documents screen. (See Documents for additional 
information.) 

Credit Information 

Use the Credit Information screen to prepare for Credit Report requests. 

 

Credit Scores 

Complete the following section to request Credit Reports. 

1. Select the Processing tab. 

2. Select Credit Information. 
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3. Click the Borrower Credit Scores Add button. 

 
Figure 290: Add Credit Score 

4. Select the Credit Repository Type from the dropdown menu. 

 
Figure 291: Add Credit Bureau Dialog 

5. Enter the Model Used. 

6. Enter the Score Category. 

7. Enter the U.S Consumers Rank. 

8. Enter the Range of Possible Scores. 

9. Enter the Number of Recent Inquiries. 

10. Use the Calendar to enter the Score Date. 

11. Select the FACT Act Inquiries checkbox if appropriate. 

12. Enter the Credit Repository. 

13. Complete the Address fields. 
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14. Click Add if additional factors are required. 

 
Figure 292: Add Factor Dialog 

15. Enter the Code. 

16. Enter code Description. 

17. Click Save & Close on the Add Factor dialog. 

Note: Click Save & New to add additional factors. 

18. Click Save & Close on the Add Credit Bureau dialog. 

Note: Click Save & New to add another credit bureau. 

19. Enter Minimum FICO score. 

 
Figure 293: Minimum FICO Score 

20. Repeat steps 1 – 19 for co-borrower. 

Alternate Creditor Names 

Complete the following section when the borrower/co-borrower has obtained credit under 
a different name. 

1. Click the Borrower Alternate Creditor Names Add button. 

 
Figure 294: Add Alternate Creditor Names 
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2. Enter the name the Borrower Name previously used for credit. 

 
Figure 295: Add Credit Under Alternate Name 

3. Enter Creditor Name. 

4. Enter Account Number under which the credit was obtained. 

5. Click Save & Close. 

Note: Click Save & New to add another previous name. 

6. Repeat Steps 1 – 5 for co-borrower. 

Credit Score Details 

Enter the credit score details for the borrower and co-borrower. 

1. Select the appropriate borrower Provided on Behalf of Lender option. 

 
Figure 296: Credit Score Details 

2. Select the appropriate borrower Disclosed Credit Score option. 

3. Repeat Steps 1 – 2 for the co-borrower. 
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Tax Return Requests 

Use the Tax Return Requests tab to provide the borrower authorization to verify tax 
information with the Internal Revenue Service (IRS). 

• Form 4506 orders copies of tax returns. 

• Form 4506-T orders transcripts of tax returns. 

• Form 4506-C enables Income Verification Express Service (IVES) participants to 
order tax transcript records electronically for a third-party. 

Note: Zenly creates a clean version of Form 4506-C that is compatible with OCR (Optical 
Character Recognition) technology. 

Request Transcript 

Use the following steps to request Tax Return Transcripts. 

Note: Complete separate requests for each borrower. 

1. Select the Processing tab. 

2. Select Tax Return Requests. 

3. Click Add. 

 
Figure 297: Request Transcripts 
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4. Select the Tax Request Status option. 

 
Figure 298: Add Transcript Details 

5. Select the appropriate Borrower option. 

Note: The Borrower's information auto-populates into the Name on Tax Return fields. The 
spouse's information auto-populates if the Borrower dropdown menu contains both the 
Borrower and Co-Borrower. See the figure below. 

 
Figure 299: Borrower/Spouse Information 

6. Enter the Customer File Number. 

7. Select the Tax Form Number option. 

8. If needed, select the Certified Copies checkbox. 

9. Enter a Unique ID. 

10. Complete the Request Period End Dates. 
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11. Select the appropriate checkboxes for Transcript Requested. 

Selecting the Form W-2, 1099, 1098, or 5498 checkbox will enable the Request 
Wage & Income Form. 

12. Select the Alternate Name checkbox if applicable. 

13. Select the Line 1A Request Wage & Income Transcripts if applicable. 

This checkbox is unavailable by default. 

14. Enter the Cost Amount. 

15. Enter Number of Returns. 

16. Select the Return Refund to 3rd Party on Line 5 if applicable. 

17. Use the dropdown menus to select which forms to request in the Request Wage & 
Income Form section. 

This section is unavailable by default. 

18. For the Spouse Name section, select the Alternate Name/Joint Return checkbox 
if applicable. 

19. Select the Line 2B Request Wage & Income Transcripts if applicable. 

This checkbox is unavailable by default. See step 11 of the Request Transcript 
section. 

20. Select the Address Type. 

Note: The Address fields populate for the selected address. 

21. Click Save & Close. 

Note: Click Save & New to request additional returns. 

Line 5a – IVES 

Complete IVES fields to order tax transcript records for a third-party. 

1. Enter Participant Name. 

 
Figure 300: Line 5a – IVES Dialog 
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2. Complete the Address fields. 

3. Enter Telephone number. 

4. Enter Extension if applicable. 

5. Enter Fax number. 

6. Enter SOR Mailbox ID. 

7. Enter Participants ID. 

Line 5d – Client 

Use the fields in this section to enter the client’s information. 

1. If needed, select the Same as IVES checkbox. 

 
Figure 301: Client 

2. Enter the Client’s name. 

3. Complete the Address fields. 

4. Enter Telephone number. 

5. Enter telephone Extension if applicable. 

Line 5 – Return To 

Use the Return To fields to indicate where the requested returns should be sent. 
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1. Enter the Company Name. 

 
Figure 302: Return To Dialog 

2. Complete the Company Address field. 

3. Enter Company Telephone Number. 

4. Enter Extension if applicable. 

Tax Request – ID Number & Certification (W-9) 

Complete these fields to verify company ID and W-9 certification if applicable. 

1. Select the Borrower Alternate Name checkbox if applicable. 

 
Figure 303: Tax Request – ID & Certification (W-9) 

2. Enter Borrower Name. 

3. Enter the Company Name. 
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4. Select the Federal Tax Classification option. 

Note: Enter Other Description when selecting Other Federal Tax Classification. 

5. Select the appropriate Limited Tax Classification option if applicable. 

6. Select the Owner interest from Foreign Entities checkbox if applicable. 

7. Enter the Exempt Payee Code if applicable. 

8. Select the FATCA Reporting Code option. 

9. Select the Print Requester Name to include the requester name. 

10. Repeat Steps 1 – 8 for the Co-Borrower if applicable. 

Add Tax Account 

Use the following steps to add a tax account. 

1. Click the Accounts (optional) Add button to enter an Account Number. 

 
Figure 304: Accounts (optional) 

2. Enter Account Number. 

 
Figure 305: Add Accounts 

3. Click Save & Close. 

Note: Click Save & New to add another account. 

Edit Tax Account 

Use the following steps to edit a tax account. 

1. Click the Account Number to edit. (See Figure 304.) 

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
196 

2. Change the Account Number as applicable. (See Add Tax Account for details.) 

3. Click Save & Close. 

Delete Tax Account 

Use the following steps to delete a tax account. 

1. Click the Delete icon. (See Figure 304.) 

2. Click Delete on the Delete Confirmation dialog. 

Tax Authorization 8821 

Complete the Tax Authorization (8821) fields to provide taxpayer authorization for personal 
taxes to be reviewed. 

1. Enter the Borrower SSN/Tax ID if applicable. 

 
Figure 306: Tax Authorization (8821) 

2. Enter the Borrower EIN if applicable. 

3. Enter the Borrower Plan Number. 

4. Select Yes or No appropriately for Centralized Authorization File (CAF) question. 

5. Select Yes or No appropriately for prior tax information authorization question. 

6. Repeat Steps 1 – 5 for co-borrower if applicable. 

Designees 

Use the following sections to complete Borrower/Co-Borrower Designees. 
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Add Designees 

1. Click the Borrower Designees Add button. 

 
Figure 307: Designees and Tax Matters 

2. Complete the Designee Name fields. 

 
Figure 308:Add Designee Dialog 

3. Complete the Designee Address fields. 

Note: Entering Postal Code populates the City & State/Province. 

4. Enter Designee CAF Number. 

5. Enter Designee PTIN. 

6. Enter Designee Telephone. 

7. Enter Designee Fax. 

8. Select the appropriate checkboxes. 

9. Click Save & Close. 

Note: Click Save & New to add another Designee. 

10. Repeat Steps 1 - 9 for co-borrower if applicable. 
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Edit Designees 

Use the following steps to edit a designee. 

1. Click the Designee to edit. (See Figure 307.) 

2. Update the designee details on the Edit Designee dialog. (See Add Designees for 
details.) 

3. Click Save & Close. 

Delete Designees 

1. Click the Delete icon. (See Figure 307.) 

2. Click Delete on the Delete Confirmation dialog. 

Tax Matters 

Use the following steps for borrower/co-borrower Tax Matters information. 

Add Tax Matters 

Use the following steps to add additional tax information. 

1. Click the Borrower Tax Matters Add button. (See Figure 307.) 

2. Enter Type of Tax. 

 
Figure 309:Add Tax Matters Dialog 

3. Enter Tax Form Number. 

4. Enter Year(s) or Period(s). 

5. Enter Specific Tax Matters. 

6. Click Save & Close. 

Note: Click Save & New to add other Tax Matters. 

7. Repeat Steps 1 – 6 for co-borrower if applicable. 
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Edit Tax Matters 

Use the following steps to edit tax matters. 

1. Click the Tax Matters to edit. (See Figure 307.) 

2. Edit the Designee as applicable. (See Add Tax Matters for details.) 

3. Click Save & Close. 

Delete Tax Matters 

4. Click the Delete icon. (See Figure 307.) 

5. Click Delete on the Delete Confirmation dialog. 

Title Commitment Request 

Use this screen to add information for title commitment requests. 

1. Enter the name and address of the requester. 

 
Figure 310: Request Title Commitment 

2. Enter the name of the Title company. 

3. Enter the name of the Homeowner. 

4. Enter the homeowner’s phone number. 

5. Add any Attachments if applicable. 

6. Enter the Type of Policy. 

7. If needed, select the Mail Away option. 

8. If needed, add Special Instructions. 

9. Click Save. See Generate Processing Document List. 
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Verification Certification 

The Verification Certification options enable printing forms to verify borrower/co-borrower 
provided information. Verification must be completed for the borrower and co-borrower. 

Verification of Benefits 

Complete the Verification of Benefits (VOB) fields in preparation for printing. 

Copy VOB 

Copy VOB before adding other income. 

1. Select the Processing tab. 

2. Select Verification/Certification. 

 
Figure 311: Verification/Certification 

3. Click the Borrower Copy Income button to copy the income from the application. 

 
Figure 312: Copy Income 

4. Select Income Type form(s) to print on the Copy Income dialog. 

5. Click Copy & Close. 

6. Enter the form requestor name in From field. (See Figure 311.) 

7. Enter the form requestor Title. 
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Add VOB 

Use the following steps to add a VOB. 

1. Click the Add button to add another income source. (See Figure 311.) 

 

Figure 313: Add Verification of Benefits  

2. Complete the Add Verification of Benefits dialog fields. 

3. Click Add to add another account for new income source. 

 
Figure 314: Add Account Verification Dialog 

4. Complete the Add Account Verification dialog fields. 

5. Click Save & Close on the Add Account Verification dialog. 

Note: Click Save & New to add another account. 

6. Click Save & Close on the Add Verification of Benefits dialog. 

Note: Click Save & New to add another account. 
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7. Enter form requester name in From field. 

8. Enter form requester Title. 

9. Repeat Steps 1 – 8 for co-borrower. 

Edit VOB 

Use the following steps to edit a VOB. 

1. Select the VOB to Edit. (See Figure 311.) 

2. Edit the VOB as applicable. (See Add VOB for details.) 

3. Click Save & Close. 

Delete VOB 

Use the following steps to delete a VOB. 

1. Select the Delete icon. (See Figure 311.) 

2. Click Delete on the Delete Confirmation dialog. 

Verification of Employment 

Complete the Verification of Employment fields in preparation for printing. 

Copy VOE 

Copy VOE before adding another employer. 

1. Click Copy Employer. 

 
Figure 315: Verification of Employment 
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2. Select Employment Verification form(s) to print. 

 
Figure 316: Copy Employer Dialog 

3. Click Copy & Close. 

4. Enter form requester name in From field. (See Figure 315.) 

5. Enter form requester Title. 

Add VOE 

Use the following steps to add employment. 

1. Click the Add button to add another employer. (See Figure 315.) 

2. Complete the Add Employment Verification dialog fields. 

 
Figure 317: Add Employment Verification Dialog 

3. Select the Print “SEE ATTACHED” in signature box checkbox to include the 
statement on the verification form. 
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4. Click Save & Close to add the employment verification information. 

Note: Click Save & New to add another employment verification. 

Edit VOE 

Use the following steps to edit employment. 

1. Select the VOE to edit. (See Figure 315.) 

2. Edit the VOE as applicable. (See Add VOE for details.) 

3. Click Save & Close. 

Delete VOE 

Use the following steps to delete employment. 

1. Select the VOE to Delete. (See Figure 315.) 

2. Click Delete on the Delete Confirmation dialog. 

Verification of Deposit 

Complete the Verification of Deposit fields in preparation for printing. 

Copy VOD 

Copy VOD before adding other deposits. 

1. Click Copy Assets. 

 
Figure 318: Verification of Deposit 

2. Select the Asset to copy. 

 
Figure 319: Copy Asset Dialog 
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3. Click Copy & Close. 

4. Enter form requester name in From field. (See Figure 318.) 

5. Enter form requester Title. 

Add VOD 

Use the following steps to add deposits. 

1. Click the Add button to add another deposit. (See Figure 318.) 

2. Complete the Add Verification Deposit dialog fields. 

 
Figure 320: Add Verification of Deposit Dialog 

3. Select the Print “SEE ATTACHED” in signature box checkbox to include the 
statement on the verification form. 

4. Click Add to complete another account for the new deposit company. 

 
Figure 321: Add Account Verification Dialog 

5. Complete the fields. 

6. Click Save & Close on the Add Account Verification dialog. 

Note: Click Save & New to add another deposit account. 
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7. Click Save & Close on the Add Verification of Deposit dialog. 

Note: Click Save & New to add another deposit account. 

8. Enter form requester name in From field. (See Figure 318.) 

9. Enter form requester Title. 

Edit VOD 

Use the following steps to edit deposits. 

1. Select the VOD to edit. (See Figure 318.) 

2. Edit the VOD as applicable. (See Add VOD for details.) 

3. Click Save & Close. 

Delete VOD 

Use the following steps to delete a deposit. 

1. Select the Delete icon. (See Figure 318.) 

2. Click Delete on the Delete Confirmation dialog. 

Verification of Loan 

 Complete the Verification of Loan (VOL) fields in preparation for printing. 

Copy Liabilities 

1. Click Copy Liabilities. 

 
Figure 322: Verification of Loan 

2. Select Liability form(s) to print. 
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Figure 323: Copy Liabilities Dialog 

3. Click Copy & Close. 

4. Enter form requester name in From field. (See Figure 322.) 

5. Enter form requester Title. 

Add VOL 

Use the following steps to add VOL. 

1. Click Add to add another liability account. (See Figure 322.) 

2. Complete the Add Loan Verification dialog fields. 

 
Figure 324: Add Loan Verification Dialog 

3. Select the Print “SEE ATTACHED” in signature box checkbox to include the 
statement on the verification form. 

4. Click Add to add another account to the new liability company. 

5. Complete the Add Account Verification dialog fields. 
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Figure 325: Add Account Verification Dialog 

6. Click Save & Close on the Add Account Verification dialog. 

Note: Click Save & New to add another liability account to the new liability company. 

7. Click Save & Close on the Add Loan Verification dialog. 

Note: Click Save & New to add another loan account. 

8. Enter form requester name in From field. (See Figure 322.) 

9. Enter form requester Title. 

Edit VOL 

Use the following steps to edit a loan. 

1. Select the VOL to edit. (See Figure 322.) 

2. Edit the VOL as applicable. (See Copy Liabilities for details.) 

3. Click Save & Close. 

Delete VOL 

Use the following steps to delete a loan. 

1. Select the Delete icon. (See Figure 322.) 

2. Click Delete on the Delete Confirmation dialog. 

Verification of Mortgage and Rent 

Complete the appropriate Verification of Mortgage and Rent (VOM/R) fields in preparation 
for printing. 

Rental Verification 

Complete the Rental Verification fields if borrower/co-borrower currently rents. 

1.  Click Copy Rentals. 

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
209 

 
Figure 326: Rental Verification 

Note: Proceed to step 4 if borrower/co-borrower currently owns property. 
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2. Select the Address checkbox. 

 
Figure 327: Copy Rental Dialog 

3. Click Save & Close. 

4. Click Copy REOs when borrower/co-borrower currently owns property. 

5. Select the Address checkbox. 

 
Figure 328: Copy REOs 

6. Click Save & Close. 

7. Enter requestor name in From field. (See Figure 326.) 

8. Enter requestor Title. 

Note: Use the Delete icon to remove table items. 

Mortgage Verification 

Complete the Mortgage Verification fields if borrower/co-borrower currently falls into the 
Real Estate Owned (REO) category. 

1. Click Copy REOs. (See Figure 326.) 

2. Select the Address checkbox. 

3. Click Save & Close. 
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4. Complete the From and Title fields. (See Figure 326.)  

Note: Use the Delete icon to remove table items. 

Add Mortgage or Rent Account 

Use the Add button to add the mortgage or rent details to the Property List if not present. 

1. Click the Add button. (See Figure 326.) 

2. Complete the Add Mortgage or Rent Verification dialog fields to verify landlord or 
mortgage holder details. 

 
Figure 329: Add Mortgage or Rent Verification 

3. Click Save & Close. 

Note: Click Save & New to add another mortgage or rent verification. 

4. Complete the From and Title fields. (See Figure 326.) 

Edit VOM/R 

Use the following steps to edit mortgage/rent. 

1. Select the VOM/R to edit. (See Figure 326.) 

2. Edit the VOM/R as applicable. (See Add Mortgage or Rent Account for details.) 

3. Click Save & Close. 

Delete VOM/R 

Use the following steps to delete a mortgage/rent. 

1. Select the Delete icon. (See Figure 326.) 

2. Click Delete on the Delete Confirmation dialog. 
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Social Security Number Verification (SSA-89) 

Complete the Social Security Number Verification (SSA-89) fields to verify the social 
security number matches the borrower/co-borrower providing the documentation. 

1. Enter Information Released for the Business Transaction details. 

 
Figure 330: Social Security Number Verification 

2. Select the Borrower Reason for Authorizing Consent. 

3. Enter Other Description when selecting Other as the reason. 

4. Repeat Steps 2 – 3 if applicable. 

5. Enter the recipient Name for the returned SSA-89.  

6. Enter the recipient Address Information. 

7. Enter recipient Telephone Number. 

VA Verification and Certification 

Complete the VA Verification and Certification details to verify the borrower/co-borrower 
VA benefits. 
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1. Enter the borrower VA Claim Number. 

 
Figure 331: VA Verification of Benefits 

2. Select the appropriate VA benefit-related indebtedness option. 

3. Select the appropriate VA disability benefits prior to discharge from active duty 
service option. 

4. Complete the Certification of Eligibility and Status options. 

 
Figure 332: VA Certification of Eligibility & Status 

5. Repeat Steps 1 - 4 for co-borrower. 

Military Service 

Complete the Military Verification and Certification details to verify the borrower/co-
borrower military benefits. 

1. Click the borrower Add button. 

 
Figure 333: Military Service 
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2. Complete the Add Military Service dialog fields. 

 
Figure 334: Add Military Service Dialog 

3. Click Save & Close. 

Note: Click Save & New to add additional military service. 

Indicate How You Will Use Your Certificate of Eligibility 

Use this section to indicate how the Certificate of Eligibility will be used for either the 
borrower or the co-borrower. 

1. Click on the Select button. 

 
Figure 335: Certificate of Eligibility Indicator 

2. Select the desired options. 

 
Figure 336: Use of Certificate 
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3. Click Save & Close. 

4. Complete the Military Service options. 

 
Figure 337: Military Service Options 

4. Repeat Steps 1 – 4 for co-borrower. 

VA Property Address 

The VA Property Address options are available when Yes is selected for the borrower or co-
borrower questions: Have you used the VA Home Loan program before?, Do you still own any 
of the homes you used the VA Home Loan Program for?. See Figure 337. 

1. If applicable, use the Copy REO  button to auto-populate property information. 

2. Select the desired Address. 

 
Figure 338: Copy REO (VA Property Address) 

3. Click Save & Close. 
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4. Click the VA Property Address Add button. 

 
Figure 339: Add VA Property Address 

5. Complete the Add VA Property dialog fields. 

 
Figure 340: Add VA Property Dialog 

6. Click Save & Close. 

Note: Click Save & New to add another property. 

7. Enter the Mailing Address details for the returned Certification of Eligibility. 
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Figure 341: Certification of Eligibility Address 

8. If needed, add any Remarks. 

9. Repeat Steps 1 – 4 for Co-borrower. 

FHA 

Complete the FHA options for FHA loans. 

FHA/VA Loan Purpose 

Complete the FHA/VA Loan Purpose section for an FHA or VA loan. 

1. Select the Processing tab. 

2. Select FHA. 

 
Figure 342: FHA/VA Loan Purpose 

3. Select the appropriate Section of the Act option. 

4. Use the Calendar to select the FHA Assignment Date. 

5. Click the Select button. 

6. Select the FHA/VA Loan Purpose from the dropdown. 
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Figure 343: FHA/VA Loan Purpose Dialog 

7. Select applicable checkboxes. 

8. Click Save & Close to add to the FHA/VA Loan Purpose table. 

 
Figure 344: FHA/VA Loan Purpose Table 

Addendum to Uniform Residential Loan Application 

Complete the HUD-92900-A fields for an FHA or VA loan. 

1. Select the appropriate (VA) Title Vested in option. 
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Figure 345: HUD-92900-A 

2. Enter Other Description when selecting other as the (VA) Title Vested in option. 

3. Select the appropriate HUD/FHA mortgage option. 

4. Select the appropriate To be sold option. 

5. Complete the To Be Sold fields when selecting Yes. 

6. Complete the remaining HUD-92900-A fields appropriately. 

 
Figure 346: HUD-92900-A Fields 
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Property Improvements (HUD-56001) 

Complete the Property Improvements sections if appropriate. 

1. Select the appropriate answers for HUD-56001 options. 

 
Figure 347: HUD-56001 Options 
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2. Click the Property to be Improved Select button. 

 
Figure 348: Select Property to be Improved 

3. Select the appropriate checkboxes on the Property to be Improved dialog. 

 
Figure 349: Property to be Improved Dialog 

4. Click Save & Close. 

5. Select the applicable radio button. 

 
Figure 350: Property to be Improved Options 
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6. Select the Mortgage or Deed of Trust on Property checkbox if appropriate. 

 
Figure 351: Mortgage or Deed of Trust Details 

7. Complete the Mortgage or Deed of Trust details. 

Bank Accounts 

The displayed borrower/co-borrower Bank Account information is transferred from Assets 
List on the Application Borrower screen. 

Note: Separate processing forms are required for each account. 

1. Select the Account Type to process for printing. 

2. Enter missing borrower Bank Account details. 

 
Figure 352: Bank Account Details 

3. Enter the co-borrower Bank Account details. 
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DE Statement of Appraised Value (HUD-92800.5B) 

Complete the HUD-92800.5B fields to process the Direct Endorsement (DE) Statement of 
Appraised Value form for printing. 

1. Select the Conditional Commitment to Mortgage Insurance checkbox when 
appropriate. 

 
Figure 353: HUD-92800.5B Options 

2. Select the See Below checkbox to mark the See Below checkbox on the printed 
HUD-92800.5B form. 

Note: The See Below form checkbox indicates additional form fields to complete. 

3. Enter the appraiser’s name in the By field. 

4. Use the Calendars to enter the appropriate appraisal dates. 

5. Enter the assigned lender case number in the INST Case Ref. No. field. 

6. Enter the home square footage value in the Improved Living Area field. 

7. Select the appropriate Construction Status. 
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8. Complete the remaining selections. 

 
Figure 354: HUD-92800.5B Selections 

9. Click Select to review the Condition Statements entered on the Underwriting 
Conditions screen. (See Underwriting for details.) 

10. Select the Conditions to include on the form. 

 
Figure 355: Conditions Dialog 

11. Click Save & Close. 
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Energy-Efficient Mortgage Fact Sheet 

Enter the Maximum Mortgage Amount value in preparation for printing the FHA Energy 
Efficient Mortgage Fact Sheet. 

 
Figure 356: Energy-Efficient Mortgage Fact Sheet 

Housing Counseling Lender Certification of Completion 

Complete the fields in preparation for printing the verification of Housing Counseling form. 

1. Select the appropriate Delivery Method party. 

 
Figure 357: Counseling Cert. of Completion 

2. Select the appropriate Training Format. 

Affiliated Business 

Complete this screen if there are any business relationships with service provider(s) that 
offer services for the loan. 
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Option A 

1. Select option A if services are NOT required to be used. 

 
Figure 358: Affiliated Business 

2. Select the appropriate condition. 

3. Click on the Add button to list any affiliated business. 

 
Figure 359: Add Service Provider 

4. Enter the Settlement Service Provider. 

5. Enter the Nature of the Relationship. 

6. Click the Add button to list the service(s). 

 
Figure 360: Add Service 

7. Enter the Settlement Service. 

8. Enter the Charge or Range of Charges. 
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9. Select Save & Close or Save & New for both the Service and the provider screens. 

Option B 

1. Select option B if a service is required to be used. 

2. Click the Add button to list any affiliated businesses. 

3. Repeat Option A steps 4-10 to list any affiliated businesses. 

Underwriting 

Complete the required fields in preparation for printing the Uniform Underwriting and 
Transmittal Summary form and Property Conditions form. 

Transmittal Summary 

Many of the Underwriting Transmittal screen fields are auto populated and non-editable. 

 
Figure 361: Transmittal Summary 

Note: The Ratios, Stable Monthly Income, and Total Monthly Payments tables are auto 
populated. 

Project Classification 

The Project Classification fields are displayed on the Project Classification section of the 
Uniform Underwriting and Transmittal Summary form for Freddie Mac or Fannie Mae 
submittals. 

1. Select the Freddie Mac option if appropriate. 

  
Figure 362: Project Classification 

2. Select the Fannie Mae option if appropriate. 
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3. Enter the assigned Project Name. 

4. Enter the Constant Payment Mortgage (CPM) Identification number. 

Qualifying Ratios 

Complete the fields for the Uniform Underwriting and Transmittal Summary form Qualifying 
Ratios fields. 

1. Enter the Qualifying Interest Rate. 

  
Figure 363: Qualifying Ratios 

2. Select the Note Rate radio button if appropriate. 

3. Enter the Note Rate. 

Risk Management 

Complete the fields for the Uniform Underwriting and Transmittal Summary form Risk 
Assessment fields. 

1. Select the Underwriting Method option. 

  
Figure 364: Risk Management 
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2. Enter Other Description when selecting Other from the Underwriting Method 
dropdown. 

3. Enter the Automated Underwriting System (AUS) Recommendation. 

4. Enter the AUS identifier in the AUS Identification field. 

5. Enter the Loan Prospector (LP) document class in the LP DOC Class field. 

6. Enter the Credit/Indicator Score. 

Escrow Account and Funds to Close 

Complete the fields for the Uniform Underwriting and Transmittal Summary form Escrow and 
Borrower Funds to Close fields. 

1. Select the appropriate Escrow Account radio button. 

  
Figure 365: Escrow Account and Funds to Close 

2. Enter the Funds Required amount. 

3. Enter the Verified Assets amount. 

4. Enter the verified assets Source. 

5. Enter the total Months in Reserve. 

6. Enter the Interested Party Contribution percentage. 

Mortgage Originator and Level of Property 

Use the following steps to complete the Mortgage Originator/Level of Property sections. 
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1. Select the Mortgage Originator from the dropdown. 

 
Figure 366: Mortgage Originator/Level of Property 

2. Enter the Mortgage Contact name. 

3. Enter the Mortgage Company name. 

4. Select the Property Review Level from the dropdown. 

5. Enter the Form Number from the dropdown. 

6. Enter Other Description if selecting Other from Form Number option. 

7. Select Yes or No for Community Lending/Affordable Housing Initiative? 

8. Select Yes or No for Homebuyer/Homeownership Education on File? 

9. Enter Underwriting Comments if applicable. 

10. Click Save. 

Conditions 

Add an Underwriting condition by selecting the Add button. 

 
Figure 367: Conditions 

Adding Conditions 

To add an Underwriting condition: 
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1. Select the Add  button. 

2. Add a Description to the Condition. 

 
Figure 368: Add Condition 

3. Enter the desired information in the fields on the Add Condition dialog. 

4. If needed, select the paper clip icon to link stored documents. 

5. If needed, select the upload icon to upload a PDF. 

6. Select the Save & Close button to complete the Condition. 

Notice of Action Taken 

The Notice of Action Taken allows the user to generate an action notice. 

 
Figure 369: Notice of Action Taken 

To fill out the notice: 
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1. Select the Action Notice dropdown and select an appropriate option. 

2. Select a Delivery Method for the dropdown menu. 

3. Enter who the notice was Prepared By. 

4. Select an Action Date. 

5. If the Credit Denial action was selected, add a Denied Date. 

6. If the Counter Offer action was selected, add the Counter Offer Date. 

7. If the Incomplete Application was selected, add Provide Missing Information By 
date. 

8. Type a Notice Detail to explain in-depth the reason for the notice. 

9. If needed, select the If checked… checkbox. 

Note: The If checked… checkbox only applies to the Counter Offer Action. 

 
Figure 370: Principal Reasons of Action 

Add Reasons of Denial 

For Part 1 – Principal Reason(s) for Credit Denial, Termination, or Other Action Taken, to add a 
reason: 
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1. Click on the Add button. 

 
Figure 371: Add Reason of Denial 

2. Click on the Section dropdown menu and select the desired option. 

3. Click on the Denial Type dropdown menu and select the desired option. 

4. If Other was selected, enter a description in the Other Description field. 

5. Select Save & Close. 

Part II 

Select the check box if the information was obtained in a report from a consumer Reporting 
agency. 

Credit Information 

1. If needed, click the Copy Credit Information button for Borrower and/or Co-
Borrower. 

OR 

2. Enter the Borrower’s and, or Co-Borrower’s Credit Information manually. 

Factors 

To add Factors: 

1. Click on the Add button. 
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Figure 372: Factors 

2. Enter a Code and a Description. 

3. Click the Save & Close or the Save & New button. 

Credit Agency 

Enter the Credit Agency information and select the checkboxes if the credit information was 
obtained externally and/or if adding more information. Click Save when this section is 
complete. 

 
Figure 373: Credit Agency 

Reporting 

Use the Reporting screens for entering the information that will appear on the yearly Home 
Mortgage Disclosure Act (HMDA) Report. 
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Mortgage Call Report 2024 

The Mortgage Call Report 2024 (MCR) screen allows the user to enter loan origination 
information required for the NMLS (Nationwide Mortgage Licensing System). The Reporting 
tab is hidden by default for new users. Ensure that the tab is enabled in the User Information 
screen. See Add User. 

 
Figure 374: Mortgage Call Report 

1. Select a Business Channel. 

2. Use the Servicing has been dropdown menu to select a service status. 

3. Select the Exclude Loan from NMLS Report if applicable. 

4. Select the Report as a HOEPA loan checkbox if applicable. 

5. If needed, change the Application Date. 

6. If needed, change the Closed Date. 

Note: Setting a Closed Date will synch and update the Status in the Status > Tracking 
screen. 

Origination Information 

1. Select the Type of Purchaser. 

2. Select the Action Taken. 

3. Choose when the Action was taken (Action Taken Date). 

Loan Information 

The information in this section is auto-populated from the Loan Application screen. Edit the 
fields in this section if applicable. 
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Subject Property Information 

This section is auto-populated from the Application > Subject Property screen. Edit fields if 
applicable. 

 
Figure 375: Subject Property/Loan Originator 

Loan Originator Information 

This section auto-populates the assigned Loan Originators’ information from the Status > 
Contacts screen. 

Profit & Loss Information 

Use this section to enter the Profit and loss information for the loan if applicable. If needed, 
follow these steps for both tables. 

1. Enter the Lender Comp. (compensation). 

 
Figure 376: Profit & Loss Information 

2. Enter the Broker Charges. 

3. Enter the Commissions Paid. 

4. Enter the Lender Charge. 

5. If needed, enter Other Costs. 

6. Select Save. 

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
237 

HMDA 

The HMDA screen contains application, underwriting, and closing information for the 
selected loan. Most screen fields are pre-populated with data entered on other Zenly 
screens. 

Select the Exclude Loan from HMDA Report checkbox to exclude the loan from the HMDA 
Report. 

1. Select HMDA. 

 
Figure 377: HMDA Application 

2. Select Application. 

3. Select the Preapprovals option from the dropdown. 

4. Enter the Legal Entity ID. 

5. Enter the Non Universal Loan ID. 

6. Select the Exclude Loan From HMDA Report checkbox to exclude the selected 
loan from the yearly HMDA Report. 

Note: The Universal Loan Information field is ungrayed for users that are operating as a 
Broker. This functions the same for Loan Application screen. 

7. Verify the following information: 

• Subject Property 
• Applicant 
• Co-Applicant 
• Applicant & Co-Applicant Ethnicity 
• Applicant & Co-Gender 
• Race 

8. Click Save. 
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Underwriting (HMDA) 

Most screen fields are pre-populated with data entered on other Zenly screens. 

1. Select the Application Submission from the dropdown. 

 
Figure 378: Underwriting (HMDA) 

2. Select an Initially Payable option from the dropdown. 

3. Select the Action Taken from the dropdown. 

4. Select the Date. 

5. Select the Purchaser Type from the dropdown. 

Automated Underwriting 

Use the automated underwriting options to select the Automated Underwriting Service (AUS) 
details. 

Add AUS 

1. Click the Automated Underwriting Add button to select the AUS options. 

 
Figure 379: Automated Underwriting Section 
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2. Select the Add Automated Underwriting system from the Type dropdown. 

 
Figure 380: Add Automated Underwriting Dialog 

Note: Enter Other Description when selecting Other from Type dropdown. 

3. Select the appropriate Result. 

Note: Enter Other Description when selecting Other from Result dropdown. 

4. Click Save & Close. 

Edit AUS 

Use the following steps to edit an AUS. 

1. Select the AUS to edit. (See Figure 379.) 

2. Edit the AUS as applicable. (See Add AUS for details.) 

3. Click Save & Close. 

Delete AUS 

Use the following steps to delete an AUS. 

1. Select the Delete icon. (See Figure 379.) 

2. Click Delete on the Delete Confirmation dialog. 

Reason for Denial 

Use the reason for denial to select the Reason for Denial Service (US) details. 
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Add Denial Reason 

1. Click Reasons for Denial Add button to enter loan denial information. 

 
Figure 381: Reasons for Denial Section 

2. Select the Denial Type option from the dropdown. 

Note: The Date field auto populates. 

 
Figure 382: Add Reasons for Denial Dialog 

Note: Enter Other Description when selecting Other from Denial Type dropdown. 

3. Click Save & Close. 

Note: Click Save & New to add another reason for denial. 

4. Select the Disclosed using Notice of Action Taken checkbox if appropriate. 

Edit Denial Reason 

Use the following steps to edit denial reason. 

1. Select the Denial Reason to edit. (See Figure 381.) 

2. Edit the Denial Reason as applicable. (See Add Denial Reason for details.) 

3. Click Save & Close. 

Delete Denial Reason 

Use the following steps to delete a denial reason. 

1. Select the Delete icon. (See Figure 381.) 

2. Click Delete on the Delete Confirmation dialog. 
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Closing 

Most screen fields are pre-populated with data entered on other Zenly screens. 

1. Review the screen fields and add missing information. 

 
Figure 383: Closing 

2. Enter the Origination Charges in the Disclosed Fees section. 

 
Figure 384: Disclosed Fees 

3. Enter the Discount Points. 

4. Enter the Lender Credits. 

5. Enter the Total Loan Cost. 

6. Enter the Total Points and Fees. 

7. Check NA checkbox when applicable. 

Documents 

The Documents screens provide management options for loan associated documents. 

Stored 

Generated documents are moved to the Stored page after clicking the Generate Store 
button. 
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Upload Documents 

Upload locally saved documents. 

File Types allowed: 

• TXT 
• MSG 
• PDF 
• PNG 
• JPEG 
• JPG 
• GIF 

• DOCX 
• BMP 
• RTF 
• HTML 
• TIFF 
• XML 

1. Click the Upload icon. 

 
Figure 385: Upload Documents 
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2. Enter the Document Name. 

 
Figure 386: Upload Dialog 

3. Select the appropriate Borrower when the document is received from a borrower. 

4. Select the appropriate document type from the Category dropdown. 

5. Click Choose File. 

6. Use the Calendar to select the Prepared Date. 

7. Enter the Package Name if the document is part of a package. 

8. Use the Calendar to select the Stored Date if applicable. 

9. Browse to the file location and upload. 

10. Click Store. 

Document Search 

Use the Document Search feature to quickly locate stored documents in a long list. 

1. Select Documents. 

2. Select Stored. 

 
Figure 387: Search Documents 

3. Enter the Search criteria. 

4. Press Enter. 
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View Documents 

View stored documents for accuracy and details in the Zenly application prior to 
downloading. The document opens in PDF when PDF is installed on the computer. 

1. Select the View icon for the document to view. 

 
Figure 388: View Document 

Note: The document opens in a Browser window. 

2. Perform one of the following for the open document. 

 
Figure 389: Document Browser View 

3. Click Save to save the document locally. 

4. Click Print to print the document. 

Download Documents 

Download multiple documents to perform batch printing. 
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1. Click the Download icon. 

 
Figure 390: Download Document 

2. Click Open File to view the document. 

 
Figure 391: Open File 

Generate 

Generate the files created on the following screens: 

• Application 
• Processing 
• Underwriting 

Generated documents display with a DRAFT watermark. Save them to Storage to remove 
the watermark in preparation for printing. 

Generate Application 

Use the following steps to generate the Loan Application. 

1. Select Document. 
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2. Select Generate. 

 
Figure 392: Generate Application 

3. Select the Borrower radio button. 

4. Select Application from the dropdown. 

5. Enter Date Prepared. 

6. Select the documents from the Application List to store for loan application 
submittal. 

7. Click Store. 

 
Figure 393: Set Package 

8. Enter the Package Name when prompted. 

9. Click Set. View document in the Document > Stored menu option. 

Generate Processing Document List 

Use the following steps to generate the processing document list. 

1. Select the appropriate borrower radio button. (See Figure 392.) 

2. Select the Processing from the dropdown. 

3. Enter Date Prepared. 

4. Select the processing documents to generate. 
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5. Click Store. View document in the Document > Stored menu option. 

Generate Underwriting Documents 

Use the following steps to generate the processing document list. 

1. Select the appropriate borrower radio button. (See Figure 392.) 

2. Select the Underwriting from the dropdown. 

3. Enter Date Prepared. 

4. Select the processing documents to generate. 

5. Click Store. View document in the Document > Stored menu option. 

Request 

The Request screen has options to request and track requested documents. 

Note: Document request recipients must have a valid email address on file. 

1. Select Document. 

2. Select Request. 

 
Figure 394: Document Request 

Pending 

Use the Pending options to request missing documents from appropriate parties. 

1. Click the Add button. (See Figure 394.) 
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2. Select or enter the Document Name. 

 
Figure 395: Add Document Request Dialog 

3. Select the request recipient from the Borrower dropdown. 

4. Select the document Category from the dropdown. 

Note: Leave Category blank when the document category is not listed. 

5. Use the Calendar to select the Due Date and Time. 

6. Enter a memo to the request recipient if Memo to Borrower does not auto 
populate. 

7. Click Save & Close. 

Note: Click Save & New to add another document request. 

8. Click Send when requested documents are listed. 

 
Figure 396: Send Document Request 

9. Click Send To. 

 
Figure 397: Send To 
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Review 

Documents requested appear in the Review List after returning from requestor. 

1. Click the Preview icon. 

 
Figure 398: Review Received Document 

2. Click Accept to approve the received document. 

3. Click Reject to reject the document. 

Note: The rejected document moves back to the Pending List and returns to the requestor. 

Completed 

Accepted documents move to the Completed List. 

 
Figure 399: Completed Document Requests 

eSign 

eSign documents are available from the Stored Documents List. Upload documents not 
auto generated and save to the Stored Documents List that require eSignatures. 

Use the eSign screen to request electronic signatures. 

1. Select Documents. 

2. Select eSign. 

3. Click Request eSignatures. 

 
Figure 400: eSign Application 
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4. Select the appropriate signee radio button. 

5. Click Next. 

 
Figure 401: Retrieve Document List 

6. Select the appropriate Filtered by option to return the appropriate Stored 
Documents List. 

Note: Select the Uploaded PDF icon to display uploaded documents. 

7. Select the document from the Document Name List to place in the Selected 
Documents List. 

 
Figure 402: Selected Documents 

8. Repeat Steps 7 – 8 until all documents requiring eSignatures are in the Selected 
Documents List. 
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9. If Document Packages is selected, choose the desired package. 

 
Figure 403: Document Packages 

10. Click Next. 

11. Select the appropriate link to continue: 

• Add Signature Fields 

• Request Signatures 

Add Signature Fields 

Use the Add Signature option to add signature fields to upload documents. 

1. Select the Read Receipt checkbox to receive an email when the document is 
delivered. 

 
Figure 404: Add Signature 

2. Click Add Signature. 

3. Click the Add Signature Block icon. 
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Figure 405: Position Signers Dialog 

4. Drag the Signature Block to the appropriate location. 

 
Figure 406: Position Signature Block 
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5. Resize the Signature Block. 

6. Click Save. 

7. Proceed to Request Signatures. 

Request Signatures 

Use the following steps to complete the eSignature request. 

1. Click Next. 

 
Figure 407: Complete eSignature Request 

2. Enter a Package Name. 

 
Figure 408: Send eSignature Request 

3. Use the Calendar to select the Due Date. 

4. Click Request to submit. 

5. Use the Resend Email option on the eSign Pending List to resend documents. 

Services 

Use Services options order credit reports and Automated Underwriting Services (AUS). 
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Credit Reporting 

Use the Credit Reporting screen to order soft or hard credit pulls for the Borrower/Co-
Borrower. Credit pulls auto-populate the Credit Information screen. 

Credit Order  

Complete the individual credit report request for borrower and co-borrower. 

1. Select Services. 

2. Select Credit Reporting. 

 
Figure 409: Borrower Credit Reporting 

3. Check the Credit Card Payment checkbox if appropriate. 

Note: Leave the Credit Card Payment checkbox blank to use credit card information stored 
on the Services Settings screen. (See Services Settings.) 

4. Enter the Credit Agency from the dropdown. 

5. Enter the Request Action Type from the dropdown. 

6. Enter the Report Type from the dropdown. 

7. Enter the Report Identifier if applicable. 

8. Click Credit PINs to enter the borrower-provided credit report PIN number. 

  

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
255 

9. Enter the appropriate Credit PIN. 

 
Figure 410: Credit PIN Dialog 

10. Click OK on the Credit PIN dialog. 

11. Click Submit to submit the Credit Report Request. 

If the Credit Card Payment checkbox is selected the image below displays. 

 
Figure 411: Pay with Credit Card Dialog 

12. Enter credit card information in the Pay with Credit Card dialog. 

13. Click Continue Order on the Pay with Credit Card dialog. 
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14. Enter credit agency Login Information in the Login Information dialog. 

 
Figure 412: Credit Agency Login Information 

15. Click OK on the Login Information dialog. 

16. Repeat Steps 1 – 13 for co-borrower. 

Results 

The Results List auto populates when the requested credit report is returned. 

1. Click Credit Alerts to review credit report alerts. 

 
Figure 413: Credit Report Results List 

2. Click Report to review the full credit report. 
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3. Click the Import Liabilities icon to copy credit liabilities to Zenly. 

 
Figure 414: Copy to Liabilities Dialog 

4. Select the appropriate checkboxes. 

5. Click Yes to import the liabilities to the Application Borrower screen. 

Pricing (Loan Service) 

The Pricing screen allows users to submit the loan to a Pricing Vendor. The Vendor 
dropdown list contains vendors the user can send the loan for pricing. Selecting the Run 
Pricing button will open a new window directing the user to the vendors website login page. 

 
Figure 415: Pricing (Loan Service) 

To run pricing for the loan: 

1. Select a Vendor from the dropdown menu. 
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2. Select the Run Pricing button. 

 
Figure 416: Run Pricing (Loan Service) 

3. Enter the desired search criteria. 

 
Figure 417: Launch Pricing Interface 

4. Click Continue. 
The vendor's login page opens. 

Note: Loans submitted using the Pricing service must have all required fields (Zenly fields) 
completed. An error message with the missing fields will appear. 

Industry Connect 

The Industry Connect allows the user to submit the loan to multiple available wholesalers. 
This screen displays the status of the loan submission and all documents sent by the 
mortgage wholesaler. 
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Figure 418: Industry Connect (Zenly Screen) 

To run pricing options: 

1. Select the Services tab. 

2. Select Industry Connect. 

3. Select an option from the dropdown menu. 

4. Select a wholesaler from the Industry Connect. 

 
Figure 419: Industry Connect Webpage 

5. Complete the wholesaler’s requirements. 

Wholesaler Status and Received Documents 

After a new request submission, the user may receive a status or documents from the 
wholesale. Those items will appear in the tables below the Submission Information section. 

To view the status or documents received: 

1. In the Submission Information section, select the dropdown menu and select the 
wholesaler. 
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Figure 420: Status and Received Document 

2. Preview or download any documents received by selecting the icons. 

3. Click Save. 

Run Market Pricing 

For New Requests, users have the option to select the Run Market Pricing. Selecting that 
button opens LoanScoreCard®. LoanScoreCard® is a service that allows for loan eligibility 
checking as well as searching for an available loan product. 

 
Figure 421: LoanScoreCard 

Desktop Originator 

The Desktop Originator settings determine how Zenly interacts with Fannie Mae Desktop 
Originator. 

Fannie Mae DO and Credit Logins must be set up to submit to Underwriting. 

Note: Proceed to Services Settings to set up Fannie Mae credentials. 
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1. Select Desktop Originator. 

 
Figure 422: Desktop Originator Submission Info 

2. Select Credit & Underwriting from the Underwriting dropdown. 

Note: Select Underwriting from the Underwriting dropdown when re-submitting the loan to 
Desktop Originator. 

3. Select the appropriate Submission option. 

4. Select the appropriate Lender option. 

Note: Selecting a Lender is not required when the Preliminary Submission option is selected. 

5. Click the Lender Refresh icon to refresh the Lender dropdown. 

6. Click Submit. 

Note: A red warning displays by the Submit button when a Credit Reissue is not attached. 

7. Click the Remove button to remove the Fannie Mae assigned Casefile ID and the 
Results List information to resubmit and receive a new Casefile ID. 

Note: The Results List populates after submittal. 

Loan Product Advisor 

Freddie Mac’s Loan Product Advisor (LPA) allows the user to access Freddie Mac credit 
requirements and view credit risks as well as the loan’s overall underwriting risk. 

Before submitting an LPA request. Ensure that the following is completed: 

• LPA credentials are added to Zenly. 
• The borrower’s credit is pulled through Zenly. 
• The loan application is reviewed. 
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Figure 423: Loan Product Advisor 

Submission Information 

To submit an LPA request: 

1. For the Transaction Request Type dropdown menu, select the desired option. 

2. Enter the desired Case State option. 

3. Enter the desired Submitting Role. 

4. Click the Submit button. 

The Submit button will change to a Refresh button after an LPA is Processing 
message appears. 

5. To retrieve a result, select the Refresh button. 

Note: Allow the screen a few seconds to process before selecting the Refresh button. 

Results Table 

The Results table contains LPA information for submitted requests. Errors messages are 
views by selecting the icon in the Messages column. The LPA report is viewed by selecting 
the icon in the Reports column. 

Credit 

This section of the table lists the Borrowers that have credit documentation available. 
There’s a Max of five borrowers listed. 

Error Messages Table 

The Error Messages table is a hidden table below the Results table and becomes visible if 
the LPA submission contains errors. 
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Settings 

Use the Settings tab to apply conditions for the selected loan. The Settings tab options 
override the USER tab selections. 

User Access 

Apply User Access settings to the selected loan. 

Add User Access 

Use the following steps to add user access to the loan. 

1. Select User Access from the Settings tab. 

 
Figure 424: Loan User Access Settings 

2. Click Add to add another user to the loan. 

3. Enter the user in the Search field. 

 
Figure 425: Set Loan User Access 

4. Click the Search icon. 

5. Click Add Edit to enable edit functionality. 

Note: Click Add Read to enable read functionality. 

6. Click Close. 
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Edit User Access 

Use the following steps to edit loan user access. 

1. Select User Access from the Settings tab. (See Figure 424.) 

2. Update the Edit User Access To Loan dialog. (See Add User Access for details.) 

3. Click Save & Close. 

Delete User Access 

Use the following steps to delete loan user access. 

1. Select the Delete icon. (See Figure 424.) 

2. Click Delete on the Delete Confirmation dialog. 

Document Defaults 

Use Document Defaults settings to set up the default information for specific documents. 

Status Defaults 

Use the Status Defaults to set the company defaults to automatically print on forms. 
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1. Select Document Defaults from the Settings tab. 

 
Figure 426: Document Defaults 

2. Select Status from the Select Menu dropdown. 

3. Select Company Information from the Select Document dropdown. 

4. Enter Company Information. 

 
Figure 427: Default Company Information 

5. Click the State License Add button to automatically add state license information 
to documents. 

6. Enter the licensed State from the dropdown menu. 

 
Figure 428: Add State Dialog 

7. Enter License number. 
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8. Enter License Authority. 

9. Enter Web Site Address. 

10. Click Save & Close. 

Note: Click Save & New to add additional licenses. 

Application Privacy Settings 

Select the information to appear on the Privacy Statement Form. 

1. Select Application from Select Menu. 

 
Figure 429: Loan Application Privacy Settings 

2. Select Privacy Policy from Select Document. 

3. Select the Calendar to set Privacy Policy Revision Date. 

4. Click the Personal Information Sharing Add button to select document types 
impacted by personal sharing. 

 
Figure 430: Add Personal Information Sharing 

5. Select the appropriate Type. 

Note: Enter Other Description when selecting Other from the Type dropdown. 
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6. Select Save & Close to add the document type to the Personal Information List. 

 
Figure 431: Document Type List 

Note: Select Save & New to add another document type. 

7. Enter Questions and Assistance Telephone and Web Site Address to which the 
borrower/co-borrower can refer when questions arise. 

8. Select Yes for the Reason to Share Personal Information statements to appear on 
the form. 

 
Figure 432: Reasons to Share Personal Info. 

9. Select the appropriate corresponding Limited Sharing option. 
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10. Select the appropriate Opt-out Methods details. 

 
Figure 433: Opt-out Methods 

11. Click Select to add Opt-out Choices. 

12. Select the checkboxes to include the information on the form. 

 
Figure 434: Opt-out Choices Dialog 

13. Complete the remaining form fields. 

14. Click Save to save the selections. 

ECOA Processing Settings 

Select the statement to include in the Equal Credit Opportunity Act (ECOA) Form.  
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1. Select Processing from the Select Menu dropdown. 

 
Figure 435: ECOA Form Statement 

2. Select ECOA from the Select Document dropdown. 

3. Select the appropriate Federal Agency from the dropdown. 

4. Review the Description to ensure the correct one is selected. 
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Chapter 5: MARKETING 
The Marketing tab displays the user’s Marketing Dashboard. This dashboard is used for 
creating and monitoring email campaigns. The tab contains a dashboard for viewing created 
marketing campaigns. 

Note: Email settings must be configured before activating an email campaign. 

 
Figure 436: Marketing Tab 

Marketing Dashboard 

Use the columns in the table to sort the information in the dashboard. A toggle is available 
to make a running campaign active or inactive. For more information, see Creating a New 
Campaign. 

Campaign Status 

The Status column shows the level of activity for each created campaign. 

Available Statuses 

In Progress: The campaign is Continuous and Active, or if the campaign is set as One-Time 
and the final campaign email has not been sent. 

Cancelled: When an “In Progress” or “Pending” campaign is switched to “Off” or cancelled. 

New: A new campaign was created or edited where not enough parameters are set to 
activate the campaign. 

Pending: The campaign is One-Time and Scheduled Delivery is a Future date/Time. 

Completed: The campaign is One-Time and the final campaign email was sent. 
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Off/On 

A toggle is available to activate and deactivate email campaigns. For active One-Time 
campaigns, a Cancel link appears to remove that campaign. If the toggle is switched from 
On to Off, the associated campaign will reset. 

 

 
Figure 437: On/Off 

To activate a New Continuous campaign, ensure that all parts of the campaign are 
configured (Workflow, Recipients, and Scheduled Delivery time). 

Cancel 

The Cancel link will appear for One-Time campaigns with multiple leaves. Clicking this link 
deactivates the campaign and moves the table item to the Inactive side. 

 
Figure 438: Cancel Link 

When a “In Progress” or “Pending” campaign is cancelled, no more emails will be sent for 
that campaign, including any additional  

Copy Campaign 

To copy a campaign: 

1. Click the Select button. 

2. Choose the desired campaign(s). 

  

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
272 

3. Click Copy. 

 
Figure 439: Copy Campaign 

Delete Campaign 

Unnecessary or unneeded campaigns are removed by selecting the Delete  icon. 

 
Figure 440: Delete Campaign 

Filtering 

Filter specific campaign types in the Marketing Dashboard by selecting the Filter  icon at 
the top of the screen. Users can filter by three types: Active, Continuous, and Archived. 

 
Figure 441: Filtering Campaigns 

Archiving a Campaign 

To move an active or inactive campaign into the archive: 

1. Click the Select button. 
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2. Select the desired campaign(s). 

3. Select Archive. 

 
Figure 442: Archive Campaign 

Viewing Archived Campaigns 

To view the archived campaigns: 

1. Select the Filter  icon. 

2. Choose Archived. 

 
Figure 443: Filter Archived 

Creating a New Campaign 

Users can create multi-step email campaigns that allows the user to enable delayed emails 
and specify when the emails are sent. 

To create a new campaign: 

1. Select the New dropdown menu. 

2. Choose New Continuous or New One-Time. 

One-Time Campaign 

One-time campaigns are email campaigns executed once over a period. 

To create a new One-Time Campaign: 
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1. Select the New dropdown menu. 

2. Select New One-Time. 

 
Figure 444: One-Time 

Workflow 

The Workflow step allows the user to create and set delayed email. Each email segment or 
“Leaf” represents a set email used for the period. 

For the Workflow step: 

1. Enter the desired Campaign Name. 

 
Figure 445: Workflow 

2. Select the Design/Edit Email button. 
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3. Design the email to the desired format. 
If needed, select the Send Sample email. 

 
Figure 446: Email Composition 

4. Once the email is completed, click OK. 

5. If needed, add additional emails by selecting the Add  icon. 

 
Figure 447: Delaying Email 

6. Choose how long until the next email is sent. 

7. Enter the subject in the Subject Line. 

8. Click the Design/Edit Email button. 

9. Design the email. 
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10. If needed, add a new level. 

Note: To remove a level, click the Delete button for that level. 

11. Click Next to proceed to Step 2 (Recipients). 

Recipients 

Recipients that generate into the table import information from the user's Leads/Loans file. 
If Loans is selected from the Contact from drop-down menu, only Loan files linked with a 
Lead file will populate the Recipients table. See Linking a Loan file. 

For the Recipients step: 

1. Select an option from the first drop-down menu. 

2. If needed, select the desired checkboxes. 

 
Figure 448: Recipients 

3. To set Filters, select an option from the drop-down menu. 

4. If needed, select the Add  icon to insert a filter. 

5. For the additional Filter, select the type of Field. 

 
Figure 449: Filters for Campaign 
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6. Select the parameter. 

7. Enter a desired value. 

8. For additional filters, click on the Add  icon. 

9. Once the desired filters are set, click Generate to populate a filtered list. 

 
Figure 450: Generate List 

10. Click Next to proceed to Step 3 (Scheduled Delivery). 

Scheduled Delivery 

There are two options (Now and Date/Time) the user can select to start the campaign. 

To set a campaign delivery date: 
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1. If the Now option is selected, click Save & Exit to begin the campaign immediately. 

2. If Date/Time is selected, click on the Calendar  icon. 

 
Figure 451: Select Delivery Date 

3. Select a date. 

4. If needed, select the clock icon to set a specific time. 

5. Use the dropdown menu to choose a timezone. 

 
Figure 452: Time Zone Dropdown 

6. Click Save & Exit. 
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Continuous Campaign 

Continuous Campaigns function similarly to One-Time. Continuous Campaigns don’t end until 
the toggle is turned off. 

To create a Continuous Campaign: 

1. Select the New dropdown menu. 

2. Select New Continuous. 

 
Figure 453: New Continuous 

Workflow 

For the Workflow step: 

1. Enter the name of the campaign. 

2. Select the Design/Edit Email button. 

3. Design the email to the desired format. 

4. If needed, select the Send Sample email. 

5. Once the email is completed, click OK. 

6. If needed, add additional emails by selecting the Add  icon. 

7. Choose how long until the next email is sent. 

8. Click the Design/Edit Email button. 

9. Design the email. 

10. If needed, add a new level. 

Note: To remove a level, click the Delete button for that leaf. 

11. Click Next to proceed to Step 2 (Recipients). 
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Recipients 

For the Recipients step: 

1. Select the Include Spouse/Co-Borrower checkbox if applicable. 

 
Figure 454: Recipients (Continuous) 

2. Select the Remove duplicates by SSN checkbox if applicable. 

3. If needed, select the dropdown menu and select All. 

4. If needed, select the Add  icon to insert a filter. 

5. Click Next to proceed to Step 3 (Scheduled Delivery). 

Scheduled Delivery 

There are two options users can select to schedule a Continuous campaign. The first option 
(When the Field...) allows the user to set a recurring delivery that triggers if a specific field 
changes to the selected field. The second option (On the...) allows the user to set recurring 
triggers for specific time constraints. 
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To set a campaign delivery date: 

1. Select the desired options from the dropdown menu. 

 
Figure 455: Scheduled (New Continuous) 

2. Click Save & Exit. 
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Chapter 6: REPORTS 
The Reports tab allows users to generate reports with loan data from loan files in Zenly. 
Each Report has the export function to let the user download a CSV file of the loan data. 

 
Figure 456: Reports Tab 

The reporting options available in this tab function similarly to each other. The difference is 
the data generated in the report. See the figure below. 

 
Figure 457: Active Pipeline/Closed 
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Status Dropdown Menu 

The user can use the Status dropdown menu to generate a report based on the Status of 
the loan files. Any loans labeled with the selected Status at any point will populate the 
table/report. 

Example: The figure below shows that the loans are either currently a Lead or was Lead. 

 
Figure 458: Status 

Generating a Report 

Follow the steps below to generate a report. Use one or all the functions to specify which 
loans appear in the table. 

To generate a report: 

1. Select the Reports tab. 

2. Select the desired report (Example: Active Pipeline Report). See Figure 456. 

3. Click on the Current Status button. 
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4. Select or unselect desired Statuses. 
Click on the All checkbox to unselect the other checkboxes. 

 
Figure 459: Status Dropdown 

Note: Using both the Status dropdown menu and the Statuses button allows the user to pull 
loans that have had the same status and are at the same current Status. See the example 
below. 

Example: Both loan files previously had the Lead status assigned, and both are currently 
Closed. 

 
Figure 460: Status/Current Status 
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5. If needed, select the Loan Originator dropdown menu, and select the desired 
option. 

6. Select a Status dropdown menu to select an option. 

7. Select the Calendar icon to select the date interval. 

 
Figure 461: Select Dates 

8. Click the Generate button to populate the table. 

 
Figure 462: Generated Report 

Exporting Generated Report 

Once generated, the user can export and download the report as a .csv file. 

To export the report: 
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1. Select the Export to CSV button. 

 
Figure 463: Export to CSV 

2. Once the file is downloaded, click on Open File. 

3. Save the report to the desired location. 

Mortgage Call Report 

The Mortgage Call Report (MCR) contains features to generate a report for all the loan files. 
The data generated from the Mortgage Call Report 2024 screen, located in the Reporting tab 
within a loan file. The generated MCR report contains fields specific to this report with the 
ability to export to an XML file. 

To generate the MCR: 

1. Click the Reports tab. 

2. Select Mortgage Call Report. 

3. Choose a State from the dropdown menu. 

 
Figure 464: Mortgage Call Report 

4. Select a quarter from the Report Period dropdown. 

Note: Using the Report Period dropdown auto-populates the dates fields with the correct 
quarter interval. 
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5. Click on the Calendar icon to choose a date interval. 

 
Figure 465: MCR Date Interval 

6. Click Generate. 

The report generated displays a familiar view to the user that can be exported. 

 
Figure 466: Generated MCR 

To view the report’s data, click on the View Data button at the bottom of the screen. 

 
Figure 467: View Data 
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Note: Line items AC063 and AC1100 are user-defined. Those items are editable after the 
XML submission. 

Exporting 

The Mortgage Call Report (MCR) allows the user to choose between two options; via CSV 
(See Exporting Generated Report), and via XML. 

Use the CSV file to assist in cleaning up the data prior to submitting the report as an XML. 

 
Figure 468: Resubmission Status 
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Chapter 7: USERS 
The USERS tab contains administrative options for Zenly user setup and maintenance. 

User Information 

Access the User Information screen to view and update current user statuses. 

Add User 

Use the following sections to create a new Zenly user. 

User Status and Contact 

Setup the user status and contact information. 

1. Select the USERS tab. 

2. Click New. 

 
Figure 469: New User 

3. Select the Active radio button to activate the new user. 

 
Figure 470: New User Contact Details 

Note: Select Inactive to establish the user without activating user ability to access Zenly. 

4. Enter First name. 

5. Enter Last name. 
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6. Enter the Loan Name if applicable. 

7. Enter Email. 

8. Enter Phone number. 

9. Enter Mobile number. 

10. Enter NMLS Number if applicable. 

11. If needed, select the By Checking the Opting in Box…. 

Note: By opting into the informational texts, the user is provided with an additional method 
for sending password change requests. 

Loan Access 

Set the options for determining which loans to which the user has access, and the type of 
access granted. 

1. Select the appropriate Loan Access View option. 

 
Figure 471: User Loan Access 

• All/Edit: Select to enable user to view and edit all loans. 
• All/Read Only: Select to enable user to view all loans. 
• User’s Only/Edit: Select to enable user to view and edit assigned loans. 

2. Select the Create New Loans checkbox to enable the user to create new loans. 

3. Select the Delete Existing Loans checkbox to enable users to delete loans from 
Zenly. 

Marketing Access 

Allows the Admin to grant specific access to items in the Marketing tab. Select the desired 
checkboxes. 

• All/Edit: Select to enable user to view and edit every user’s marketing campaign. 
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• All/Read Only: Select to enable a user to view marketing campaigns and removes 
the ability to create one. 

• User’s Only/Edit: Select to enable user to view and edit the user’s own marketing 
campaigns. 

Document Management Access 

Set the user document management options. 

1. Select the Upload Documents checkbox to enable the user to upload documents 
to Zenly. 

2. Select the Delete Uploaded Documents to enable users to delete documents 
from Zenly. 

3. Select the eSignature checkbox to enable users to capture borrower/co-borrower 
electronic signatures. 

Menu Loan Access 

The options selected for Menu Loan Access determine the Zenly tabs to which the user has 
access and the level of assigned access. Different access options may be set for different 
tabs. Options include: 

• No Access: Removes the tab from a user’s view and prevents the user from 
performing the action. 

• Read Only: Enables information viewing without editing capabilities. 

• Edit: Enables user to make changes to tab information 

1. Select the appropriate Status option. (See Figure 471.) 

2. Select the appropriate Application option. 

3. Select the appropriate Processing option. 

4. Select the appropriate Underwriting option. 

5. Select the appropriate Reporting option. 

6. Select the appropriate Services option. 

7. Select the appropriate Settings option. 

Directory Access 

Enable or disable the user's ability to edit contacts. 

• Read Only: Enables information viewing without editing capabilities. 

• Edit: Enables user to make changes to tab information. 
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User Profile 

Admins can configure User Profiles to allow or disallow functions in the menu and for the 
Interview Portal. 

For the User dropdown menu: 

• No Access: Users will not have access to the user profile. 

• Read Only: Users can view the User Profile, but not the ability to edit. 

• Edit: Users have full access to the User Profile. 

For the Interview Portal dropdown menu: 

• Disable Site: This option prevents the user from accessing the Interview Portal. 

• Company Managed: This option disables the site for the user. 

• Read Only/Limited Access: This option allows the user to only view the Interview 
Portal, but not have any editing access. 

• Edit/User Configurable: This option allows the user to have full access to the site. 

Administrator Access 

Administrator Access options determine the administrative actions the user may access. 
Template options determine how the user interacts with the TEMPLATE tab. 

User 

Administrator User options include: 

• No Access: Prevents user from seeing or interacting with administrative options. 
• Read Only: Enables the user to see administrative options. 
• Edit: Enables the user to modify administrative options 

Settings 

This permission is available only for specific accounts. 

Settings option include: 

• No Access: Prevents the user from seeing or interacting with the Settings option form 
the User Profile dropdown menu. 

• Read Only: Enables the user to see Settings option. 

• Edit: Enables the user to access the Settings option open the Business Configuration 
screen. 
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Template 

Template options include: 

• No Access: Prevents users from using templates. 
• Read Only: Enables the user to access and use templates as-is. 
• Edit: Enables the user to modify and use templates 

1. Select the appropriate Administrator Users option. 

2. Select the appropriate Settings option if applicable. 

3. Select the appropriate Templates option. 

State Licenses 

Use the State License Add option to upload and add state licenses by the user. 

1. Click Add. 

2. See Status Defaults for details. 

3. Repeat Steps 1 – 2 for additional user state licenses. 

Modify User 

Modify access levels for existing Zenly users. 

1. Select a user from the User table. 

 
Figure 472: Select User 

2. Update User fields as required. 

3. Click Save. 

Reset User Password 

Use the following steps to reset a user password. 

1. Select a user from the User table. (See Figure 472.) 

2. Click Reset Password. 
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Figure 473: Reset Password 

Delete User 

Delete users that no longer require Zenly access. 

1. Select the user to delete. 

 
Figure 474: Delete User 

2. Click the Delete icon. 

User Search 

Enter search criteria to locate a Zenly user. 

1. Enter the Search criteria. 

 
Figure 475: User Search 

2. Press Enter to search. 

Activate/Inactivate User 

Activate or deactivate users without removing them from Zenly. 

1. Select the appropriate user from the User List. 
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Figure 476: Activate/Deactivate User 

2. Select Active User to enable Zenly access. 

3. Select Inactive to remove Zenly access. 

Services Settings 

Use the Services Settings screen to setup user credentials for selected service providers. 

Add User Services Credentials 

Use the following steps to add user credentials to selected services. 

1. Select the USERS tab. 

2. Select the User. 

 
Figure 477: Select User 

3. Select Service Settings. 

4. Click Add. 

 
Figure 478: Add Service 

5. Select the desired Service from the dropdown. 
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Figure 479: Add Login Credentials 

6. Select the desired Agency from the dropdown. 

7. Select the Preferred checkbox to set the agency as a preferred provider. 

8. Enter the Login Name. 

9. Enter the Password. 

10. Enter the Account Number. 

11. Enter the user Branch ID. 

12. Enter the Fannie Mae Account Number. 

13. Enter the Fannie Mae Password. 

Note: The Fannie Mae fields only appear for credit vendors that require different 
authentication credentials for Fannie Mae vendors. 

14. Click Save & Close. 

Note: Click Save & New to add another provider. 

Pricing Service 

Adding login credentials for Pricing reveals the Pricing Group ID table. Configure the dialog 
to enable the Pricing Group IDs for Pricing. See Run Pricing. 

To add login credentials for Pricing. 

1. Select the USERS tab. 

2. Select Service Settings. 

3. Click on the Add  icon. 
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Figure 480: Add Pricing Credentials 

4. For the Select Service dropdown menu, select Pricing. 

 
Figure 481: Enter Credentials 

5. Select the desired agency (Select Agency). 

6. Ensure that the Login Name is correct. 
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7. Ensure that the Password is correct. 

 
Figure 482: Add Login Credentials 

8. Click Save. 

9. Review the added information. 

10. Click Save & Close or Save & New to add additional credentials. 

Edit Provider 

Use the following steps to edit a provider. 

1. Access Service Settings. 

2. Click the provider to edit. 

 
Figure 483: Modify Provider 

3. Update the Edit Login Credentials dialog as appropriate. 

 
Figure 484: Edit Login Credentials Dialog 

4. Click Save & Close. 
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Delete Provider 

Use the following steps to delete a provider. 

1. Access Service Settings. 

2. Click the Delete icon. (See Figure 483.) 

3. Click Delete on the Delete Confirmation dialog. 

Alerts Configuration 

The Alerts Configuration screen allows the user to adjust the notifications that appear in 
Zenly. Use the toggles to select the notification types and access. 

 
Figure 485: Alerts Configuration 

Alerts & Notifications 

Two types of notifications are available: Alerts and Email (See Figure 485). Alerts appear in 
the bell icon  at the top of the screen. The three criteria for triggering a notification are: 

• Document Received 

• eSign Package Received 

• Being assigned a file. 

• New Lead from Interview 

Access 

In the Access section, adjust the user’s level of access by selecting an option from the View 
dropdown menu. Grant the user the ability to Edit alert configurations. The admin can 
remove that ability by choosing the No Access option. 
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Configuring Email Settings (Users) 

The Email Settings screen provides the user with fields for overriding default Global Email 
Settings for their profile. 

 
Figure 486: Email Settings (Users) 

To override the company’s default email settings: 

1. Select the Username from the User Profile menu. 

2. Select Email Settings. 

3. To enable the override, select the Override Company Defaults toggle. 

4. Update the desired server information. See Global Email Settings. 

5. Click Save. 

Test Email 

Enter the Sender Email into the Receiver Email field before clicking the Send button. If the 
email is valid the Status will change to Connected. 

  

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
301 

Chapter 8: TEMPLATES 
Use the TEMPLATE tab options to customize and manage templates. 

Fee Templates 

Set up the Fee Templates used to populate loan fees. The set fees auto populate the Zenly 
corresponding fields. 

Update Standard Fee Template 

The Standard Fee Template is a canned template used to populate the Initial Fees 
Worksheet. 

Note: Use the Add button to create a new template. See Create New Fees Template for 
details. 

1. Click Fee Template on the Template tab. 

 
Figure 487: Standard Fee Template 

2. Select the Add  button. 
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3. Enter the Template Name. 

 
Figure 488: Origination Charges 

4. Enter the Non-Specific Lender Credit code if applicable. 

5. Click the Amount field. 

 
Figure 489: Edit Origination Charges Dialog 

6. Enter the Origination Charges details in the Edit Origination Charges dialog. 

7. Click Save & Close. 

8. Repeat Steps 3 – 4 for remaining Origination Charge additions. 

9. Click Origination Charges Add to add additional origination charges. (See Figure 
488.) 
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10. Enter the new Origination Charge details in the Add Origination Charges dialog. 

 
Figure 490: Add Origination Charges Dialog 

11. Click Save & Close. 

Note: Click Save & New to add another new Origination Charge. 

12. Repeat Steps 1 – 10 for the following Standard Fees: 

• Services Borrower Can’t Shop For 
• Services Borrower Can Shop For 
• Taxes and Other Government Fees 
• Prepaids 
• Initial Escrow Payment at Closing 
• Other 

Create New Fees Template 

Create a new Fees Template by copying the Standard Fee Template or by using specific 
Add buttons. 

Create from Copy 

Create a new Fees Template with different names to enable different fees for different loans 
and loan types. 
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1. Click and hold the Template Name to copy until the Add button changes to Drag 
& Drop here to Copy. 

 
Figure 491: Copy Fees Template 

2. Drag the selected template to the Drag & Drop here to Copy button to create a 
copy. 

 
Figure 492: Copied Template 

3. Rename the template appropriately. 

 
Figure 493: Rename Fees Template 

4. Enter the Non-Specific Lender Credit Identifier if appropriate. 

5. Use Steps 3 – 10 in Update Standard Fee Template to update the appropriate 
charges. 

Creating a New Template 

Use the appropriate Add button to create a new template. 
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1. Click the Add button. 

 
Figure 494: Add New Fees Template 

2. Enter the Template Name. 

3. Enter the Non-Specific Lender Credit Identifier if appropriate. 

4. Click Add for the first type of charge to enter in the template. 

5. Complete the appropriate Add Charges dialog fields. 

 
Figure 495: Add Charges Dialog 
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6. Click Save & Close. 

Note: Click Save & New to add another new charge for the selected list. 

7. Repeat Steps 4 – 6 for each charge type to add to the new template. 

8. Click Save when complete. 

Loan Program 

This section allows the user to create, edit, or delete templates for loan programs that will 
auto-populate to a loan file. See Application Loan. 

Creating a Loan Program Template 

To create a new template: 

1. Select the Add  icon to add a template. 

2. Enter the Template Name. 

 
Figure 496: Template Name 

3. Adjust the desired fields in the Loan Information section. 

 
Figure 497: Loan Information Template 
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4. If needed, enter Rate Adjustments. 

 
Figure 498: Rate Adjustment 

5. If needed, enter Payment Adjustments. 

6. If needed, enter the Buydown Mortgage. 

 
Figure 499: Payment Adjustment 

7. Click on Save. 
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Document Packages 

Use this section to create templates for print documents. The Document Package will 
appear when generating documents for a borrower. See Generate. 

 
Figure 500: Document Packages 

To create a Document Package: 

1. Select the TEMPLATE tab. 

2. Select Document Packages. 

3. Click on the Add icon. 

4. Create a name for the template using the Template Name field. 

5. In the Filtered by dropdown, select the desired document type. 

6. Choose the desired document(s). 

7. Select the Save button. 
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Directory 

The Directory allows the user to add or import contact information to Zenly. 

To add a contact: 

1. Select the Add button. 

 
Figure 501: Directory 

2. Select a Contact Type. 

 
Figure 502: Contact Type (Directory) 

3. Enter the desired contact information. 

4. Select Save & Close. 
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Importing Contacts 

Import contacts using the import icon. A Sample CSV file is provided to assist with the 
importation of a directory. 

Note: Use the headers from the Sample CSV file to format the desired directory CSV file 
before importing. 

To import contacts: 

1. Select the Import icon. 

 
Figure 503: Use Directory Icon 

2. Select Choose File. 

Note: Click on the Sample .csv file link to open the CSV sample file. 

3. Select the desired CSV file. 

 
Figure 504: Import Directory 

4. Ensure the format is correct. 

5. Select Open. 

6. Select Import. 
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Global Services Settings 

Use the Services Settings screen to set global service credentials for users. 

1. Select the TEMPLATES tab. 

 
Figure 505: Stored Credit Card 

2. Select Services Settings. 

3. Click Add. 

4. Select the appropriate Service. 

 
Figure 506: Add Login Credentials Dialog 

5. Select the appropriate Agency. 

6. Select the Preferred checkbox to save settings as preferred. 
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7. Enter Login Name. 

Note: The Login Name for the Loan Product Advisor Agency is given by Freddie Mac. 

8. Enter the login Password. 

9. Enter the Account number. 

10. Enter the company Branch ID if appropriate. 

11. Enter the Fannie Mae Account Number. 

12. Enter the Fannie Mae Password. 

Note: The Fannie Mae fields only appear for credit vendors that require different 
authentication credentials for Fannie Mae vendors. 

13. If needed, enter TPO/NOTP (Freddie Mac). 

14. If needed, enter Seller Servicer number (Freddie Mac). 

15. Click Save & Close. 

Note: Click Save & New to add another service setting. 

Company Information 

Set company information defaults that will appear on all printed documents. 

1. Select Company Information. 

 
Figure 507: Company Information 

2. Select the business type from the Our business is a dropdown. 

3. Enter Company Information. 

4. Enter Processing Center information if required. 

5. Click the Company Information State License Add button. 

6. Complete the Add State dialog fields. 
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7. Click the Processing Center State License Add button. 

8. Complete the Add State dialog fields. 

Dropdown Lists 

Use the Dropdown List options to customize dropdown lists on some Zenly screens. 
Choose either Leads or the Loans option to add list items to the selected location. 

Select List Items 

Use the following steps to select a listed item not included in a dropdown. 

1. Select Dropdown Lists. 

 

Figure 508: Status Dropdown Lists 

2. Select either the Leads or the Loans option. 

3. Select the Tab option. 

4. Select the Menu option. 

5. Select the Dropdown option. 

6. Select the required option. 

 
Figure 509: Select List Option 

7. Click Add. 

8. Click Load Default to add the option to the Default List. 

9. Click Log Out to save the change. 
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Note: Log Out is required to save the default selection. 

Add List Items 

Use the following sections to add custom items to dropdown lists. 

Leads Status Dropdown 

Use the following steps to add list items to the Leads Tracking screen. 

1. Select Dropdown Lists. 

2. Select Leads. 

3. Select the Status option in the Select Tab menu. 

4. Select the Tracking option from the Select Menu. 

5. Select the Status option from the Select Dropdown menu. 

 
Figure 510: Leads Status Dropdown 

6. Click on the Add  icon to create a Status for a lead. 

Leads Documents Dropdown 

Use the following steps to add list items to the Documents Request screen Pending options. 
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1. Select Documents from the Select Tab dropdown menu. 

 
Figure 511: Leads Documents Dropdown 

2. Select Document Request from Select Menu. 

3. Select Pending from Select Dropdown. 

4. Click Add to and a new dropdown menu item. 

5. Repeat steps for additional Select Dropdown options as required. 

Application Dropdown 

New Fees must be added to the Application dropdown before the Fees are available on the 
Application screens.  

Use the following steps to add list items to the Application screen Initial and Closing fees 
options. 

1. Select Application from Select Tab menu. 

 
Figure 512: Initial & Closing Fees Dropdown 

2. Select Initial and Closing Fees from Select Menu. 
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3. Select the appropriate Select Dropdown option. 

 
Figure 513: Application Select Dropdown List 

4. Click Add to and a new dropdown menu item. 

Note: See steps 1-5 in Leads Documents Dropdown. 

5. Repeat these steps to add additional Dropdown options. 

Documents Dropdown 

Use the following steps to add list items to the Documents Request screen Pending options. 

1. Select Documents from Select Tab. 

 
Figure 514: Select Document Pending Option 

2. Select Document Request from Select Menu. 

3. Select Pending from Select Dropdown. 

4. Click Add to and a new dropdown menu item. 

Note: See steps 5-8 in the Leads Documents Dropdown. 

5. Repeat these steps for additional dropdown options. 
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Document Settings 

Use the following sections to set Application and Processing document settings. 

Application Privacy Settings 

Select the information to appear on the Privacy Statement Form.  

1. Select Application from Select Menu. 

 
Figure 515: Loan Application Privacy Settings 

2. Select Privacy Policy from Select Document. 

3. Select the Calendar to set Privacy Policy Revision Date. 

4. Click the Personal Information Sharing Add button to select document types 
impacted by personal sharing. 

 
Figure 516: Add Personal Information Sharing 

5. Select the appropriate Type. 

Note: Enter Other Description when selecting Other from the Type dropdown. 
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6. Select Save & Close to add the document type to the Personal Information List. 

 
Figure 517: Document Type List 

Note: Select Save & New to add another document type. 

7. Enter Questions and Assistance Telephone and Web Site Address to which the 
borrower/co-borrower can refer when questions arise. 

8. Select Yes for the Reason to Share Personal Information statements to appear on 
the form. 

 
Figure 518: Reasons to Share Personal Info. 

9. Select the appropriate corresponding Limited Sharing option. 

  

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
319 

10. Select the appropriate Opt-out Methods details. 

 
Figure 519: Opt-out Methods 

11. Click Select to add Opt-out Choices. 

12. Select the checkboxes to include the information on the form. 

 
Figure 520: Opt-out Choices Dialog 

13. Complete the remaining form fields. 

14. Click Save to save the selections. 

ECOA Processing Settings 

Select the statement to include in the Equal Credit Opportunity Act (ECOA) Form.  
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1. Select Processing from the Select Menu dropdown. 

 
Figure 521: ECOA Form Statement 

2. Select ECOA from the Select Document dropdown. 

3. Select the appropriate Federal Agency from the dropdown. 

4. Review the Description to ensure the correct one is selected. 

Escrow Account Setup 

Use this section to set up Escrow account fees. 

Note: The user can customize what fees/items are shown on Escrow Account Setup screen 
by using the Dropdown Lists screen. 

 
Figure 522: Escrow Account Setup 

To edit a fee: 

1. Locate the desired fee. 

2. Click on the fee. 
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3. If needed, enter a Cushion. 

 
Figure 523: Editing Escrow Fees 

4. Enter the desired value for each month. 

5. Enter Save & Close. 

Email Templates 

This screen allows the user to create and store custom email templates. Created templates 
are available to use when starting a new email. 

Zenly provides some default email templates. Use the Load Default button to populate the 
table with pre-typed email samples. 

 
Figure 524: Email Templates 
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Chapter 9: ZIP 
The Interview Portal provides options for setting up Zip users. To access the Zip user 
settings, select on the Users name in the User Profile. 

Interview Portal 

Use the Interview Portal to customize and manage Zip information. The options enable 
design and message configuration for the company Zip website used to introduce the 
borrower to organizations and loan officers. Borrowers may apply for loans and select 
specific loan officers via the company Zip website. 

Note: Not all the features described are available to all Zenly users. 

To access the Interview Portal: 

1. Open the User Profile. 

2. Select Interview Configuration. 

 
Figure 525: User Profile (Zip) 
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Company Site 

The Company Site options enable selecting what appears on the company Zip Main page. 
Include which Loan Originators appear on the Zip site. 

Company Main 

Configure the design and layout of the landing page for the company Zip landing site. 

1. Select Company Main from the sidebar. 

 
Figure 526: Company Main Page Setup 

2. Select the Use Company Main On radio button to enable the company Zip Main 
page. 

3. Select the Language Selection On radio button to enable language selection on 
the company Zip Main page. 

4. Enter the company website URL in the field to enable access to the company site. 

 
Figure 527: Company URL 

5. Select GO to test the URL. 
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6. Select the Zip Main page layout design. 

 
Figure 528: Zip Main Page Layout 

7. Click the Blank image to browse the stored Company image to use on the Zip Main 
page. 

 
Figure 529: Zip Main Page Image 

Note: Select a provided image when electing not to use a stored image. Use the Arrows to 
browse all available images provided. 

8. Browse and upload the image. 
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9. Make changes to the Edit Contents section as appropriate. 

 
Figure 530: Edit Zip Main Page Contents 

10. Click the EDIT links to change the text. 

 
Figure 531: Edit Links 

11. Click Preview to view the updates. 

12. Click Save. 

Set Loan Originators List 

Select the Loan Originators to list on the company Zip Main page. 
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1. Select Set Loan Originators List from the sidebar. 

 
Figure 532: Set Originators List 

2. Select the appropriate Originators from Loan Originators list. 

3. Click the >> to move the selected Originators to the List on Company Main list. 

Note: Select Originators from the List on Company Main list and use the << to move to the 
Loan Originators list. 

4. Click Sort by Registration to sort Originators by registration number. 

5. Click Sort by Name to sort Originators by name. 

6. Click Save to save changes. 

Borrower Portal 

Use the Borrower Portal options to set up Borrower Portal page. 

Default Information 

Use the following options to set the Borrower Portal images and comments the borrower 
will see. 

  

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
328 

1. Click Default Information from the sidebar. 

 
Figure 533: Borrower Portal Image 

2. Click the Image field to browse to and upload a stored image. 

3. Below the company image registry, enter the company’s information. 

4. If needed, select the Show the company address at the bottom of the landing 
page checkbox. 

 
Figure 534: Borrower Portal Welcome Message 

5. Click the [Edit] button to open the Edit Content dialog and add a landing page 
message. 

6. Select the Language Select On radio button when using the Spanish message 
option, if not selected. 

7. Select the provided Logo to display on the Borrower Portal. 

 
Figure 535: Borrower Portal Logo 

Note: Select the Blank Logo to browse to and upload a stored logo image. 
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8. Click Save to save the Default Information. 

Banner and Colors 

Set the banner and colors options to display on the Borrower Portal. 

Banner Types 

Two banner type configurations are available for the user. 

1. Select Banner and Colors. 

2. Select the A Type or the B Type configuration. 

 
Figure 536: Banner Options 

Edit Banner and Colors 

This section of Banners and Colors allows the user to customize the banner. 

 
Figure 537: Edit Banner and Colors 
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To edit the banner: 

1. Select the Edit Banner button to open the Edit Banner dialog. See Figure 538. 

2. Select the appropriate options. See Figure 538. 

Banner Options 

The Edit Banner dialog displays additional banner options that include: 

• Displaying no banner. 
• Displaying a text banner. 
• Displaying an image banner. 

Use the radio buttons to choose the desired option. 

Do Not Display Banner 

If banners will not display, use the Banner Navigation Options to enter the URL.  

 
Figure 538: Edit Banner 

Display Text 

Complete the following text options. 
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1. Enter the text to display on the banner. 

 
Figure 539: Text Banner Options 

2. Select the Text Color. 

3. Select the banner Background Color. 

4.  Select the text Font. 

5. Proceed to Color Settings and Font to select the Borrower Portal color options. 

Display Image 

Complete the following image options. 
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1. Click Browse to browse to and upload the stored Banner Image. 

 
Figure 540: Image Banner Options 

2. Select the appropriate Banner Placement radio button. 

3. Enter the URL the banner opens when clicked on the Borrower Portal. 

4. Proceed to Color Settings and Font to select the Borrower Portal color options. 

Color Settings and Font 

Two Borrower Portal colors are allowed. The selected Font overrides the Display Text 
selected above. 

1. Click the Hex Color Code for page titles and buttons on the active page. 

 
Figure 541: Text Colors 
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2. Select the appropriate color from the Color Palette. 

 
Figure 542: Color Palette 

3. Click the Hex Color Code for completed pages, background text, tooltip buttons, 
etc. 

4. Select the appropriate color from the Color Palette. 

5. Select the appropriate Font from the dropdown. 

 
Figure 543: Borrower Portal Font 

Note: Font selection supersedes font selected in Display Text section. 

6. Click Preview to view selections. 

7. Click Save to save Borrower Portal selections. 

Loan Originators 

The Loan Originators search for and change the image, borrower landing page message 
and web address of a loan originator. 
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Add Loan Originators 

1. Select Loan Originators. 

 
Figure 544: Loan Originators 

2. Choose the Loan Originator option. 

3. Choose the Loan Originator Email. 

4. Choose the Loan Originator Web Address. 

5. Click Search. 

6. Verify the search Results. 

Edit Loan Originators 

Use the following steps to edit a user. 

1. Select Edit User from the Results table. 

2. Enter the user Email Address. 

3. Enter the user Password. 

4. Enter the user Website Number. 

5. Select the Checkbox if appropriate. 

6. Click Login. 
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Calculators 

When borrowers visit the landing page, they can use a Calculator to see their expected 
monthly payments. As the administrator, use this screen to enable this function. 

 
Figure 545: Calculators 

1. Choose the On option to enable the Calculator for the borrowers to use. 

2. Click [Edit] to add a personal description for the Calculator. 

3. Click Save on the Edit Content dialog. 

4. To preview the site, click on the link at the bottom of the screen. 

 
Figure 546: Zip Site Link 

Products 

Set up loan products that borrowers can choose from the Zip portal. The menu is divided 
into two screens: 

Product Information: Use the screen to provide borrowers with an introduction to the loan 
products offered. 

Product Details: Use this screen to provide borrowers with details about what the loan 
products contain. 
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Product Introduction 

Use this section to add information about the loan products offered. 

 
Figure 547: Production Introduction 

To set up a product introduction: 

1. Select the On option to enable the borrowers to view the offered loan products. 

2. Click the [Edit] button to add an Introduction for the products offered. 

3. Click Save in the Edit Content dialog. 

4. Click the [Edit] button to add a Footer. 

Information added in the Footer textbox will appear below the offered products. 

5. Click Save in the Edit Content dialog. 

6. Once all content is added, click Save on the main page. 

7. Use the Preview button to open a sample. 

Product Details 

The Product Details screen allows the user to add what loan products are offered by your 
company. Use the button on the table to add, delete, or copy a loan product. 
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1. Click on the New Loan Product button. 

 
Figure 548: Product Details 

2. Enter information about the product. 

 
Figure 549: Loan Product Information 

3. Scroll down to enter loan information for the offered product. 

4. Click Save. 

5. If needed, click the Preview button to view a sample of the screen. 

Borrower Interview 

Use the Borrower Interview options to customize the information collected from Zip users. 

Configuration 

Select the interview questions. 
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1. Select Configuration. 

 
Figure 550: Set Loan Interview Configurations 

2. Select the Default Configuration from the dropdown when more than one 
configuration is available. 

3. Select the appropriate Config radio button when more than one is available. 

4. Select the appropriate Detailed Settings. 

5. Select the Classic or New radio button. 

6. Click Save. 

Disclaimer/eConsent/Result 

Set the Disclaimer and Thank you statements. 

1. Select Disclaimer/eConsent/Result from the sidebar. 

 
Figure 551: Zip Disclaimer/eConsent/Result 
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2. Click the [Edit] button to add a Disclaimer. 

3. Edit the Disclaimer if applicable. 

4. Click Save in the Edit Content dialog. 

5. Select the applicable options for eConsent if applicable. 

6. Click the [Edit] button to add eConsent information. 

7. Edit the eConsent if applicable. 

8. Click Save in the Edit Content dialog. 

9. To edit the Thank You Message, click [Edit] button. 

10. Enter the Zip Thank You Message. 

 
Figure 552: Zip Thank You Message 

11. Click Save on the Edit Content dialog. 

12. Click Disclaimer Preview to review. 

13. Click eConsent Preview to review. 

14. Click Result Preview to review. 

15. Click Save to save the Zip messages. 

Terms of Use/Privacy Policy 

Set the Terms of Use and Privacy Policy statements. 
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1. Select Terms of Use/Privacy Policy from the sidebar. 

 
Figure 553: Terms of Use/Privacy Policy 

2. Click on the [Edit] button for the Terms of Use. 

3. If needed, add or edit the information for Terms of Use. 

4. Click Save in the Edit Content dialog. 

5. Click the [Edit] button for the Privacy Policy. 

6. If needed, add or edit the information for the Privacy Policy. 

7. Click Save in the Edit Content dialog. 
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Screen Share 

The Screen Share function provides the user with the ability to allow a loan borrower to 
share their screen with the interviewer to assist with filling out forms or other tasks. 

Note: Due to security limitations, Borrowers/Prospects must screen share using a PC. 

Note: The Receive Notification Email with Borrower Contact Information must be On to use 
this feature. Located in the Email Setting > Email Preference screen. 

 
Figure 554: Interview Screen Share (Admin) 

Allowing Screen Share Access to Users 

Giving access to the screen sharing function can only be given through the Zip Admin 
account. 

To allow Screen Share Access to a standard user(s). 

1. Open the Zip admin account. 
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2. Select Screen Share. 

 

3. Select the desired user(s). 

4. Select the  button or select the  move all available Loan Originators if 
applicable. 

5. Click Save. 

Using Screen Share (Loan Originators) 

These steps are from the LO (Loan Originator) side of Zip on how to request a screen 
sharing session with a Borrower/Prospect. 

To use the screen share function, the borrower must have at least the Contact section of the 
interview completed. This is a “view only” screen sharing function. LOs will not have control 
over the Borrower/Prospect’s screen. 

After the borrower has entered all the relevant information in Zip: 

1. In Zip, select Borrower Interview > Screen Share. 
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2. In the Active Interview table, select the Request link to allow the 
Borrower/Prospect to share their screen. 

If needed, click the Search button to refresh the table. 

 
Figure 555: Request Link 

3. Click OK. 

A screen will appear, waiting for a connection with the Borrower/Prospect. For 
information on the Borrower/Prospect side, see Using Screen Share 
(Borrower/Prospect). 

 
Figure 556: Waiting for Connection 

Using Screen Share (Borrower/Prospect) 

This information is for the Borrower/Prospect side of the screen share. This explains what 
the Borrower/Prospect will receive once the LO selects the Request link. 

The Borrowers/Prospect must complete at least the Contact section of the interview before 
the screen sharing option is available. 

For the Borrower/Prospect: 
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1. Complete the desired information in the interview site. 

 
Figure 557: Interview Contact Information 

2. Wait for the LO to select the Request link. 

3. Once the request is sent, select Ready. 

 
Figure 558: Ready for Screen Share 
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4. Select the screen sharing method (Google Chrome®, Microsoft Edge®). 

• Tab: Allows the Borrower/Prospect to select which tab on the browser to 
share. 

• Windows: Allows the Borrower/Prospect to which specific window to share. 
• Entire Screen: Borrower/Prospect using multiple screens can select which on 

the share. 

5. Select Share. 

 
Figure 559: Share Button 

6. When the Borrower/Prospect is finished screen sharing, they must click the Stop 
Sharing button. 

 
Figure 560: Stop Sharing 
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Requesting a Mobile Screen Sharing Session 

LO’s can request and view a screen sharing session using a mobile phone or tablet on 
desktop mode. For information on setting a mobile phone browser, see Desktop Mode 
Setting. 

Follow these steps to start a mobile screen sharing session. 

On your mobile phone: 

1. Select the Main Menu  icon. 

 
Figure 561: Main Menu (Mobile) 
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2. Select Interview Configuration. 

 
Figure 562: Interview Configuration (Mobile) 

3. Select Screen Share. 

4. Select the Search button. 

5. Select the Request link for the desired Borrower/Prospect. To continue to process 
see Using Screen Share (Borrower/Prospect). 

Desktop Mode Setting 

The steps below are for the following browsers: 

• Google Chrome 
• Safari 

Google Chrome 

To set a phone to desktop mode. 
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1. Select the ellipsis icon. 

 
Figure 563: Menu icon (Chrome) 

2. Select Request Desktop Site. 

 
Figure 564: Request Desktop Site (Chrome) 
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Safari 

To set a phone to desktop mode. 

1. Select the URL icon. 

 
Figure 565: URL Icon (Safari) 
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2. Select the ellipsis. 

 
Figure 566: Menu Icon (Safari) 

3. Select Request Desktop Website. 

 
Figure 567: Request Desktop Website (Safari) 
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Retention Policy 

Use the Retention Policy options to change the default Zip loan document and eSignature 
retention settings. 

1. Select Retention Policy from the sidebar. 

 
Figure 568: Zip Retention Policy 

2. Change the Loan Information retention setting to modify the retention length. 

3. Change the eDisclosure & eSignature retention setting to modify the retention 
length. 

4. Click Save. 

Notifications 

Use the following section to setup borrower reminders. 

Email Settings 

Use the following sections to set up email addresses and email preferences. 

Set Email Address 

Use the Set Email Address to set email preferences. 
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1. Select Email Setting from the sidebar menu. 

2. Enter the Primary Email Address. 

3. If needed, add Additional Email Addresses. 

 
Figure 569: Zip Email Preferences 

Note: Click the  button to add additional Email fields. 

4. Click Save. 

Set Email Preferences 

Set Zip Email Preferences. Select the desired options. 

 
Figure 570: Email Preferences (Zip) 

To set email preferences: 

1. If the Receive LO notification Emails option is On, enter the desired email address. 
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2. Select On for the Receive Notification Email with Borrower Contact Information to get 
notified of potential emails with contact information. 

3. Select the desired Time Zone Configuration. 

4. Click Save. 

Edit Emails 

Use Edit Emails screen to customize email notifications sent to the borrowers after 
submitting a loan. 

Use the following steps to customize email notifications. 

1. Select Edit Emails from the sidebar. 

 
Figure 571: Edit Emails 

2. Click the Select Loan Originator dropdown and select an originator. 

Email Notifications 

1. Select the Copy Setting > link if applicable. 

2. Select an email template from the dropdown menu. 

 
Figure 572: Email Template 
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3. Click on the [Edit] button to change the text to the option selected in the 
dropdown menu. 

4. Use the Insert Merge Fields dropdown to add automation to the email. 

Note: To enter social media tags (e.g.{ Facebook_Logo_Hyperlink}), ensure that the 
appropriate platform is selected. See Manage Social Media. 

Note: The default email template contains bracketed tags (merged fields) that autofill 
common elements within the email (Ex. {Sender_Name}). 

 
Figure 573: Insert Merge Fields 

  

mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/


Zenly User Guide 

 
Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA  95120   

3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com 
www.calyxsoftware.com 

© Calyx Technology, Inc. 1991-2026. All rights reserved. 
355 

5. Customize the Subject content. 

Note: Before entering a Merge Field, place the insertion mark at the desired location. The 
Merge Field will appear wherever the user places the insertion mark. See the image below. 

 
Figure 574: Placing a Merge Field 

6. Customize the Body content. 

7. Customize the Footer content. 

8. Customize the Signature. 

9. Select the Save button. 

Set Back to Default 

Use the Set Back to Default button to reset the Subject, Body, and Footer to the email’s 
original format. 

1. Select the Set Back to Default button. 

2. Click on Yes to reset the email. 

Send Sample 

Use the Send Sample button to send a sample of the modified email to the desired email 
address. 

1. Click the Send Sample button. 

2. Enter an email address in the Send To field. 

 
Figure 575: Send Sample Email 

3. Click Send. 
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Manage Social Media 

Insert Social Media links within an email using the Insert Merge Fields. 

 
Figure 576: Email Signature 

To add a Social Media link to an Email: 

1. Use the checkboxes to select the desired social media platforms. 

2. In the fields for the selected platforms, enter the link to that account. 

3. Click Save. 

4. Click the [Edit] button to open the Edit Content dialog. 

 
Figure 577: Opening Edit Content Dialog 
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5. Select Insert Merge Fields. 

 
Figure 578: Select Insert Merge Fields 

6. Select the desired social media tag. 

 
Figure 579: Choose Social Media Tags 

7. Click Save. 

Edit Reminders 

Use the following section to set up reminders. 
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1. Select Edit Reminders. 

2. Choose a Loan Originator. 

 
Figure 580: Edit Reminder 

Copy Setting 

Use the Copy Setting > link to copy the settings from a chosen loan originator and apply 
them to other loan originators. 

After selecting the link: 

1. Select the Copy from dropdown menu and chose whose settings to copy. 

 
Figure 581: Copy Setting 

2. If needed, click on the Select All Users button. 

Or 

3. Use the field below the Select All Users button to select the desired Loan 
Originator. 

4. Click on the Copy button. 
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Document/eSign Dashboard Reminder 

Selecting On will alert borrowers (with accounts created) with emails/text messages about 
completing any outstanding documents or electronic signature requests before their due 
dates. The Off option disables this feature. 

To set a reminder: 

1. Select either On or Off. 

 
Figure 582: Document/eSign Reminder 

2. If Use Reminder is On, configure the method and frequency of the reminder. 

3. Click Save. 

4. If needed, click the [Edit] button to customize the email reminder. 

5. If needed, click the [Edit] button to customize the email reminder. 

Loan Interview Reminder 

Selecting On will alert borrowers (with accounts created) with emails/text messages about 
completing loan interviews. The Off option disables this feature. 

To set a reminder: 

1. Select either On or Off. 
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Figure 583: Loan Interview Reminder 

2. Choose Email, Text, or select both options. 

3. Select the number of days after an unfinished interview before notifying the 
borrower. 

4. Select the time of day. 

5. Click on the Reminder Frequency dropdown menu and select an option. 

6. Click Save. 

7. If needed, click the [Edit] button to customize the email reminder. 

8. If needed, click the [Edit] button to customize the text reminder. 

Reports 

Use the Reports options to run Zip Reports. 

Borrower Interview Report 

Set the Borrower Interview Report options to retrieve the list of borrower interviews for a 
specified timeframe. 

1. Select Borrow Interview Report from the sidebar. 
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Figure 584: Run Borrower Interview Report 

2. Enter Loan Originator Name. 

3. Enter Borrower Email. 

4. Set Loans originated dates. 

5. Click Search. 

6. Click Download as Excel to download the results in an Excel spreadsheet. 

eSign Reports 

The eSign Reports section displays the documents the user sent to borrowers that require e-
signatures. 

Use the search function to generate a list of Loan Originators or Borrowers. 
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Figure 585: eSign Reports (Zip) 

To generate an eSign report: 

1. Click eSign Repots from the sidebar. 

2. Follow steps 2-6 from the Borrower Interview Report section. 

3. Click Save. 
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Borrower Uploaded Documents 

The Borrower Uploaded Documents page allows the user to search for documents uploaded 
by the borrower. 

 
Figure 586: Borrower Uploaded Document (Zip) 

To generate a Borrower Uploaded Document report: 

1. Click Borrower Uploaded Document from the sidebar. 

2. Follow steps 2-6 from the Borrower Interview Report section. 

3. Click Save. 

Billing Statement Report 

Use the Billing Statement Report options to run billing reports for a selected month. 
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Figure 587: Billing Statement Report 

To generate statements for the tables: 

1. Click Billing Statement Report from the sidebar. 

2. Select the timeframe from the View dropdown menu. 

Borrower Statistics  

Use the Borrower Statistics options to review Zip borrower activity. 

Registered Borrowers 

Review the Zip registered borrowers. 

1. Select Borrower Statistics from the sidebar. 

 
Figure 588: Borrower Statistics 

2. Click the Registered Borrowers link to review the registered borrowers. 
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Figure 589: Registered Borrowers 

3. Click Search to locate a borrower when the registered borrowers appear in a list. 

Loan Submission Report 

Use the Loan Submission Report options to return a report containing the Zip submitted 
loans. 

1. Select Borrower Statistics. 

2. Enter the Loan Originator Name. 

3. Enter the Date Between range to include in the report. 

4. Click Search. 

Note: The results display in a Results List. 

Settings 

As the administrator, configure the portal Google Analytics and Document Templates. 

Google Analytics 

From the Google Analytics screen, the user can register Google Analytics ID to track the 
pattern on how borrowers use the interview portal. 

To register Google Analytics ID: 

1. Choose the On option. 
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Figure 590: Google Analytics 

2. Enter the Google Analytics ID into Measurement ID field. 

Document Template 

Use the Document Template screen to Set the document collection that you want to receive 
from borrower during Loan Interview. 
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1. Select Document Template from the sidebar. 

 
Figure 591: Document Template 

2. Enter Document 1 name. 

3. Enter description in the Note field. 

4. Click + to add additional documents. 

5. Click Save. 

Security 

1. Select the 2-factor Login Authentication option. 

 
Figure 592: Security Login 
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2. If needed, set Password Parameters. 

3. If needed, select On to set the Password Expiration Rules. 

4. Click Save. 

Payment Management 

Use the Payment Management screen to update the credit card information used for Zip 
and eSignature transactions. 

1. Select Payment Management from the sidebar menu. 

 
Figure 593: Payment Method 

2. Select the appropriate Payment Method under the Payment Management tab. 

3. Enter Credit Card or Automatic Clearing House (ACH) information. 

 
Figure 594: Payment Management Credit Card 

4. Click Save. 
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Account Management 

This section allows the Zip user to unsubscribe. Follow the instructions on the Zip screen to 
continue the process. 

 
Figure 595: Account Management (Zip) 

To unsubscribe: 

1. Click on Payment Management from the sidebar menu. 

2. Click the Account Management tab. 

3. Click the Unsubscribe button. 

4. Click Confirm in the dialog. 

 
Figure 596: Unsubscription Confirmation (Zip) 
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Chapter 10: ACRONYMS 
The following tables contain acronym definitions used in this document. 

Table 4: Acronyms 

Acronym Definition 
ADA Americans with Disabilities Act 
ARM Adjustable-Rate Mortgage 
CBSV Consent Based Social Security Number Verification 
FHA Federal Housing Administration 
HMDA Home Mortgage Disclosure Act 
FNM Fannie Mae Data file developed by Calyx. 
HTML Hyper Text Markup Language 
HOEPA Homeownership and Equity Protection Act 
MIP Mortgage Insurance Premium 
PMI Private Mortgage Insurance 
POS Point of Sale 
SCIF Supplemental Consumer Information Form 
USDA United States Department of Agriculture 
URLA Uniform Residential Loan Application (Form 1003) 
VA Veterans Affairs 
XML Extensible Markup Language 
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APPENDIX A: LOAN ESTIMATE MAPPING TABLES 
See Loan Estimate. 

Loan Terms 

Table 5: Loan Terms Mapped Fields 

Loan Estimate Field(s) Mapped from Screen Mapped from Section/Field 

Loan Amount Loan Application Summary of Total Loan Amount 

Can this amount 
increase after closing? 

Loan Application 
Determine by various loan data 
and loan terms. 

Interest Rate Loan Application Payment Schedule 

Monthly Principal & 
Interest 

Loan Application Payment Schedule 

Prepayment Penalty Loan Estimate 
Prepayment Penalty Checkbox 
and the fields below the 
checkbox. 

Balloon Payment Loan Application Loan Features 

Projected Payments 

Table 6: Project Payments Mapped Fields 

Loan Estimate Field(s) Mapped from Screen Mapped from Section/Field 

Principal & Interest 
(MIN/MAX) Loan Application 

Payment Schedule – Mth Pmt 
column 

Mortgage Insurance (MI) Loan Application Payment Schedule – MI 

Escrow Initial Fees Worksheet 
G. Initial Escrow Payment at 
Closing 
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